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Preface 

•••••••••••••••••• 
Preface 

This book is intended to help you successfully complete the test for 
Module 3 of the European Computer Driving Licence (ECDL). However 
before we start working through the actual content of the guide you 
may find it useful to know a little bit more about the ECDL in general 
and where this particular Module fits into the overall framework. 

What Is The ECDL? 
The European Computer Driving Licence (ECDL) is a European-wide 
qualification that enables people to demonstrate their competence in 
computer skills. It certifies the candidate's knowledge and competence 
in personal computer usage at a basic level and is based upon a single 
agreed syllabus. 

This syllabus covers a range of specific knowledge areas and skill sets, 
which are broken down into seven modules. Each of the modules 
must be passed before the ECDL certificate can be awarded, though 
they may be taken in any order but must be completed within a three 
year period. 

Testing of candidates is at audited testing centres, and successful 
completion of the test will demonstrate the holder's basic knowledge 
and competence in using a personal computer and common computer 
applications. 

The implementation of the ECDL in the UK is being managed by the 
British Computer Society. It is growing at a tremendous rate and is set 
to become the most widely recognised qualification in the field of 
work-related computer use. 

The ECDL Modules 
The seven modules which make up the ECDL certificate are described 
briefly below: 

Module 1: Basic Concepts of Information Technology covers the 
physical make-up of a personal computer and some of the basic 
concepts of Information Technology such as data storage and memory, 
and the uses of information networks within computing. It also looks 
at the application of computer software in society and the use of IT 
systems in everyday situations. Some basic security and legal issues are 
also addressed. 
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Modul. 2: U.lng the Comput.r .nd M.n.glng FiI •• covers the 
basic functions o f a personal computer ;Lnd its operat ing system. In 
IY.lrticubr it looks at operating effectively within the desktop 
environment, managing and organising files and directories, and 
working with desktop icons. 
Module 3: Word Proc ••• ing covers the use of a word processing 
;Ippliellion on a personal computer. [t looks at the basic operations 
associated with creating, formatting and finishing a word processing 
document ready for distribution. It also addresses some of the more 
advanced fea tures such as creating standard tables. using pictures and 
images within a document, importing objects and using m;lil merge 
tools. 
Module 4: Sp .... d.h.et. covers the basic concepts of spreadsheets 
and the ability to use ;1 spreadsheet application on a personal 
compUler. Included arc the basic operations for developing, formatting 
and using a spread'iheet , together with the use of basic formulas and 
functions to ("J.rry out st;mdard mathematiC".I1 and logied opc<.nions. 
Importing objeds and creating gmphs and charts are also covered. 
Modul. 5: Databa •• covers the basic concepts of databases and the 
ability to use a database on a personal computer. [t addresses the 
design ;md planning of a simple database, and the retrieval of 
information from a database through the usc of query, selcct and sort 
tools. 
Modul. 6: Pre •• ntation covers the use of presentation tools on a 
personal computer. in particubr creating, formatting and preparing 
presentations. The requirement to create a variety of presentations for 
different audiences and situations is ;ilso addressed. 
Module 7: Information and Communic.tion is divided into tWO 

main sections, the first of which covers basic Web search tasks using ;1 

Web browser and search engine tools. The second section addresses 
the use of eiedronic mail software to send and receive messages, to 
attach documents. and to organise and manage message fo lders and 
dire(10ries. 

Thi. guide focu ... upon Module 3. 

How To Use This Guide 
The purpose of this gUide is to take you through all of the knowledge 
areas and skill sets specified in the syllabus for Module 3. The use of 
clear, non technical expla nations and self paced exercises will provide 
you with an understanding of the key elements of the syllabus and 
give you a solid foundation for moving on to take the ECDL test 
relating to this Module. All exercises contained within this guide are 
b:lsed upon the Windows 98 operJ.ting system and Office 97 software. 

• r£m. · .. . 
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•••••••••••••••••• 
Each chapler ha~ ;1 well defim:.-'d set of objectives th:lt rehte di rcctly 10 
Ihe ~yJJabu~ for the ECDL Module 3. Bec,use the guide is .itructured in 
a logic-.!I sequence you are <ldvised 10 work through the chaplcrs one 
;[\ a time from the beginning. l1lroughout each chapter there are 
various review questions so that you can delenninc whether you h<lve 
understood the principles involved corn:cily prior 10 moving on to the 
next step. 

Conventions Used In This Guide 
Throughout Ihis guide you will come <lcross notes <llongside a number 
of icons. They are all designed to provide you with specific 
information related to the section of the lX)()k you are currently 
working through. The icons and the particular Iypes of information 
Ihey rebte to are as follow~: 

AddItIonItl 11IfonnM1on: Further Information 01' •• pIanatIon 
about • epectftc point. 

Caution: A WOld of w ....... about the ..... . uoc"tecI 
with. particular ~tlon. ~ with ..... nce . ....... 

nec .... ry _ how to .voId .., plthtU • • 

o.tInIt_: A pIIIIn .... w. ~ of • newly Introduced 

t ...... 01' cone .. 

Short Cut-= Short cub ... hint. for ....... partie ...... 
~ moN effectively. 

As you are working Ihrough the various exercises containt..-'d within this 

guide, you will be asked to carry out a variety of actions: 

• Where we refer to commands or items that you are required to 
select from the PC screen, then we indicate these in bold, for 
ex:unple: Click on the v • • button . 

• Where you are asked to key text in to the PC. then we indicale Ihis 
in italics. for example: Type in the words ;S(lVillg my wOlk'. 

You ~hould now be in a position 10 usc this guide, so lets get started. 

Good luck! 
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Introduction 

\\'lbat word processing is. 

What is meant by formatting. 
Which word processor we will lise as the basis of the 
content for this book. 

An outline of the book. 

. .. . . 
• ,..cOL ' .. . D. Penfold, Word Processing
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1.1 

Introduction 

0 ••••••••••••••••• 

What i s a Word Processor? 
A word proces~or is a computer progr.tm that allows you to enter text 
and edit it. ]n addition, you can fo rm:lt the text in various ways and 
include pictures and t:lbles. so that. once all the processing is 
compkte, you obtain a document lh:!! is bid out in the way that you 
wish. This m:ly be a sim ple leiter or it l1l:IY be the chapter of a book, 
although some of the more adv:mced K-'<:hniques required for the latter 
may be beyond the scope of this gUide. 

1.2. What is Formatting? 
[n Modu[e 2 of this series, you .~aw how a text editor c.tn be used to 
inpUl and edit lext, th:1l b , words made up of letters and spaces. 
Figure 1. \ shows a scrL>('n shot of a text editor. [n the screen shot you 

can see that text looks as though il has been typed on an old­
fashioned typewriter; this is cJ lled the Courier typeface, which has 
been set as the default. Note that any other typef;lce swred on your 
computer could have been used instead, but when the text file is 
s;lved (usually with a file exten.~ion _txt , e_g. yourfile.t.xl), it is only the 
letlers and spaces (plus a few chu:tcters such as the tab and the 
c-Irriage return) that arc saved. There is no form:lI!ing. 

Aieeee' --
, .... ~ _~ ""'" " ._ ... " __ "K •.• 

_''''. , ... , .. , ... '_"K ." ...... - ... , .. , """ ... ",,"- _ .. ''''-''''''' ,~ ..... ' H ..... " .... , .. " .. , _ .,, _ _ , _ ",,, , _ ..... ,,'_ " .... _ . "'k'" _" .. ", .. , .. " , .. _,,_. 
'COl'_'''_ "M .... ,_ ... _ .. "" .... -" ... .. ". "" ...... , ' .. , .... ,,..,-,-.. ,,, , .. _,, ., .. ... ,"'.,"_ .... ,.,-
" ... ,, ~. 

" ...... ,,,,,_ ....... -"' .. _" ..... ,,-

'''- -. , ...... - , ...... , .. "o. ,_,,_ " ... .. _ ." ... , ,ol. _"""_." _.M', ".,_ .. , .. , ... ,_ ,,'_ .. _,,_ " " , .. ,_,,,_,, .. , .. ','w .. "_ ,_'.'w' .. ,',. " _ .. ,,_ •• ." , .. , .. ,_,,_ ... ,_", • .. """'w ... 'H .... _ ... ,,_ ~"'"'' .b' .. .. _0 
, .. _,,_ ..... ' .... Mol .. , .. _". ' ... . , .... ".,. ,." ",,,,,,,,,. "' . "-.. ,."-,, .. 

'.' to. , .. __ ,_,,, "" ' .. u._, 
'-'-'«"-"''' ''''' ,.,_""", ... COl ,_ ..... , ... ' .... , .. , .. 
, .• ,-, .... "".". .:I 

~ ;, ._~!IjI .... I.--I~..,"'U;"'."."."''-''-~ 
Figure 1.1 The Not. pad Itext e ditor) w indow. 

With a word rrocessor, the sitU;l tion is different. You can define the 
typef:tce, o r typefaces, you want !O use, the !YI)Csizes to I)C used, the 
interline spacing, !hc inlerpar:lgr.lph spacing, indenls, alignment ( left, 
right Of cCnlre) and a large numl)Cr of other p:trJmeters. When you 
save the file (with 1he extens ion .doc, e.g. myflle.doc), all these 
pammeters ;Ire saved 100, unlike with a simple text editor. 

11 
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You c<ln even group all these changes together to fonn <l style, to 
which you can give a name and, in turn you ("'.In group these styles, 
together with other dewils such as the page layout, into a template, 
which you ("'.In save as <l speci<ll kind of file <lnd use again to provide a 
struCture for other documenL". 

1.3. Which Word Processor? 

1 

This book is about Word 97, the version of Microsoft Word that forms 
p:Ht of Office 97, but there <lre other word processors <lS well. There 
arc earlier versions of Word (and sometimes it is useful to save in an 
carlier format, such as Word 6. if you arc sending your file to someone 
else), there is thc more recent Word 2000, which is still very new, and 
there is Word 98, which is the version of Word 97 that runs on ;\0 

Apple Macintosh. There are also word processors provided by other 
software suppliers. Probably the most widely used on the PC platform 
are Corel WordPerfL"CI and Wordl'ro (previously called AmiPro), which 
forms part of the Lotus SmartSuite. Allhough some of the commands 
are different in these progr::lms. in geneml Ihey can be used to achieve 
the same effects as Word 97 and, if you follow and understand the 
chapters in this guide. you should be able to use any other word 
processor without tOO much difficulty, particularly if you usc the Help 
files intelligently. 

1.4. Outline of the Book 

r 

12 

In Chapter 2, we look at the first steps in word processing, such as 
how to open and close Word 97, how to open, edit and save a 
document, how to create a new document and how to use the Help 
functions. 

In Chapter 3 we see how to change the basic settings, in other words, 
how to look at the document in different ways, as a basic series of 
lines, as pages, as a World Wide Web document or even JUSt the 
outline of the document. We shall also see how you can change the 
page magnific:ltion and modify the toolbars, which contain icons for 
many of the formatting and other oper.ltions. 

Chapter 4 deals with how to save the document in other formats. 
111ese include as a simple text file , other versions of Word, other word 
processor fomlatS and as what is called Rich Text Format (RTF), which 
is a text file in which ~IJJ the formatting commands can be seen as 
codes. We shall also see how to save a document in a form that C;ln 
be loaded onto the World Wide Web. This is also a text file with the 

. ' . 
• • .cOL· .. . 
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formatting commands included in a language called HTM L (HyperText 
Markup Language), 

In the next few chapters we shall look at basic <.-diting operations. 
Chapter S covers how to insert and delete char:lclers, words, 
sentences, paragraphs and special characters, such as accents, fixed 
spaces and mathematical symbols. We shall also see how to insert a 
page break and, very importantly, how to use the undo command, 
which allows you cancel not just the last change you made, but a 
whole series of changes, one by one or all together. Chapter 6 covers 
how to selc<:t characters, words, sentences, parJgraphs or even the 
whole documem. We shall also see how to move or copy the selected 
text, not just within a single document. but hetween open documents 
and even into and from OI:her open applications, and finally how to 
delete sections of text. Chapter 7 covers searching for characters within 
a document and how to replace them with other ch~LT"'J.cters. 

The follOWing chapters then cover formatting. Chapler 8 is about how 
to change the attributes of the text (typefaces and rype sizes - also 
known as fonts - both the typeface itself and the size, italic, bold and 
underlines, the colour, the alignment). We shall also see how to use 
hyphenation jf appropriate, how to indent , change the line spacing 
and copy the formatting from a seleded piece of text. Chapter 9 is 
concerned with tabs, how to use them and how to set them. We :Ilso 
look at adding borders to your dcx:umem and using lists. Ch:lpter 10 is 
concerned with styles and templates. Chapter 11 explains how to add 
page numbering. We shall a lso see how to add more complex headers 
and footers :lnd how 10 insert the dne, page numbers and Dlher 
information in either of these, as well as how to format them. 

Chapter 12 shows you how to check spelling and gmmmar, making 
changes where necessary, while Chapter 13 is concerned with 
dcx:ument set-up, including page size, page orient:ltion and margins. 

Chapter 14 is all about printing, including previewing, while in the 
final chapters we look at some more advanced features of Word 97. 
Chapter IS is about how to creale, edit and format tables. Chapter 16 
is concerned with how to handle pictures, images and drJ.wn objects. 
In Chapter 17 we shall see how to import objects, such as 
spreadsheets, into your Word file. Finally, Chapter 18 shows you how 
to usc the M:li] Merge features of Word 97. 

The guide ends with an index. 

13 
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Summary 

In [his chapler: 

• We have seen whal word processing is. 
• We ha~·e seen whal formalling is. 
• \,\Ie have looked briefly at other word processors. 
• We ha~·e looked al an oUlline of [he remainder of Ihe book. 

.. . 
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First Steps 
WdhWord 
Processing 

2 

earn ow t 

Open and close Word 97. 

Open an existing document. 
Open more than one document at the same time. 

Create a new document. 

Save a document onto different media. 

Close a document. 
Use Word 97 Help junctions. 

15 
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2.1. Introduction 
This chapter is r.llhcr long, so you may find it easier to consider il in 
three sessions, the first concerned with st;tning Word 97 and finding 
out ;tbout the Word 97 window. In the second .sc.~s ion, you can look ;11 
opening. saving and closing files, while in the third session you will 
cxperimenl with Help. 

2.2. Opening Word 97 

,. 

There is no one way 10 open Word 97. Ind<.'Cd. there are almost too 
m;my W".tys. Perhaps the two simplest ;lrc either to double-click the 
Word 97 shortcut icon on your desktop (see Figure 2.1) or to dick the 
shon-cut icon in the Microsoft Office Shoncut Bar that is created if rou 
install Word as part of the office suite (S<.'"e Figure 2.2). TIlere arc many 
other ways (see the Inform;ltion boxes) and you will :tlmost certainly 
develop your own preferred method, if you h:tve not :tlrcady done so. 

Figure 2.1 The Word icon on the desktop. 

Figure 2.2 The Microsoft Office Shortcut bar. 

From here on in this Ix>ok. we shall just refer 10 Word, rather than 
Word 97, a lthough you will know thai this is what is meant. 

• F.f'DI. · ... 
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You c.n click Shirt I.t the bottom l.tt of your desktop) .nd 

then click on Run. You c.. then brow .. through the 

dlNetories until you ftnd the ftl. IWinword •• x.,. It will 
probably be In C:\Prog,.m FII.s'Mlcroaoft OffIc., but not 
nec .... rily. 

You can open .. the dINetori •• on your .ystem by double­

clicking on My Computer on the deaktop and then 
succ .... vely open dlNCtorie. until you ftnd the Word Icon 
IFlgu,. 2.3) or the ftl ........ Ithl. depend. on how your 
window. dlapl.y the ftle. - __ .. oduIe 2 of the ECDL). 

You c.n c.rry out •• imll.r ...... ton ualng Window. 
Explorer lmost ... 11y opened by clicking with your right 
mou_ button on St.rt, .nd then .. Ieetlng Explore lelther 
by clicking with .... left mouse button or by ju. t moving 

your cursor to Explore; thI. depends epln whe .... r you .,. 

ualng the ChI •• view or the Web view of your .y.t.m •• 
dlacu.Hd In Modul. 2). You then go down through t he 
directory atructu.w In the same wey •• for the two 

.ppnNlche. abov •• 

For obvlou ..... son. none of the .. three • .,.,.".ch • • 
repre.ent. e good w.y to .hlrt .., applic.tlon tMt you u •• 
fNquently, .Hhough there mIIy be tim •• when .ny one I • 
• pprop ....... If for .ny ..... on you do not heve .n obvJou. 
icon .v.l .... on your desktop or the OffIc. toolbar, then 
the following I. the be.t .pproach. Click on St.rt .nd then 
move yo.. cursor .. to Program. , when the prog,.m • 

• tored on yo.. .,..tem will be aItown on the right. "ove the 
cursor to "ICroMtt Word .nd open it Iby clicking or doubI. 
clicking - spin thl. depend. on the vie w you .,. u.ing,. 
See Flgu,. 2.4. Not., how. v.r, ..... H you .,. working on • 
networked .y.tem. you .,. best to check wHh your .y. tem 
.clmlnistr"or tf you heve not .1,....,. been told the 
recommended w.y to ••• rt Word. 

t7 
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'I Do ,. ... <io , .... ,. • '" IbJ l( 10 <l\ ., X 'a .. ~ "'" ,- ~ -I ~I...J CIAog ... ; .. , .... "'''"'''O''''. 101I\to 3 

~ ~ ~ ~ It-; 
Office _ n5 

w_~ W-.. ..., W.-od _ 

SoloCl on ... m I • 

~ ~ ~ ~ ., ...... 
d • • "",,_ 

W_"II WOIlIo.R ... w_. w __ 

~ ~ ~ ~ -' 
;J - .. --

Figure 2.3 Finding the Word icon in My Computer. 

0-- _.-
IiJ> .... -""--
'\l --,~ -,-
~ ~ 
:!'l ~ 
,t LooOlO-O_ 

... -
Figure 2.4 Opening Word by following the 

Sta rt I Progra m s route. 

When you stan Word, cenainly for the first time and mayhe every timc. 
Office Assistant will open (see Figure 2.5). At this stage, dick on the 
Close box in the lOp righl corner to close il We will COIllC back 10 it 
in Scaion 2.9. 

• [CD!. · 

' .. 
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x 

Figure 2.5 The Office Assistant. 

2.3. The Word Window 
Now Word is open and the screen looks like Figure 2A where you 
can see th:n it is divided into various 'Irea.';;, Now, you may feel that 
this looks more like an aircr-Jft cockpit than the d:lshbo;ud of a C;Ir. so 
a pilot 's licence. rather than a driving licence would s(.--em to be 
3ppropriate. However, you will gener-Jily only use one o f the 
commands at a time (each icon represents a command); some of them 
you will uS\:: a lot, while others you may hardly evcr use. Different 
1)(.'Ople usc Word in different ways and that is why you c:m customise 
your \Vord window. as we shall see in various chapters. although, 
strictly spea king, this is outside the ECDI. syllabus. 

!;l ........... ,.... ... __ ... ..w", 
, ___ . • • • , ••••• l'I"' .... 0·' · .. · 

a" IiI .G" .. ,' ... III .. e:ll."II . '~ · .. '~~ 

- , ,. ~ .. , 
~ :D . ~Il!I' .... . J" ...... J~1Iil ... ~ .. 

Figure 2.6 The opening screen in Word, 

Before we go on to describe the different areas o f the screen, notice 
th,l[. when Word SUrts up. it opens a new docu1llt::n1, G illed 
Document1 , and the name is g iven at the top of tht:: window after the 
Word icon :md, juSt to rem ind you. the words 'j\IicfOsoft Word'. At the 

top right of thc SCT\:.'cn are tllft .. "C icons, common to :11l Windows 
applicuions and descrihcd in ,\.kxlule 2. 

19 
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Exercise 2.3a 

If your Word window does not fill the screen, cl ick on the centre icon to 

maximise the window so that it fills the screen. You will see that there is still 

the taskbar at the bottom of the screen, which shows the Start button, the 

applications you have open (Word will be highlighted) and, at the bottom 

right, various icons representing background tasks in what is cal led the 

system tray. To switch between windows and applications you just click on 

the appropriate ptace on this bar. 

In case you have not read the Module 2 guide, the three icons in the top right 

of (almost) every Windows application do the fol lowing: 

CI or 8 

x 

Minimise: if you cl ick on this, the title of the application will 

appear in the bar at the bottom of the screen, but there will be 

no window open. 

Maximise or reduce in size: if the window does not occupy 

the fu ll screen, then you will see a button which enables you to 

make it do so, or 'maximise' il If the window is already 

occupying the full screen, then you will see a button which 

reduces the window size, 

Close: if you click on this. you will c lose (exit from) the 

application. If you click this in Word, depending on what you 

are doing. you may see a message on the screen, asking, for 

example, if you want to save the file you have been working on 

• You can ck)se any application by holding clown the AH 

key and p,. •• lng function key F4 (AH+F4' • 

• You can .witch between application. by holding clown 
.he All key and ....... Ing the Tab key (AII+ Tab). Thl •• how. 
the ..... window. ( ... F ....... 2.7, with t ... active window 
surrounded by a squ.,.. " you keep AH held clown and 
p,. •• Tab ... In. you will ....... squa,. move '0 .he next 
appllca.ion. You can cycle .hrough all .he open windows. 
To make a window active. you .Imply ,.I_se .... key. 
when it I. surYOUnCled by the squa,.. it Is useful '0 no'e 
that. although you cyele through .he ope .... lons ...... you 
key AH+ Tab a second time, .he pNvlously acttve window 
will be active a .. ln. Thl. can be very useful" you a,. 
switching backwards and 'orwards between 'wo 
appllca.ions or windows. 

.' . 
• B('f)L ' ... 
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Figure 2.7 Showing the open windows using AIt+Tab. 

The second line of the screen applies to the file you have open. On the right 

there is a Word file icon (a page with the Word icon superimposed - see 

Figure 2.7). 

Exercise 2.3b 
• Click. on the Word file icon and you will see var ious commands that attow 

you to change the document window (which up to now is integrated with 

the Word window itself). 

• Click Restore and the document window will become separate (and the 

Word file icon witt move to that window) (Figure 2 .8). 

• Click Move or Size and the cursor witt change shape and al low you to 

move either the window as a whole, by cticking in the title bar and moving 

the cursor and the window (known as drag and drop) or one 01 its edges. 

• Click Maximize or Minimize. These have the same effect as the 

symbols at the top right of the window, which you witt note are given 

separately for the document window, so that you can modify or close the 

document window without having the same effect on the Word window. 

Note that. if you click Maximize, the document window again becomes 

integrated with the Word w indow. 

Figure 2.8 You can separate the Word window 

from the document window. 
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Drat and drop: Drag and drop means lhal you pIac. the 
cursor on what you want to move and depre •• the left 
mou_ button. Keeping the button -.....-eI, you mov. 
the cursor, * .. kttI the Icon with It, to .... new po.ltlon. 
Then you let go of the mou_ button and what you w.,. 
movtng 'a window, an 6con, a fI'" will stay In the new 
positkm, " It I. aUoweel In that posttkm; you may al_ gat. 
me ..... giving you various opt"""; ... ModuI. 2. You can 

al_ .... drat ancl drop to mov. I.d, a. we ..... , ... lal.r. 

In most cases you will not use Document 1 , but you can do so, 

typing in the te)(t area and saving the document as we shall see in Section 

2.7. 

On the second line of the screen, there is also a list of words: File. Edil etc. 

These are menus and. if you click on them, the menu wi ll drop down; for 

example. see Figure 2.9. Click again (or elsewhere in the window) and the 

menu will close. Anything you can do with Word can be accessed Irom these 

menus and we shall be looking at many aspects of them as we go through 

the book. You will notice that in each 01 the menu names. there is nearly 

always a letter underlined. What this denotes is a keyboard shortcut, so that 

keying th is letter while holding down the All key has the same eHeet as 

selecting the menu. Within the menus, you will see that each command also 

has an underlined letter within it. To select that command. you can just key 

that letter (do not use the Alt key) as long as the menu is showing . 

...... 
p... .".... ,,_. ""'"" -1iiI _ CbIo. -. __ I;l1>0.. ---~=--
~,. -i_-
i'" _"" 
1'" . __ 

1..-...-..... 1·' ___ ...... 

"......-....._,,-
1·.--' .... 
I .. _" ..... 

Figure 2.9 The File drop down menu, ... 
• F:c":ot. · .. . 
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In a wa~ Wold Pft'dat .......... view Inco,,"" __ In 

.......... If rou put row ounor on a ........ ....... COl' 

.,.,. Icon,. " will be ~ ..,. • box and to open ". 
you cMok once. ........ rIv. ~ rou ...". ......... open. .. 
~ou moM .... 0 ..... downll, ............ will ....... ... 
,..,.,.. video CwNle on ...... ..,. .................. " 
d.p .... on how wour.pIeIn Is HI .. ,. To MIect ..... 
option rou ontr ...... to CIIck, ................... click. 
Note ..... ........ aIeo...,.. other .,proaohll. 

Below the menu names are ooe or more toolbars. Note thatlhe toolbars on 

your system may nol be exactly the same as shown in the figure: the 

Standard and Formaltlng toolbars are shown by default (Figures 2.10a and 

2. lOb). 

We will look at toolbars in more detail in Chapter 3, but it is worth repeating 

here that the toolbars contain Icons that are graphicat eQulvatents of the 

commands on the menus. 

There are also a few icons at the bottom left of the screen (see Figure 2.6). 

Clicking the icon is often quicker than accessing the menu and. If you move 

your cursor over an icon (called mousing over it), the meaning of the icon will 

be displayed in a small box. 

As well as the icons. most commands also have a keyboard equivalent, which 

is even quicker than clicking an Icon. However. you have to remember what 

the keyboard command is, so you will probably use keyboard commands for 

operations ItIat you carry out frequently, toolbar icons for common opera\lons 

that you do not need all the time and menus for tess common operations. We 

shall see examples as we go along and you will develop your own j)feferred 

way of accessing different commands. 

Figure 2.10a The Standard toolba, In the default .tate. 

- ___ , • • r 

Fig!olre 2.1Ob The FormaHlng toolbar in the defauM state. 
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TooIINrs do not "'v. to be .t the top of the ecNed; they 
c_ .1 ... be moved .round the ecreen ....... t they fIcNIt. If 
you w.nt to UN them In ..... w.y. you c.n •• tthough moat 
.,.ope. "'v. them ft.ed id the top of the screen; In .... t 
w.y. .n Icon la .Iw.ya 6ft the .. me .... c •. s-tlme., 
how_ ...... la uuful to ...... y • apecHtc 'ooIIM, hH' • 
.,.rtlc .... ' gak • •.•. edit .... pictures - .nd aomethnes they 
.ven open .... ....ucally. In such c. ..... no.t ..... ooIIM, 
can be helpful. bec4i .... H ................... ionII of 

c......m 1m ....... H la eIao M option to "'v., UYt the 
DrIIwtng .ooIbar _long the bottom of the document 

window. 

Below the tool bars, immediately above the text window (as shown in Figure 

2.6). is the Ruler, which shows the margins you are using, as discussed in 

Chapter t3 and any tabs you have set for the line in the text on which the 

curSOf IS currently placed. At the left there is a box showing the type of tab 

you can currently set. See Chapter 9 for more on tabs. II you are In Page 

Layout view (see Chapter 3). there will also be a ruter down the tell·hand side 

of the page. 

On the fight hand Side of the text window is the vertical scroll bar, which you 

use to move through the document. You can use this in several ways. 

Exercise 2.3c 
• In Document t, depress the Enter (Return) key (add some text if you wish) 

until you see the slldmg box In the scroll bar start to move down 

• Put the cursor on the sliding box and hold down the left mouse button. 

Then just move the mouse. and thus the box, up or down untIl you reach 

the liM you want in the teXl 

• Move the sliding box by pointmg at either the slogle arrow at the top. to 

move up. or the single arrow at the bottom. to move down the document 

and hold the left mouse button down until. again. you reach the 11J"\8 you 

want. 

• Click in the space above or below the sl iding box and you Will move up or 

down the document by one screenlul: repeat until you see the line you 

want. 

If you have a third button or a wheel on your mouse, you can also use one of 

these to control scrolling, but thiS IS outside the ECOl syltabus 

.. . 
• [(""DI.· ... 
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Above the top scrolling arrow is a small horizontal bar, which can be used to 

split the screen, but this is outside the scope of the ECDL syllabus and 

therefore of th is book. We mention it for completeness. 

Below the bottom single arrow, you will see two double arrows, with a circle 

between them. If you mouse over either of the arrows, you will open a box 

telling you what will happen if you click the double arrow. By default, you go 

to the next page. Mouse over the circle and it will say Select Brows. 

Object. Clicking on the circle will open a menu containing ten icons (see 

Figure 2.tl), from which you can select what you wanlto happen when you 

click on the double arrow. If you mouse over an icon, it will be highlighted and 

in a box below the icons, you will see what the option means. 

Some of these you may not understand at this stage, but we will come back 

to them (although not all), as we go through the book. Note that if you are 

using Find (Chapter 7). the Browse Object will automatically be set to what 

you are looking for (this can be disconcerting if you are expecting to go to the 

next page). 

Figure 2.11 Selecting the action for the double arrow buttons. 

We have already noted that there is a small tool bar at the bottom left of the 

screen, containing the view options (see Chapter 3) and alongside th is is the 

horizontal scroll bar. which you can use if your text is wider than the screen. 

You can use this to move horizontally in exactly the same ways as described 

above for the vertical scrol l bar. 

Unle •• your document Is very wkle, we ..... st that you 

change the Magnlfic.tlon ,sa. Chapter 3). so that your text 

fits In the sc ...... window. Although the horizontal cunot' 

will move automatlcalty tf you are Inputting, this can be 
very Irrttatlng. This Is even more the ca .. tf you .re 

editing Of' reading the text, beeau .. you have to scroll lett 

and right on every line. 
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Finally, Within the Word window, you have a line lhal gives you Informallon, 

known as the Stalus Bar From left to right , you see 

• The page number (e.g Page 4): 

• The section number (e.g. Sec 1) - note Ihal seCllons are oulslde the 

ECDL syllabus, 

• The page number and the lotal number of pages (e.g. 4/16); 

• The cursor POSIIIOll on the page (e.g. AI 17cm) - Ihe unll Will depeoo on 

what UnllS you have chOsen undE!f menu Toois/Opiions/General; 

• The line number where your cursor is placed on the currenl page 

(e.g. Ln 25): 

• The column number where your cursor is placed on the current hne (e.g. 

Col 79) - In fact. Ihls is not really the column number, bulthe number of 

characters to the left of the cursor minus 009, so thai when you go to a new 

line this number goes to 1 (before you type anything new); the termmology 

is really a hangover from the days when all characters were the same Width 

(see ChaptE!f 8 when we discuss lonls): 

• Five boxes labelled REC, ATK, EXT, OVR and WPH, describing the current 

operating mode(s): as you will see as you mouse over them, these stand 

for Record Macro, Track Changes, Extend Selection, Overtype and 

WordPerfect Help: within ECDL you only need to be concerned With OVA. 

which will become darker il you hit the {Ins] (Insert) key on your keyboard 

and will go grey again il you hit Ilns] again - lhls is called loggling, by 

defaull you are in the insert mode, so that If you type somethmg anywhere 

except atlhe end of a paragraph, the text moves to lhe right 10 make (oem 
lor Ihe new material In Overstnke mode, when you type, you overwrlle lhe 

charactE!fs thai are already lhere. 

• Then there are tWO final boxes. The Ilrst has an open book in It m , which 

shows Ihe Grammar and Spelling status. See Chapter 12. The laSI box 

shows an icon 01 a diskette when Word is saving your fi le in the 

background. This is a secuflty measure, so 1ha111 your system crashes you 

can get back your work up to the last background save, even II you haven't 

saved what you have dooe. You can set how often background saves take 

place by accessing menu Tools I Options I Sa ve , you can also turn 

them off if you Wish, butlhls IS not a good Idea It is also a good Idea to 

leave Always create backup copy ticked, so Ihat you have the 

previOUS verSIOll of a Ille to go back to. 

• r.C'D! • • . . . 
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Note tM' Word will only .. ve • MCUrtty copy tMt c.n be 
uSH tor recovery .ft .... cr.sh H you Mve .. ved tIM tile 

.t ..... once. It you do not give tIM ftle • n.me, then you 

will 10 .. your wortd 

Note thaI. even when the Word window is set for lull screen, you can still see 

the system bar at the bottom 01 the screen. Depending on how your system is 

set up, there may also be an Office toolbar (or maybe a Windows toolbar) 

down the right-hand side of the screen. 

Self Study 
1 Open Word (choose your method) and cxamine the Word window. 

Mouse over icons. Open menus. Try typing somc text into Document 1 

if you havc not done so already, but do nOl s;lve. If ever in doubt 

when you see ;1 screen thaI rt.~uircs ;\fl answer, click on Caneel. (Note 

that you C'Jn do no harnl, as long as you do nOl open an existing 

document ;md save it ;Ifter making any changcs.) Once you have 

finished, dose Word by clicking the Close box in thc top righl corner 

(click on No when askt><1 if you want to s;J.vc ch;mges to Document I). 

2, Open Word again (try a different method this time). Type a few 

sentences, Zoom in to make the tcxt larger (click on the down ;\rrow 

by the pcrcent;ige - prob;!bly H)(I'lAl - on thc Stand;ud toolbar (s{''C 

Figure 2. IO(a» and incrcase to, say, 200%). Now (a) Iype some mono! 

;md sec what happens to the text in the window and (b) try 10 read 

thc text you havc typed, using the horizontal scroll h;lr to t:lke you 

back ;md forth across the page width. 

2.4. Opening an Existing Document 
Exercise 2.4a 
To open an existing document, click on the File menu and then on Open ... 

(File I Open.. - Irom here on we will omit the stops after the command 

name). You will then see a window that looks like Figure 2.12. This contains a 

large number of ways to specify a file, but at present we will onty look at some 

of the options. First, smce we are going to open a Word document, we go to 

the box at the bottom left of the wmdow (Files ot type:). If it already shows 

Word Documents (·.doc), then you do not need to change anything. tl it 

says anything else, then, if you click the down arrow on the right 01 the box, 

you will see a list 01 options that you can scroll down. Choose Word 

Documents (·.doc) by clicking on it and onty liles with the extenSion doc 
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(the extension used by Word) will appear in the main file-name window. You 

can achieve the same thing by tyPing ·.doc in the box labelled File name: 

and then keying Enter. 

• 

"--:::,.~I~:::.-:::;==--,iI=-' ",§j~;!. "'="''!!'''!!E1''",I'=.oIll!f!!1 ~~~I r.q-""'" _o>rI209.doc ! {i\>otI 
.<I« !.l'0C2.doc 

-.IIll .doc ConooI -.... ~ ... 
-.~ 
-~ -------~ 

Figure 2.12 Opening an existing document_ 

Next, you need 10 see if you are in Ihe directOfy where the file you want is 

stored. The first time you open a fi le in a Word session, you will probably not 

be (by default you will probably be in My Documents), so you need to 

browse. 

Here you use the same technique as is described abo"e for looking for the 

Word application file. This assumes that you know where the file is that you 

want to open. More often than not. this will be the case. particularly if you 

have organised your directory structure in a logical way (see Module 2). 

However, if. like 311 of us. you sometimes C',mnot remember exactly 
what the file name was that you gave to a file or where you s3ved it. 
the Open dialogue bo x gives various w3yS that you can find the file . 

-nlCSC are outside the scope of the ECDl syllabus, but 3re fairly easy to 
understand. 

Once you have found the directory you want , you may wish to find 
out more 3bout the files therein. The icons to the right (sec Figure 
2.12) ;ll1ow you to view diffen:nt ;1~1X.""Cts of the file. Figures 13a to [3d 
show these different 3SpcctS. 

. .. 
• F.(,Dr. · .. . 
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"...... GEl 

_~·I...J~ 
,,_. _.do< 

.. !j,oa .... -, .... 
-~ 
-~ 
-~ 
-~ 
-~ 
-~ 
-~ 

3 ""~fii;.1"1"11!I 
1--

_~N[_:;_~~_~_~~=~ [;:;;;::==~ ... _ 1 ::J ,.., .. _-1 ::J 8"4 _ 

_ 01_,1 ___ (' .... ) ::I ........ 1..".- ::1 ..... -
"fIo(o)_. 

Figure 2,13a A simple Ii.t of flies. 

, 
"""''''''--- '_Ill'" ""'-- '1J06I21)I)O" . ., 
"' .. _-" 'IJ06I21)I)O.Ut ., .. _-- ,IJ06I21)I)O,,,.~ .,"'--- '1JO"I2OII01U • 

"' .. -- ,--" .. _-- '_'f,~ 

"""'--" ,,,.,.,.,..,. ... ., 
)'''-- '1JO"/2OII011"" .!.l 

Figure 2.13b More information about the file, such .s 

its .ize and when it was la.t modified . 

• __ I.G 

G," 
lMJOI!o'lI3DOot,,,, 

, 
,m 

Figure 2.13c Additional information about the individual file. 
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• 
1.-. 1::1_ :;] ~HII!!j;lll<!'I.I" [;i" 1lI 
~.- .' , :I I 0-

i-. 10-..110. ~ 

I-~ 
~ .. , 

-~ , _ .6>< ~ .. -
-.~ 
-~ 

In""' .. __ .... b.oIl 

-~ . . o....lrtIl."""""ofIl>oPC • 
-.~ 
-~ .,j . 0... • ....., oo.Qno 01_ N. .,j 

~""' ..... -----I :::J ' .... ..-.,,1 :;] .. -
""'<#~I_-'·(··doc) 3 .... ..-, 1..".- :;] -_. 
Uf6o(.)_. 

Figure 2.13c1 A preview of the file. 

The iast icon, Commands and s.ttlngs. provides you with other 

options outside the ECDL syllabus. 

Exercise 2.4b 

I 
I 
I 

I 
I 

Once you have decided which file you want to open. you can either double 

click on it or you can select it with a single click and then click Open. If you 

know the full name of the file you wish to open. you can enter that in the 'Fite 

name:' box and key Enter. Then you will only see one file tisted in the main 

file-name window. so all you need to do is click Open. 

If you want to open a file that you have worked on recently. then. by clicking 

on the File menu. almost at the bottom (immediately above Exit). you will 

see a list of file names (how many depends on how your system has been set 

up; the number can be changed by using Tools I Options I General. with 

the maximum number being nine). These are the last files you saved with the 

most recent first. To open one of these fi les. just click on the file name. Note 

that. if they are not in the directory in which the file you are currently working 

on is stored. then the full path (disk drive name plus d irectory tree) is given . 

... MCI of cltcIdng on FI .. 8ftd then on Open, pu c... tuM 
trpe Ctrl+O, which will 8ChIeve the .. me t~ 01' you c..­
cHell the Open fI" Jcon on the tool .... 

. .. 
• y.cD! • • . . . 
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Not. thIIt InatINd 01 click .... Open In the File Open 
window, you can ..... key lEnter. ThI. will ... a,.. be the 
c. .. when you hII ....... wIndow ..... when tat .. .... 

enter will be ........... click .... on the box ..... Is 
highlighted. .. c. ....... , howawer, If J'OU use thI .... pro.ch. 
which Is IIIIdoubtecllJ' laster, to ...... tINrt the option you 
wllnt I. I ............. 1ghtMI 

2.5. Opening Several Documents 
You can open aimost as many documents as you like at the same time 

(the size of the memory on your computer is the main factor limiting 

the number; along with the number of other applications you have 

open). 

You open each file in the way described above. To move between 

them, you click the Window menu :md you will see the files you have 

open listed at the bottom. Just click on the one that you want to bring 

it 10 the front. By using split screen and changing the sizes of the 

document windows, you coin view more than one file at the same time 

( this is outside the ECDL syllabus). 

2.6. Creating a New Document 
There are three ways to open a new document: 

Exercise 2.6 
• Click on the N.w document icon on the tool bar. This will 

immediately open a new document in whatever view you are currently 

using; we will deal with views in Chapter 3. 

• Type Ctrl+N. This is the keyboard shortcut tor the above and the effect will 

be the same. 

• Go to the File menu and select New. This will open a window that looks 

like Figure 2.14. Choose the icon that is labelled Blank Doeument. It 

your system is new. this may be the only one visible. Make sure that. under 

Create New. Document (rather than Template) is selected. We will 

discuss templates in Chapter 10, when we will come back to all the other 

labs shown in Figure 2. t4. 

31 



Module 3: Word Processing 

Open Word and type a letter, putting your address (or whatever address you 

want to use at the top) and using the usual forms of address. Perhaps you 

could tel! a friend about doing the ECDL course? Do not be concerned with 

formatting or typefaces etc. Just use the typeface that appears when you 

type and allow everything to align left. 

-" !l_.&.F __ l_l 00I0r~1_~1 0ffI009$' ..... 1 

• - _rwot_. 

Figure 2.14 Creating a new document via the File menu. 

2.7. Saving a Document 
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There are three ways of saving a documem: 

Exercise 2.7 
• Click on the Save file icon ~ on the tool bar. If the document IS new. 

then you will see a window like that shown in Figure 2. ts. To save as a 

Word file. all you need to do is make sure that the name suggested is 

acceptabte. changing it If it is not. and ensure that the file will be saved in 

the correct directory. The window is. in fact. quite similar to the Open file 

window and the icons mean the same. There is one icon . that we have 

not seen previously: this allows you to create a new subdirectOfy within the 

current d irectory. Once you have determined the name and place for the 

file, then click OK. You will then see an expanding bar at the bottom left of 

the Word window. tracking the progress of the save. If you are saving a file 

that has previously been saved, then you will only see the progress bar and 

not the Save window. 

. .. 
• • ..rDl. · ... 
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.0 •••••••••••••••• 

- .. I..J_' 

!:'..:.doc ~= ~'.doc~"""""".doc 
-..a2.doc !l'«:>-"" 
~----~ --

3 ~ .. H!lIi5,.lallll 
1--

Figure 2.15 Saving a new document • 

• 

• Go to the File menu and select Save. This will have the same effect as 

clicking the icon . 

• Type Ctrl.;.S. This is the keyboard shortcut and again the effect will be the 

same. 

If you have not already carried outlhe exercise In Module 2 in which you 

created a directory (in My Documents) called ECDL. with subdirectories for 

each module, then we suggest you do so now. Start to save your document 

and you will see the Save menu (Figure 2.15). Make sure that you are in the 

My Documents directory and click on the Create a New Folder icon. 

Type in the name t.:CDL and then open that directory by double clicking or 

single clicking and then clicking Open. (If you wish, you can then create a 

subdirectory called Module 3.) Once you are sure that you are in the directory 

where you want to save your file. decide what you want to call your file, 

perhaps JeuerO/ .doc or leslOI .doc and then click on Save (note that when 

you have a directory selected this button changes to Open). We shall come 

back to this file as we go though the book and we shall refer to it as test01 

(and others as test02 etc.). Please also save the file as test02.,loc, perhaps 

after making a few changes. 

2.8. Saving a File Under a New Name, In 
a Different Directory or on a Different 
Medium 

If, when you arc working o n a file that has been saved before, in.~te;td 
of sc!e<:ting Save, you <:an select Save As in the File nlenu. TIle 
proct."dure is the sanle as if you were saving a new file; you can 
<: hange the n;une of the file ;tnd/or the dire<:lOry in whkh you ~;tve it. 

You can also save onto a different medium. When you browse through 
dirC<:lOrics, if you keep pressing the Up One Level icon ~, you will 
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eventually reach My Comput.r and you will see the drives on your 
system list(.-'(I (see Figure 2.16). "I11cn you select the drivt:: you wam 
(making .sure, if appropria te, that there is a form:Itt(.--d disk in the drive) 
and next move down the directory ~' rodure, creating directories if you 
wish. When you reach the level where you want to save the file , you 
click the Save button. 

~~ •• A, (J EJ 

s-t>' I. fottCo!r<Uot 

lll>A:!<oy(A) 

~~(c:) 
F R_OoIi<(f') 

3 ~ ~ l!.IlifalR I ~ 
I~ 
~ 

~I ~ ... 

s-~· I 

Figure 2.16 Saving on a new medium. 

We shall discuss s:lving in other form:lls in Chapter 4. 

" you want to ..... file ••• kind of 'unofficial template', 
lor ........ you .N using one lett ..... the basis lor 
.nother, It I •• good .dea 10 .. ve It under • new file name 
HfoN pu .... ke any cha ....... " pu do not do this and go 
........ nd make the c ......... t ...... I. always the chanC. 
1hal pu will click on $av. and .verwrlt. your .,.. .... 1 file. 
WhIle yow .plem .... y hav. been set up to keep • bM:kup 
of the original file. It I. much _ •• H 'OU do not have I. 
uselt. 

2.9. Closing a Document and Closing 
Word 

Exercise 2.8a 
To close a documen1. you can do one of the following: 

• Go to the Fil. menu and select Clos. (File I Clos.) . 
• Click on the Word document icon on the left of File and then on Clos • . . . . 
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.a •••••••••••••••• 
• Click on the Close box at the top right-hand corner of the document 

window (not the one at the top of the screen, which will exit from Word), 

• Type Ctrl+W. 

If the document you are closing has not been saved, then you will be 

prompted to sa"e It. 

Exercise 2.8b 
To close Word, you can do one of the following: 

• Go to the File menu and select Exit (File I Exit). 

• Click on the Word icon In the tit le bar and then on Close. 

• Click on the Close box at the top right-hand corner of the screen. 

• Type Ctrl+F4 (function key 4). 

If there are any open documents that you ha"e not sa"ed, then you will be 

prompted to sa"e them. 

2.10. Using Help 
'11lt:re arc v:Jrious ways you can obtain hdp on using Word. With 
<.::Irlicr v<.:r,~ions, you would h;lve received a fairly large primed m;lI1ual. 
but tooay almos! ;111 heip is provided e lectronically. which should 
mean that it is c:l ,~ier to loc:ltc what you W~l(lt to know. Even now, 
however. there ;Irc different :lpproachcs you GUl t;lkc_ 

The fir:.! of theM:' is called the Office Assi~tant. which we :lln.;~ldy noted 

will prob:lb!y :Ippcar the very first time YOll lISC \X'ord. The rathl~r sly­
looking character, based on a paper dip. is Gilled Clippit. 

To np!.'n Office Assist;mt. if it is not alre:tdy open. dick on the 
Question Mark icon I1J on the toollnr. prcss function key Fl or go 
to tlw Help menu and select Microsoft Help. Clippit will then appear. 
;ll> in Figure 2. 17. ;Isking YOll what you would like to do. If you type in 
;1 question and then d ick Seareh. Clippil1 will do its 1X:l>t to :Inswer it. 

Some options will then ap]X'ar, If YOll sciect one of these, then a 
relcvant Help screen will ;lppcar (FigllfC 2.18), 

Once you h:lvc read th;lt screen and any others tll:lt 1ll:1Y he linked to 
it (:md evcn printing it if yOll wi~h by clicking on Options and 
:.electing Print) you can dO'se It by using the Close box at the top 
right corner. To r~a(·tivate the Offic~ AS ... bt:lnt. just dick on him (or 
press function key F]) ;Lnd you will find the .";I111e dispby ;1" in Figure 

2.17. You can then dick on a different option. 

35 



Module 3: Word Processing 

3. 

What would you lik", to do? 

• ~ the font rJ text ot numbers 

• CI'w'qe the size rJ text ot numbers 

• Set tile defd: font 

• CI"Iarlge the color rJ text a...J numbers 

• Let Wotd lotl'Ml ....,. doo.merb a...J 
Wot~ messaoes 

.... ~rnore .. 

I:···';'·'· 

• lips: . """" . """ 

Figure 2.17 The Clippit Office Assistant. 

ChangQ thQ font oftQxt or numbers 

~ Showme 

Selecllhe text you wanllo change 

2 On the Formatting toolbar. click a fGnt 

"m,," m, '0. b" I """ I-

Figure 2.18 A Help screen. 

If you do not like Clippit, there are a number of o[her chamdcrs [hat 

you can use. To access these and o[her ways of customising Office 

r\s:; islant. you need to click Options in the Office Assis[ant window. 

TIle Gallery lab will allow you to move [hrough the various alternative 

characters (Figure 2.19). hut perhaps morc important are the Options 

themselves. Most of Ihese arc fairly self-explanatory. A word, however, 

ahou[ Tips. . .. 
• [COl. ' .. . 



First Steps With Word Processing 

.0 •••••••••••••••• 

"" .... ,,", .... • 

.... .., ..... .......,. .... _ ..... "'_ ... _--,..-..._,.,. .. _-_-..""' .... ""-.. _ ......... "", .. """"._--.... -...... 

- -""'_<# ... __ ...... _<# ..... _ .. _<#_ ...... _-
~-

Figure 2.19 The Office Assistant Gallery, showing an 

alternative character to Cllpplt. 

Depending which options you have selected, then when Office 
Assistant 'thinks' that you could do what you are doing more 
efficiently, a light bulb will appear in the top right corner of the Office 
Assistant window. If you dick on that, you will see the tip (sec Figures 
2.203 and 2.20b). 

Figure 2.2Oa The Office Assistant displays 

• light bulb to show it has a tip tor you. 

,---------------------------. . V .. __ , ....... ____ ... ...u""" ...... _ .. -"' ... __ . 
• to<>.. . 0>00 

Figure 2.2Gb The tip Itself. 

If you no longer find Office Assistant helpful. you can close it. You 
should also note that. when you are using Office Assistant, all 
messages appear in the Office Assistant message hox, r.uher than in an 
ordinary dialogue IX)x, so it is possible that you may miss them 
because Office A.-.sistam has become a fixture th,11 you tend 10 ignore. 

You C'oln also use Help in a more conventional way. Go the Help 
menu. at which point you have two choices (in addition 10 opening 
Office A.-.sistam): 
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• Select What's this? The Qu.stion Mark icon ~? appc<lrs in the 
Help menu :llld can be added to the toolbar. '111is will provide you 
with context-sensitive help. i.e. help about the p:m of Word that you 
are currently using. Your cursor will change to the icon :lnd when 
you click in any part of the Word window a small window will open 
giving you information (see Figure 2.21). To cancel this click again 
on either the toolbar icon or the menu option. 

--,_ ... _-_ . ., .. -...... _'._-w-, .. __ .... .. - _.------_ ..... _ .... ---=--------
t'~".~~,-:-.. ~-. -

Figure 2.21 A Help window produced by s.lecting What's This? 

• Click on Contents and Inde • . 

As you can see from Figure 2.22, Help is self-explan:lIol)' , as indeed it 
should be if it is going to be much use. A little expl:lnation lllay be 
helpful, however, specifiC:llly for Contents, Inde. and Find: 

• Contents gives you the view shown in Figure 2.22. If you are 
learning about the system or are not really sure, this is probably the 
easiest approach. 

tki._,ond __ -.O' __ .... _ .. _ 

• ro-,, "oI> . _ ... R_"' ... 
• ~"""_ond", __ r ... • o.-..c......., ... ~ ...... ~ 
. '_"_ond_ 
• (......, ond$_ 
. """,,",,~ondc..-.'­.~",--~~ ... p ... • -.-_.ondc.......,Do-.._ • ........,-'_...:1_1-. "'--' .... -..... • ,.....", 0 ... _0h0"- ...:I _ 
~ __ 0.- ...:1_0..0..-.. 

• 

Figure 2.22 The Help screen showing Contents. . .. 
. .. Cot" .. . 



Firs. Steps With Word Proeessing 
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• Index gives you a ·b:lck-of-thc-book· type index (see Figure 2.23) 
:lnclthis is quick if you know what you are looking for :md if you 
know the term Microsoft uses, which may not always be obvious' 

, r.- .......... _ ... _ ...... _ .... 

' . 1""" ... __ .... -. ... _-"-
- =I .--~ .. --­_____ 10""<0<1 ------
~~ _.------ -

• 

Figure 2.23 The Help screen showing Index . 

• Find (sec Figure 2.24) allows you 10 search for any word. You put in 
the word or phrJ5e and then follow the instmctions. This will 
eventually yield what you want if it is there. 

• 
c..-I_ roW 1 

Figure 2.24 The Help sereen showing Find. 

The final option in the Help menu is About Mierosoft Word and this 
will give you infomlation on various aspects of the progrJI11 (Figure 
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2.25) and indeed your system, if you click Sy.tem Info. Note that 
there is also a Technical Support bunon that opens speci:1l Help 
screens that tell you about Microsoft Technical Support. 

--"~I"''''''''-'' 
~1"I Io>fJeO~""_. 
fnIIliIh tt-..... ...- ......... ,.""-'" '" 
......,1'IMIftIg 1'It. 
~ ___ """"'fw-.art~"" 1>r __ ~s.&I""'~ 

'-" ........ Cl"' ...... 5oftwoN, h . .. ...,. -n-........., .~"" 

Figure 2.25 The result o' .electlng the 

About Microsoft Word option. 

Self Study 
Experiment with the different ways that you can find help. Don't worry 
about finding infonnation about a specific topic (although you may 
want to do that), but ensure that you are happy about the ways in 
which help can be obtained so that you CJn decide which approach 
you prefer. 

Summary 
In this chapter: 

• We have seen how to open Word. 
• We have examine<lthe Word window. 
• We have seen how to open one or more existing documents. 
• We have seen how to create a new document. 
• We have seen how to save a document. 
• We have seen how to save a document under a new name, in a 

new directory or on a different medium. 
• We have St.."Cn how to dose a document and how to dose Word. 
• We have seen ways o f using Help. 

. .. 
• r.cDl. · .. . 
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Adjusting 
Basic Settings 

Change the basic sellings. 

Change the page magnificalion. 
ModifY the toolbar display. 
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Module 3: Word Processing 

3.1. Introduction 
One of the great advantages of Word (and Ill:my other modern 
programs) is thaI. in m;my wayS. you can choo~e to use thel11 :[~ you 
want to. ralher Ih;1ll ;I~ the software de.~igne r felt was the right W:ly. 
There :tre. of coursc. always things thM you would like 10 change hUl 
GHlnOL Here we sh:[11 look :tl soille of those you Gill. 

3.2. Changing Display Modes 
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If you look at tho.: View mt:nu. you will sec that IIll're :m: fil 'e dispby 
[J1(xio.:s listed, 

• Normal. which is probably the easiest to work With. in lhat the text 

tills lhe Word wiodow (Figure 3. 1) and page breaks ;Irc JUSt 
indic;I1<-"(1 by ;1 broken line acro~ the screen. [t is important 10 

remember, however. Ihat neither drawings ,Hld :tr1lvork in boxes nor 
page he:lders and footers appear in this vicw, so yOll ne<:d to be 

careful if you h:lve these things in your document 

• Adj usting·basic·setti ngsll 

, 

. ~ ~~""·-'''_·I 

. . a....n~ .... ,_-._, .. _ , 

Figure 3.1 Normal view . 

• Online Layout. whkh .'iplitS the window into two Ixmes. with :1 

\;Ible of (Onlents in Ihe left-hand P;IOC (Figure 32), II is f:lirJy 
important thaI you use .'ityle.'i to take advantage of this view (see 
Ch3pter [0). Its hig :\dvantage is Ihat if you dkk on one of the 
headings in the left ]XlIle. you will jump to thc appropriatc place in 

the dCK:urnenL 

... 
• H'Dt.· ... 
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Hi "M"" !l('>-'* ____ , ... _ .... 

, ----,,-"-"-­-u-.. .... _ ----.. -..",-
oIiii 

.... , .. , ... 

• " • • , ••••• ..::.;:U' U' 0·',4,· 
.:1<1"', ". IIO~ • ...,I5J'f - (Jj . ....... .. 

.~ 

.--, 

·1,t·_ 

.:.._ ... ,.· ... _,../-w .... __ --..._"'_ .. 

J!!d OJ • .., .-.I...y._I~It-'1 

Figure 3 .2 Online layout view . 

•• ••• 

• P age Layout . which shows ~'ou how your d<x:ument will ;lppcar 

when printed. with all the gr::lphics etc. (Figure 3.3). 

"tthe.ll l. .'fI ' !l ...... ____ ' ... __ ..lila; 
_, . ... . " • • " ..... F-1l11a" 0"' 4.' 
o ~ " .t?'" 0<1"', ..... IIOGl • ...,m . - .(!t~~I), ... .. 

~ .. - ..... -., ........... _-, 
., . .".,., .. _-_. 
"-""""'-' 
"'-

.... , .. , '" .... Q) 
~:<l. ~ ._.j,.!j'-I~~ 

Figure 3 .3 Page Layout vie w • 

• Outline . which allows you to sec the structure of your document, 

ag:lin using the hC:lding styles (Figure 3.4). 
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':] .... _--- -­.... . . -,· .···,·=·. 51 
, ..... , ._ . ~ • • , ...... 10" •• 0 ... • ... · 

# 11 .11:' .~. ~. aCl!ll. ~" ~.!lI J'''' .. . 
- 311 ~ 

~,;,I .j! 10. raor-J ..... r.=-It_d 

Figure 3.4 Outline view . 

",i! 

J 

• Master Document, which is used when you group a number of 
documents into a larger one. This is outside the scope of ECDL :md 
is. in any casco not always predictable. 

These views can also be accessed from the tool bar ;it the b(){lOm left 
of the window (see Figure 3.5). 

Figure 3.5 The View toolbar. 

Self Study 
1. Open test01.doc or te.t02.doc. Expcrimt:nt with the Normal :md 
Page Layout views. The laller will give you a good idea, for example. 
if your leller will fit on a single page. 

2. If you have acres:> 10 a longer Word file, including he;ldings dC., 
open it and experiment with the Online Layout and Outline view • . 

3.3. Changing Page Magnification 

44 

You can ch;mge the page size of ;] document, as well :IS the type .~izes 
within it. as we shall see in Chapler 8. Howevcr. it is convenient 10 be 
;]blc to see Ihe text at a larger size. so as 10 m;lke editing c .. ~ier 
(although [hat may lead [0 problcm~, as nOted in Chapter 2, if [he 
page width is wider than the screen). You may also wish 10 see a 
number of pages ;It ;1 sm;llIer sil.e so as 10 obtain an over-til impression 

of the layout. Remember. however. tha! in either CISC. you arc 
changing how you look at the document and not the document itself. 

• F.cOl . · 

' .. 
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Exercise 3.3 

You can set the page magnification in two ways: 

• Go to the tool bar, where you will see the box (Figure 3.6a) that allows you 

to picl<Jspecify the view size as a percentage; the current percentage will 

already be shown. If you ctick the down arrow on the right-hand side, 

you see a list of fi xed percentages, plus Page Width. Just click on one of 

these and the magnification will change. Alternatively, you can type the 

percentage you want to use directly in the box and then press the Enter 

key. If you choose Page Width, the system will calculate the percentage 

so that your text (in Normal view) or the page (in Page Layout view) will fill 

the width of the page. 

Figure 3.6a Zoom options on the tool bar_ 

• Go to the View menu and select Zoom. You will now see a window (Figure 

3.6b) with a selection of percentages, as well as Page Width and, if you 're 

using Page Layout, Whole Page and Many Pages. Your present 

percentage is shown bottom left and you can again type d irectly into this 

box or pick from the lis\. Whofe Page, of course, shows the whole page on 

the screen, whi le, if you choose Many Pages, you can click on the 

computer icon to choose from a series of preset layouts (Figure 3.6c). You 

can also see a p review. Click OK when you are happy with what you have. 

. r 

rgJJ 
~' :B 

AaBbCcDdEeXxYyZz 

AaBbCcDdEeXxYyZz 

Figure 3.6b The zoom options obtained from View I Zoom. 
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L""", 11 E1 -."""""'~ c_ 
C..,.. 
c".. c __ 
c __ 

Figure 3.6c Preose' mutti·page options. 

Although you .. ..,.allying percentagea. It I. not ,..1.,. 
• ...,. elM, _..u, ..... thQ .. ~ of. " you 
chooM 100%, lIMn IhtlftMt" on MNMI .. not .... ...... 
.. It would 1M on ,..... It wHI ~ dip Ind on the ... of 

YOW' acreen. "... It ......... to ... what rou ... on the 
acNeII ......... to typt ..... In .... nn.I printed 

document. AIthouah ZOOINng .. NferNcI to. thIe Ie not a 
...... le.1 zoom lik ........... manr ............... ...... 
............... of Intereat I. Mlected ..... zaa ..... 
~ .... view eo that ........ of ......... fli. the 
ac ..... window. Note that .... Page WIdth rnagnlflc8tlon In 
the Online "rout does not ha .. ...,. ,..1 ......... ThI. I. 
lMclluae .... text In .... rftIht; ............ ..".. •• TNa 
muna that ..... tine ........ I. IMIjuateci to fill ..... width of 

the window. 

IIItch "rout view Nta .... ttl own megnlflcatton. so that. " 
you ~ .... ~ton In 1rIorma1. you do not.lter" 
.... for .x ....... Page urout. 

Self Study 
Continue with the files you had open in lhe earlier examples in Ihis 
chapter and change the magnification in the different views 10 see 
what the effe<:ls are and whether larger sizes are helpful or present ;I 

problem. 

. .. 
• r.cOL • . . . 
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3.4. Changing the Toolbar Display 

The toolbars, as described in Chapler 2, are sets of icons that represent 
10015 (or opennions Ihal you C;lIl carry OUI). Word comes with a 
number of 100llYJrs already prepared. To see a list, go 10 the View 

menu and sek'<:t Toolbars (sec Figure 3.7). To sec what is on each 
loolb-Jr, if you can seled one, it will appear at the lap of the screen 
(those that are ticked arc already showing). To remove a toolbar, JUSt 
open the Toolbars window again and deselect it. It is obviously 
impr:K1ical 10 have all the toolbars on the screen, so you need to 
choose which ones are most useful to you. Indeed, depending on 
what you are doing. you may change your selection from t;Lsk to task. 

... ,'" 
'"""" .... ....... 
"'-' -..... --Tallis «Id 8ordarI: ........ 
WoO ....... 
80CikuIM 3.1 

Figure 3.7 List of available toolbars. 

As noted earlier, with a few exceptions. such as the Layout toolb;lr in 
the boltom left of the Word window, most loolbars can be moved 
around the screen. If a toolbar is 'locked' at the lOp of the window, 
then place the cursor on the double lines at tlte left and just 'dmg and 
drop' (Figure 3.8a). if the tool)):lT is floating. you place the cursor in 
the title bar :1\ the top of the toolbar window (Figure 3.8b). Note that 
when the toolbar is floating , you see what il is called . which is not the 
case when it is 'Iocked' ;11 the top of the window, As nOlcd in Chapter 
2. you may find it helpful 10 use floating loolbars when you are 
carrying OU! ;1 specific task. 

., .,,"'.""~".~. 

Figure 3.8a A fixad toolbar. 
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Figure 3.8b Moving. flo.ting toolb.r by dr.gglng It. title b.r. 

You m;LY have noticed that :1\ the bot(Om of the Toolbars window it 
says Cu.tomb:e. This is outside the ECDL syllabus. but it is worth 
experimenting with once you arc more confident, bcc'J.use you may 
want to add to the toolb:Lrs icons that are appropriate to the work you 
do. You C.1n even create your own if you wish! 

The icons on the toolb:Lrs are not really self·explan:Llory, excel" 
perhaps in a few GlSCS. However, to find out what they mean, JUSt 
move your cursor over (mouse over) the icon and a small box will 
appear telling you wh:LI it means. There is a certain knack in doing 
this, so move the cursor around over the icon if the box does not 
appear immediately. You will get to know the icons you usc regularly. 

Self Study 
look at the list of tooloors in the View menu. Sell'a as many as you 
can and mouse over the icons, so as to try and familiarise yourself 
with what they mC'J.n Try moving the toolbars so that they are fixed 
and floating . 

Summary 
In this chapter we h:Lve seen how to: 

• Change display modes (or views). 
• Change the page magnificJ.tion. 
• Change the tooloor displ:iy. 

• ,.cD! .. ' .. . 
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Saving 
Documents in 
Other Fonnats 

Save a document as a simple t@-tfile. 

Save a document for Lise in olber versions of \Vord 
and other word processors. 
Save a document in Rich Text Format (RTF), 

Save as a document template. 

Save different versions of a document. 
Save a document in a/arm tbat can be pllt up on the 
World Wide Web. 

49 
D. Penfold, Word Processing
© The British Computer Society 2000



Module 3: Word Processing 

4.1 . Introduction 
You may not always want your document ;IS a Word document. for 

example you may want a web version. or you may wam to send it to 

someone who has an earlier version of Word or someone who b 

using, for example, WordPerfect or Word on a jl,bcintosh. Thus Word 

provides WJys of saving documents in other formJts. 

4.2. Saving a Document as a Simple 
Text File 

5. 

As discussed in Chapter I. while Word documents include fonmuting 

information when they arc saved. so that next time you open them 

they have the same appt:JT',mcc JS previously, there arc times when 

you only want to save the text, i.e. the letters and spaces, plus 

punCl u;u ion, carriage returns and tab Char:lClers. These are known as 

~imple text files (usually with the file extension ,txt, J lt hough others 

arc used as well). 

Exercise 4.2a 
To save a file in texlformal, go to the File menu and select Save As, just as 

you did in Chapter 2 when you wanted to save a document under a different 

name. This time. however, as well as selecting the file name and the directory 

where you want to save ii , go the drop-down menu Save as type (Figure 

4.1). Here you will see a list of various options, which you can scroll down. 

Near the top, however, you will see variOUS .txt options: 

• Text ooly. 
• Text ooly with line breaks. 

• MS-DOS text. 

Figure 4.1 Save as type: box expanded. 
.' . 
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• MS-DOS text with tine breaks . 

• Unicode with line breaks. 

The last three you can ignore for the purposes of ECDL: they code accented 

characters and other symbols in different ways from Windows. The difference 

between the first two is simple. TelCl only includes a carriage return only at 

the end of each paragraph, whereas Ted only with line breaks adds a 

carriage return at the end of each line. as it appears in the Word document. 

The latter may be useful if you are going to use the text file in some 

application where the text is not automatically ·wrapped· (although such 

applications are less common today than they used to be) Note that, i f you 

do not include it, Word will add the .txt file extension. 

Although when you save as text, the e)(isting formatting remains on the 

screen . if you close the file and reopen it in Word, you will find that all the 

formatting you added has disappeared. The other thing to note (and this 

applies to all saves in di fferent formats) is that the file name and the file 

extension in the tille bar wil l have changed. Thus you are now looking al the 

new lile and not the Word file . If you want to go back to working on the Word 

file . you need to reopen it . You should remember that if you want subsequent 

changes saved in the new format you will have to use Save As again. You 

will then see a message asking you if you wish to overwrite the previous file or 

not. Cl ick OK to accept. 

Exercise 4.2b 
Open lestOi.doc. Although it has very little formatting, it will almost 

certainly be in a typeface such as Times. Save it as testO l .lxt and (with line 

breaks) as tesI03.lxl. Close the file(s) and then reopen them and notice the 

differences. 

4,3, Saving a Document for Use in Other 
Versions of Word and Other Word 
Processors 

Word makes it extremely easy to save a document for use with carlier 
versions of Word, or indeed othcr word processors. 

Exercise 4.3 
Click on Save As in the File menu and look through the Save as type list 

until you see what you want. This list contains various versions of WOfdPerfect 

and Word 6.0/95 (as well as RTF and HTML, which we shall consider in the 

following sections): see Figure 4.2. 
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I 

Figure 4.2 Different view of the Save •• type: box. 

You simply choose the option you want, as for text files, and Save. Again the 

correct file extension will be added if you do not include it. Note that if you 

save in Word 6.0/95, you will see a warning that you may lose some of the 

formatting (Figure 4.3). 

fhI~ _ _ J-..,....tod> .. bobst .... COIWIt..,toWord 
6-om; fcnool. To pr--.., ..... ntIII ~ dd:. Ho to e>:t INs <Wog, then_ 
..... '*'-"" hwn,....bof<n~ 
c:ara.. ooIh .... 1 

Figure 4.3 Warning window di.played if you save a Word 

file a. a. an earlier ver.ion of Word. 

4.4. Saving a Document for Use in Rich 
Text Format 

52 

Rich Text Formal (R'IT) was invented by Microsoft as a document 
interchange language for moving documents between word processors 
and, indeed, mOSI word processing progrJms, and some other 

programs, can now open files saved as RTF, which can be useful. As 
noted e::lrlier, an RTF file is actually a text file with all the forrnalting 
inSlrudions spell OUI as codes. Part of the file of this sedion as 
originaHy entered looks as follows in RTF: 

... 
• r.CDl. · .. . 
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i --

(Ib' 
\par )\pard \Sb6lJosIJro.slmulll\Wldctlpat'outJlnelevellJ..adjustright I'b SaVing 

documents in other formats 

\par )\pard \sb6O\slJro.slmult l\widctlpar\adjustright (\b 

\par !\pard \sb6O\s13W.slmult l\widctlpaMut!ineleveIO\adjustright I'b 
Objectives 

\par l\pard \sb6O\sl36O\slmult 1\widctlpar\adjustright (In this section you will 

learn how 10: 

\par (\pntexNlartf.,plain\l3\!s2Ck:gricl \Ioch\a/3\dbch\afCNlich\l3 \'b 7\labU\pard 

\li-36CNi36O\sb6O\sIJro.slmult l \widctlpar\4Clisttab'l1x360I\"\pn 

~lvlblNlvl(Ns \2\pnrnot(1,pnf3\postart l\pnindent~hangl'f>ntxtb 

\'b71I'1s12'adjustnghtl 

Save a document as a Simple text lile 

Before Ihis p:lss:lge, which is the stMI of the text, there is a very long 
section, often called the preamble, which s)x.--cifies almost all aspects of 
the layout. -111i.~ i.~ often longer than the file iLorel!"! 

As you can S<.'e, RTF is nO( a reader-friendly language, but it does not 
need to be as it only really m:."(.-ds to be understood by other word 
processing progr-.uns. If you open an RTI' file in Word, you may be 
asked to confirm Ihat it is RTI' or it may JUSt open like a Word file; this 
depends on how your system i~ sel up, but normally you will never 
see coding like that above, unless you want to. 

To save in this format, again usc Save As and this time sclect Rich 

Text Format. Word will aUlomatiC"".llly change the extension to .nf. 

WonI _ M ..... to .. for conIIrMatIon ....... file Is 

.p ...... In ....... that Is not Ward. In .... Tooh;-. 
MIect 0ptJ ............... the o...r.I a-. You _ ... that 
.... of ............ ConfIrm con ........ lit o.-n. H this .. 
ticked. ...... rou _ M __ eel to confirm thIIt • tile I. 

Indeed RTF, for ......... You c.n ........ click 0.- or rou 
_ ....... taxt one, Nt ....... then cl'-'k Open. You wHl 
............. RTF •• ted. TIle ...... c.n M done for tITIIL 

...... H rou do this wtth ......... trPno rou ......, .... 
acNeII of ce.r.ot.... ..................... to rou- Note 
..... If,... try to .......... In _ IncarNOt..,....., ...... 

...... text .......... WonI_ ... rou ............ not -. 
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Exercise 4.4 

Open your file text01 .doc and save it as RTF. Close it and then reopen it. 

Did it open immediately or ask you to confirm? If the latter, key Open. In 

either case you should find that the file appears identical with the original 

Word file. If you want to see the RTF fite, ensure that Confirm on Open is 

selected and then select text in this box, as discussed. As your lile is quite 

short, go to the end 01 the file and work up until you lind the start 01 your file. 

Looking at the position of the box on the vertical scroll bar will give you an 

idea 01 what proportion of the file the preamble takes up. 

4.5. Saving a Document as a Template 

54 

We shall look at docurnern tempbtes in Chapter 10, but all you need 

to know now is that a template stores ali the formatting information 

that you have created. It can contain text, but docs not have 10. When 

you create a new document using File I New, you have a choice of 

[cmpl:ucs, as we shall see in Chapter 10. 

Exercise 4.5 
If you want to save a lile as a template, you can delete all the text that is 

specific to the document. but leave. for example, your address in a letter 

template and then go to Save As and choose Document Templ.t. in 

the Save.s type box. You will notice two things (Figure 4.4): 

• The file extension changes from .doc to .dot. You may also want to 

change the file name to something that is more generic and describes the 

template type rather than this particular file . 

• The directory changes to one called Templ.t • • . Until you have more 

experience. it is wise to accept this and stme the new template in this 

directory. In this way. when you open a new document with File I New. 

your new template will be one of the choices offered to you. 

s::::::'-..J"" __ 

Figure 4 .4 Saving a file . s a template. 

. . . 
• ECDI.· ... 



Saving Documents in other Formats 

--------ee .. eHet-<O e e e e e e e e e e •••• 
Self Study 

While you can open te.t01.doc and look at saving it as a template, 
we recommend that you only look and do not save. The file as yet 
contains too little formatting information to make saving it as a 
template worth while. 

4,6, Saving Versions of a Document 
There may be situations where you want to save different versions of a 
document without changing the file name. 

Exercise 4.68 
If you choose Save As and click Save Version. you can save different 

versions of a document all in the same file . You have the opportunity to add 

comments to each version (Figure 4.5a) and when you reopen the file . you will 

see the latest version. If you go to the File menu and select Versions. a 

window like Figure 4.5b will appear. You can open earlier versions by 

selecting them and clicking Open. You can also delete previous versions and 

so on. 

• •• v"""~ (113 

. -
Figure 4.5a The option to add comments. 

r.-._._ ... _ 

Figure 4.5b The opportunity to review earlier versions. 
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Exercise 4.6b 

Open textOi .doc . Make a few changes and then save the new version. 

Make a lew more and save another version. Review your versions. When you 

have tinished, delete aft except the original and the most recent version. 

4.7. Saving a Document in a Form That 
Can Be Put Up on the World Wide 
Web 

56 

The World Wide Web uses a coding system called HyperText i\k1rkup 
Language (HTML) with which to describe formalling. A web browser, 
such as Internet Explorer or Netscape Navigator, interprets this 
language in just the same way as Word interprets RTF, so that you do 
not see the coding on the screen. HTML C'J. rries out ;\ similar task to 
R1T- and is also a text file, but it is Illuch Simpler. The s ame lext as we 
saw above looks like the following in HTML: 

<HTML> 

<HEAD> 
<META HTIP·EQUIV",·Content·Type· CONTENT ='tex!Jlltml: charset=windows· 

1252'> 

<META NAME="Generator' CONTENT='Microsoft Word 97'> 

<TITLE>2 First steps with word processing <[TITLE> 

</HEAD> 

<BODY> 

<B><FONT SIZE=2><P>4</P> 

<P>Saving documents in other formats</P> 

<P>&nbsp:</P> 

<P>Objectives</P> 

</B><P>ln this section you will learn how to:</P> 

<Ul> 

<U>Save a document as a simple text file</ll> 

This is the beginning of the file and there is no preamble like that in 
RTF. TIlis is p;u'tly because much of the formatting information is 
stored in the web browser, although you can open HTML dcx:uments 
in Word and save them as Word files. Again , however, you do not ever 
need to see Ihis coding. 

. .. 
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Exercise 4.7a 

To save as HTML. you can either use Save As as before and choose HTML 

document or you can choose Save as HTML directly from the File 

menu. 

When you save as HTML, you will find that the screen layout changes to look 

more like a web browser. This is a version of the Online layout, but with only 

ooe window and this is buill into the template, which changes when you open 

an HTML file. You can switch to other layouts in just the same way as for an 

ordinary Word file. 

Exercise 4.7b 
Open text01.doe and save it as an HTML document See what happens to 

the screen. II you have a web browser available (see Module 7 for rTlO!"e 

information on this topic), you can try opening the hlmlfile, which will now 

have an extensioo .htm, to see what it looks like. Since it has very little 

formatting. it will probably look very uninteresting. 

It Is poasiltltsl to .. t up Word without the t.cll~ to .. ve a. 

HTIIL. SO If you do not ... litis opt ..... ...-k to ,OW 
systems .......... ,OW' ..... or even tIM Microsoft 
Helpline. Altern8ttnIJ. _one with experience m8V be 
..... to help ,ou ......wI Word or Innall the extra mo ..... 

Summary 
In this chaplcr: 

• Wc have looked al saving a document as a text file. 
• We have looked at saving a document for use in other versions of 

Word and other word processors. 
• We have looked at saving :1 document as an RTF file . 
• We have looked at saving a document as a lempbte. 
• We have look(.--d at saving the file as an HTML file for use on the 

Web. 
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Inserting, 
Deleting and 
Editing 

Insert and delete characters, words, sentences, 
paragraphs and special characters, such asfixed 
spaces or mathematical symbols. 

Insel1 a page break. 

Use the undo command. 

. .. 
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5.1. Introduction 

Most of this chapter is about the basics of word processing. gening text 
(characters ;md spaces) onto the page. Of course, if you open a new 
document. all you need to do initially is type, ju.st as you would on a 
typewriter. You will have :llready S<."'Cn that, when you re;lCh the right­
h;md margin that has been set up for you, the next word ;llllomalic:Llly 
appear on the next line and, when you press the Enter key. you 
generate a carriage return that .stans a new line. Similarly, you can 
enter tab charJcters and the cursor will move to a fix(.>d preset position 
in the line, just as it does with a Iypewriter. 

This is fine as long as you only want to type the char.l.CICrS you eln 
scc on the keyboard :lOd if you do not nced to change :1O)11hing. We 
sh:tll S<."'C in later chapters how you C:1n change the appe;mmce and 
formatting of text, but here we consider how to ch;mge the text you 
have already entered and how to enter ch;lrJders that :lre not on Ihe 
keyboard. We will also see how to undo an edit. 

5.2. Editing and Deleting Characters 
In Chapter 6 we shall discuss scleding :tnd deleting more than one 
ch;lrJCler :H a time. However if you want \0 dclete char.lders one by 
one, you simply place your text cursor before the first chamcter you 
want to delete or after the la.st one (sec the Information box for more 
about cursors). "i1len, if you want to delete the character after the 
cursor. you press the Delete key (Del) and, if you want to delete the 
chamcter before the cursor, you press the Backspace key. You do this 
as many times as there :lre charaders you want to delete. You can also 
hold down the Del or Backspace key, but, if you do this, you will n(:cd 
to be careful that you do not delete more char-..tcters th:m you intend to. 

When you .,. working on • document. there .,. eneetlve" 
two cursors on the sc ....... The,. Is the mouse cursor. 
which looks Ilke a capital I (with bars at the top and 

bottom) and this moM. around the sc ........ you move 
y_ -.... TheN I. aiM the text cursor, which I. a 
....... ng vartul line, that shows you ........... the ted you 
.,., In other word ............ ned thing you .... _ at the 
keyboard will take affect. You need to be claar .bout .... 
dlHarence between the two cursors. 
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FOI' most of tIM time tIM rI'tCM.a. cunor does not .tt.ct what 

you .,. cIointI. It Ia one,. wIMn you click with It that H pl8ys 
• PMf,. " you click the '-'l rI'tCM.a. button , .... clllck - 01' just 
click) with tIM mouse .t MY position In the text., you wlU 
mow. tIM ted cw.or to that PHftIon. As we will ... MIow, 
theN .,. other wIlY. that you CM mon tIM ted cw.or, but 

the big .cIvMbtge of the mouu Ia that you c.n mowe 
.,.ywhere In the text, ~ H you also .... the scroll 
bItrs. Once you ...... clllckecl, the ted c ........ stay 
........ you put II, lrNepectIve of ...... you now move the 
mouse c--. to. " you k..., tIM mouu button IMtkI down, 
then other things ........... w. MIdI ... In the ned 

chIIpter. IncIdentaItr, " you click tIM right IftOUM button 
(right click). you bring up • pop-up ....... that dupllcat .. 
...... of tIM ........ at tIM top of tIM Word window. 

There are various other ways in which you can move the text cursor: 

• You can use the arrows on the numeric keypad. TIlere ,Ire always 
four (up, down, lefl and right) and somelimes eighl of these; the 
additional four are diagonal (up left, up right, down left and down 
right). Depressing one of the first four moves your text cursor one 
line up or down or one ch;lracter to the left or right. Depressing one 
of the other characters combines two movements. If you also hold 
down the Ctrl key, then instead of moving by a line or .. chamcter, 
you move by a panlgr.Iph or a line. 

• You can use the Home and End keys. Home takes you to the 
beginning of your current line, End to the end of it. If you hold 
down the Ctrl key this time, Home and End will take you to the 
beginning or end of your document. 

• You ('.In use the Page Up and Page Down keys; these will usually 
take you up or down a screenful mther than a text p:lge. 

To insen a chaf""Jcter or characters in the text. for example if you have 
missed a chaf"".Icter out of a word, just place the text cursor al the 
position where you w:tnt to add the characler(s) and type. Usually 
when you open Word. you will be in Insert mode, which means that 
typing will insen the new charJclers imo the text. However, you may 
have switched 10 Overstrike mode. intentionally or even 
imldvenently, by depressing the [nscn (Ins) key. [f you are in 

• F,CDL ' ... 
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Overstrike mode, you will find that, inSICad of inscrting the new 
char-.leters, each character replaces that 10 the right of the cursor as 
you key it; sometimes, of course, this may be what YOll want. If you 
arc in OverSIrike mode, then the text in the OVR box at the bOllom of 
the window will be dark; see Figure S. L Note that, in Word, the text 
cursor does not change; in some other, particularly older, word 
processors, the cursor changes to a block covering the current letter 
(the leller is then white on black - or its colour C(\uivalent). 

Figure 5.1 The Status box In Overstrike mode. 

5.3. Entering Words, Sentences and 
Paragraphs 

To insert more than one chamcter (in Insert mode), jllst keep on 
typing. If you want to add a new par-.lgraph, just type at the beginning 
or end of an existing pamgr.lph, adding c.lrriage relllrns appropri;lIcly. 

Exercise 5.3 
Open the latest version of your test file . Edit it by adding additional 

paragraphs and words and sentences within paragraphs. Delete some text. 

Press the Insert key and then overtype some text. Remember to press the 

Insert key again to come OUt of Overstrike mode. Save the file as a new 

version (or even save as a new file, say /es/03.doc), so that you have a series 

of versions or files that represent the stages that you have gone through. 

5.4. Inserting Symbols and Special 
Characters 

One of the big advantage of a word processor over an old-fashioned 
typewriter (and there are many) is that you can include in your 
document many more characters than you can type directly on the 
keyboard. Keyboards generally used in the UK and USA are not, for 
example, designed so that you can key accented char-.lcters directly 
(unlike those used. say, in Fr:lflce). However, you can still key such 
char-.!cters, as well as all kinds of symbols. TIlere is also a special way 
to key ch;Ir;lcters that have traditionally been used in printed books 
but not in typed documents. These include curly qu(){e marks (' and ') 
and En and Em rules (- and -), as we shall see. 

., 
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Exercise 5.4a 

There are various ways of inserting symbols and special characters. The 

simplest is to go to the In.ert menu and choose Symbol. A window that 

looks like Figure 5.2 will open (sometimes not very quickly). You can then do 

two things to find the symbol you want: 

.... , 111:1 

- -
Figure 5.2 Symbol wIndow wIth one cMracter enlarged . 

• Scrol l through the fonts (you may also find that you can scroll through 

subsets); the top one is always called (normal text): 

• look at the characters; it may unfortunately take you some time to find the 

character you want if this is the first time you have used it. 

Sometimes the characters appear rather small, but if you click on a character 

and hold the mouse key down, you will see a larger version of the character 

in question (see Figure 5.2). 

To make life easier for you in some cases. you will note that in the Symbols 

window there is a second tab, labelled Special Characters (Figure 53). 

Here you will see listed a number of characters that occur quite frequently in 

well formatted material. Most of them are characters that used to be the 

province of the typesetter in the days when secretarial work was done on 

typewriters. but new they are available to everyone. Because the symbols are 

listed on the left, they should be self-explanatory. A few need some 

explanation: 

.. . 
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Or!.'Nh_ • .-, .-._, .- '" 
Figure 5.3 Special Characters tab in the Symbols window. 

• The Em space and En spaces are fi~ed spaces that are the same Width as 

the Em and En dashes above them. They are called Em and En because 

they are. respectively. the width of a capital M and a capital N 

• The optional hyphen is a hyphen that only appears at the end of lines if you 

allow the te~t to be automatically hyphenated (to keep the inter-word 

spaces within a fi~ed range): see Chapter 8 

• The non-breaking space allows you to keep two words with a space 

between them on the same line. The non-breaking hyphen is similar 

• Your program can be set up to produce opening and clOSing quotes that 

look like' and ' at the appropriate pOSitions, even though you type the 

straight quote · (Format I AutoFormat As You Type I "Straight 

Quotes" with "Smart Quotes"). Sometimes, however, the 

autoformatting gives you the wrong characters. for e~ample when you want 

a single closing quote mark by itself (With a space on either side). so you 

can use this menu to allow you to put in the character you actually want 

You will notice that at the bottom of both the Symbols and Speciaf 

Characters windows, there are two buttons. AutoCorrect and Shortcut 

Key AutoCorrect is outside the ECOL syllabus. but allows you to 

automatically correct common mistakes: we shall see references to It in later 

chapters. If you click on It. you will see the corrections listed 

A Shortcut Key allows you to use a keyboard shortcut instead of the menu. 

This IS quicker once you know the short cuts. but means you have to 

remember them. II. in the Symbols menu. you select a character and a 

shortcut key has already been set up. It Will be displayed at the bottom right 

of the window (see Figure 5.2). This does not happen lor the Special 

Characters window, but you can see (and change) the shortcut key by 

clicking the Shortcut Key button. Be careful. however. about using this 
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because you may overwri te existing standard shortcut keys. Note that all the 

characters in the Special Charact.rs window also occur in the Symbol, 
window. 

Another way of inserting non-keyboard characters is to use the character 

number. keyed on the numeric keypad while holding down the Alt key (you 

must have the Num Lock on). This is quite efficient, but requires you to know 

these numbers and effectively only applies to characters that are in the basic 

Windows character set (known as the ANSt character set after the American 

National Standards Institute), so that, for example, keying AII+0233 gives e. 

For other characters, such as those in the Symbol font. you still need to know 

which is the equivalent character in the ANSI character set. 

Finally, for Greek characters and symbols, you can key in the character in the 

normal font and then change the font, as we shall see in Chapter 8. Thus 

keying 11/ and changing the font to Symbol, as we shal l see in Chapter 8, 

gives p. This also applies to Cyrillic (Russian) characters, but. once you gel 

away from alphabetical characters, remembering the equivalents becomes 

difficult. 

Exercise 5.4b 
Open one of your test liles. Insert some non-alphabetical characters using the 

methods described previously. Add a French quotation for example and 

perhaps an En rule to replace a hyphen (one of the uses of En rules is to 

indicate a relationship, e.g. the parent--child bond). Perhaps you can consider 

a Greek letter to indicate an angle, say 8. See which method you find easiest 

to use. Again save your file Of save it as fesf04.doc, for example. 

5.5. Inserting a Page Break 

.. 

Sometimes you want your tex!!o continue at the lap of a new page. 

Word allows you to insert a page break. 

Exercise 5.5 
Go to the Insert menu and select Break. You will see a window like Figure 

5.4. Page break is selected by default, so all you need to do is click OK. 

Exactly what you wililhen see on the screen depends which layout you are 

using, but, il you go to Page Layout. you will see that the text cursor has 

moved to the top of the next page. In Normal , you see a dotted line across 

the page with Page Break typed in the middle. 

. .. 
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Figure 5.4 The Insert Break window. 

Open your most recent test hIe and insert a page break at a poinl where it 

makes sense. Save the lile again. (We will no longer repeat the alternative of 

saving as a new file, but it will be implied.) 

5.6. Using Undo (and Redo) 
One of the most useful commands is Undo. This i:> ac~ from the 

Edit menu (or you c.m key Cu l+Z or usc the Toolh.ar icon IC"") . What 

this does is reverse the last editing operation you carried out. NO(e th.at 

it does nO( reverse ch.angt's of view. Thus, if you have in:K'rt(.'"(i some 

text and then decide that you did nO( want this, Undo will remove it 

without you having to delete it. 

What is evcn more import:mt is that Word provides multiple Undos. 

Thus, if you k(.>cp selecting Undo, you ~ucces.sivcly undo the 

operations you have coIrried out, in reverse order. TIlb coi n ...ometimes 

be very helpful. 

A related command is R(.'"(io (Ctrl+Y or toolbar icon ("":0 or function 

key F4), which is s trictly oul.side the ECOL syllolhus hut is clO*ly 

linked with Undo. TIlis allows you to repc-oIt the 100:>t opcmtion you 

CoITried out. It can he very uscful if you w:mt to carry out the .'klme 

openltion in sever-oi l places in a document. p:trlicul;lrly if this Involves 

an oper,I1ion that takes sever .II keystrokes o r ;1 cOlllbin;ltion of 

keystrokes. YOli JUSt move the text cursor 10 the new pol>i!ion :.II1d 
activate Redo. 

Exercise 5.6 
Note that if you use either the Edit menu or the keyboard shOrtcut (click the 

down arrow on the TIght 01 the symbol), you are given a clue as to what you 

will be Undoing or Redoing USing the icon is aclualty more explicit (e. g . 

•• 
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.. 

Figure 5.5) and allows you to carry out several actions alone go. II is also 

worth noting thai, if you are undoing or redoing typing, you need to check 

carefully exactly how much lexl has been affected. 

Figure 5.5 

So open your latest test file. Try carrying some edits and undoing and redoing 

them. Look at what the tool bar icon tells you rather than always using Clrl+Z 

or Ctrl+Y (F4). 

Summary 
In this chapter: 

• Wc have looked at inserting, over.vriting and dclcting char.JC1crs. 

• We have lookcd at inserting symbols and special charJc\crs. 
• We have looked at inserting a page break. 
• Wc havc looked at using Undo and Rcdo. 

. .. 
• f.CDI. · .. . 
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Selecting, 
Copying, 
Moving and 
Deleting Data 

Select text. 
Copy and moving text within and between 
dOCl lments. 

Delete text. 
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6.1. Introduction 
One fC'JI ad\~Jnt:I8e of a word processor over" typewriter i~ th"t you 
em use text over and over again by copying it and you C'Jn move it 
:Iround very e:Isily. Here we shall see how you do th:u. :IS well as how 

you c:ln delete it. 

6.2. Selecting text 

6. 

If you want to carry OUI an action 011 a pk-<:c of tex!. which C"JIl be 
anything from a single char-Jeter to the whole text of your document. 
Ihe fir..1 thing you need 10 do b to select it. As for many tasks in Word, 
there is more Ihan one way 10 do this. 

Exercise 6.1 
Open your latest test lile and try the following methods of selecling text: 

• To select the complete lexl, open the Edit menu and choose Select All . 

Even easier IS to use the keyboard shortcut and type Ctrl+A. The text will 

change to reverse Video. i.e. negative white on black (If you are using black 

type on a white background as In Figure 6. t , othelWlse the colours will 

change) 

I 

Flgtre'62 'Uslng-drag-and'drop '(a)1he-te)(t-Is'seJected,'(b) ' 

"-'''I 
Figure 6.1 Selected text in reve,.e video. 

• Place the cursor (the mouse cursor) at the beginning of the text you want [0 

select and, holding down the left button. move the cursor to the end of the 

text you want afld release. 

• Place the cursor (the mouse cursor) at the beginning of the texl you want to 

select, click and hold down the Shift key. Move to the end of Ihe text you 

want to select and click again; you can go up or down the document. If you 

have to scroll , i .e. the beginning and end of the text you want do not 

appear on the screen at the same time, then this is ITIIJch easier than 

holding down the mouse burien while you scroll. You can also use this 

approach to extend a seleclton. but only III the dlf9CtlOll In which the 

setecltOn was Oflglnally made. 

. .. 
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• To select a smgle WOfd. clICk once oolnat word If you double-cliCk, you 

will select the whole paragraph. If you clICk once while holding down the 

Ctrl key. then you will select the sentence. 

• Use the arrow keys and the Home and End keys. You will remember that 

these move you around the document. If you hold down Ihe Shi ll key at the 

same time as you press one of these keys, you will select from Ihe posi tion 

of the text cursor Thus shill plus a single arrow selects a single character 

(left and right arrows) or a single line (up and down arrows), while holding 

down Ctrt as well selects WOfds or paragraphs. Shlft.Home selects from 

the text cursor POSltJ()O to the beginning of the line and Shill. End selects 

from the text cursor position 10 the eod of lhe line (including the carriage 

return II there IS one), Holding down Ctrl as well selects 10 the beginning or 

end of the document (and also takes you to the beginning or end of the 

document). 

• Use the function key F8. Click once on F8 and the (mouse) cursor will now 

select when you click. Click again and you will extend the selection. Click 

within the selectlOll and you wilf shorten the selection. Pressing F8 again 

has a similar eNect. Pressing F8 together with Shill reduces the selection. 

To 'switch off ' F8, press the Escape key (Esc). 

To deselecltext selected by clicking or double clicking, you just click on it 

again. If you have setected text by using a combination of keys (Home, End 

or arrow keys), you can desetect part of the texl. You hold down the shift key 

and click at Ihe point where you want the deselection to end. ThiS works from 

the end of Ihe selection if you selected the eartier point in the document first , 

and from the beginning if you selected the later point in the document first 

You can also use F8, by itself or together with the cursor. 

You will find that you develop your own pl'eferred way of selecllng text 

Once you start using Word In earnest. selecting lext will be somethmg you 

do all the time 

Although at the moment you Will be doing nothing wllh what you select, try to 

familiarise yourself with the various approaches and see which you find 

easiest. For example, some people think that using F8 is a great approach, 

while others find it confusing See what you think 

6.3. Copying and Moving Text 
In principle. the e;J.sic:.t WJY to move text is to usc drag :md drop. TIllt 

is, )'ou sek"Cl some text and then, holding down thc mouse bul1on, 

)'ou drJ.g the text until il is where you want il. when you release the 

•• 
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mou*, hulton (Figur~ 6.2). I-Iow~ver. this b g~ncrJlIy o nly ~asy if the 
amount of text is not too 1;lrgc o r you are dr.lgging within what you 
C',m sec on the M:n:cn. While you C'Jn d mg and drop off the :.creen by 
moving the cursor [0 the (.'(Igc of the scree n, what h ;lppcn~ then is nOl 
always easy to control. 

I ::.::,:v...,....,...-." ••••• '~I'-hr~.,.......... ,I<bo __ 

Figure 6.2 Selecting te .. t fOf dfeg and drop editing. 

If rou ...". • window open on the ...... IIUCI'I .. FInd Of 

Repl8ce I'" ~ 7,. JOII C8IIIIOI ........ ..., tellt. 

Dr::IS and drop ;llIows you [0 move text . However, if you hold down 
the Ctrl key when you drJg and drop, then you will copy the sdected 
texL However, : m ahern;lt ive method is necessary for ('Opying :md 
moving large amounts of text (and can, of course, be usc:..-d for short 
sel~aions as well). l11is uses what is called the Clipbo:lrd and 
techniques C'Jlk-d Copy, Cut and Paste. 

6.4. The Clipboard, Copy, Cut and Paste 

70 

To copy teXI from one place in a document (0 another or indl.>t:cl 
betw(.'"Cn documents, you first select wh:u you W:1I1t to copy : Ind thel1 
choose Copy, either from the Edit menu or from the pop-up menu 
you sec when you right click 011 your selection. What h:lppcns then. 
al though Ihis is l10t obvious from what you sc:..'C on the .scf"(.-cn. is that 
Ihe text you have selected is stored (usually described as plact.-d) on 
the Clipboard. which you can think of as a special al"C"J in the 
computer memory. I1le term Clipboard is used I>CC'Ju.'>C, if you think of 
the physical analogy. rou can take a piece of p:lpcr and add it to a 
clipboord unt il you decide where it should be past(.-d hack in. 

If you decide that, instead of copying some text, you want to move it, 
then instead of choosing Copy from the Edit menu or the pop-up 
menu, you choose Cut . This lime Ihc text will v:mish. Ag;!in it has 
1x.'Cn copk-d to thc Cltpboard. In either C'JSC, you then mo\"e to where 
)'00 \\~Jnt to place the text you have copied or CUI. l11is em either be 
within the sanlC document or wilhin a different document. To mo\'c 
belwccn open documents you go the Window nlCnu and selca the 
document )'OU want (St..'C Chapter 2). You can ewn open a completely 
new document to paste your text into. . . . 

• f".f'DL · .. . 
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To pa~te the text back into the document, you either go to the 
Edit menu or right click ;I ! the position where you want to pa~tc and 
seled Paste. The text will then appear. You may have to adiu~t the 
typeface or typcsize (Chapter 8) to !mllch the new position. You 
~hould also check the inter-word spacing (and possibly the number of 
carrbge returns), before and after the passage you pasted in to make 
sure that you have neither left no space nor left a double space (or 
c.lrriage return). 

Not. ttwIt H .. not juat t.xt you can copw, cut .nd pa .... 

Module 2 ell" ...... IIIOYIntI and copying ...... but you can 
.Iso copy and move IlIustralIona. And you ... not IlmItecll 

to cGpJlng within .... appIIcatton. So 'OU can copy and 
move t ... and .............. from or to. for .x ....... an 
Exc" .... In .. Exc" .... tcatlon window I ... Chapter 17,. 
The .,...., thing to no .... that the Clipboard will .... In .n 
.... t l"le ........... pic .... etc., until .Hher ,au turn 

,OW computer off or you cany out another Cut or Copy 

operation. "...., rou can ...... the content. of the 
CIlpbHnlIn more than one ~. (this c ... 1M very useful 

with ""I. but ....... nb.r that H you do cut or copy 
aomethlng ..... then what w .. pNvtously on the CUpboard 

is lost. Of cour... H you copied. then thl. I. not • pnabl.m. 
How.ver. H you ... cutt ..... then ,OU need to 1M ca .. IuI, 
........... you can .... Undo to .. verse • CUt. which I. 
sometime. verr ........ tf ,ou Cut when you meant to Copyl 

" I. poaaatIe to obtain program. that .llow more than one 
Hem to 1M Ntalnecl on the Clipboard .nd, 6ncIeecII. Window. 
2000 " .... altow •• I.w Item. to be .... Ined. 

The keyboard shortcuts for Cut, Copy and Paste are probably some of 
the most widely used. Onley are (with their icons): 

• Cut : Ctd+X 

• Copy ~: Ctrl+C 

• Paste ft : Ctrl+V 

You will note thai, ;llong with Ctrl+Z (Undo). they are at the 
boI:lOm left of the (U K) keybo;Hd and, even for one-finger typists, 
are easy to access. 
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It is also worth repeating that all the move and copy opcr,l1ions can be 

rever~ed with Undo (Ctrl+Z). 

Exercise 6.4 
Open your latest test file, Select passages by whatever method you found 

easiest in the previous exercise and then see what happens when you Cut 
them or Copy them and then P •• te them elsewhere in your document. You 

can also try dragging and dropping (with and without holding down Ctrl) and 

compare the ease with which this can be done for a word, a sentence and a 

paragraph. 

6.5. Deleting Text 

72 

Deleting files is similar to copying and moving. exccpt [h:11 once you 

have selected the text you want to remove, you either dick the right 

mouse button or you go to the File menu of the window containing 

the file(s) you want to delcte and select Delete. Even simpler is just to 

depress the Del (delete) key on your keyboard. You can, of course, 

also delete by using the Delete and Backspace keys without previously 

selecting any text. 

Exercise 6.5 
Repeat the last exercise, although this time delete some of the text you select 

You can always use Undo to restore it 

This is probably a good point at which to review your test document and 

check that the text makes some sense. All the changes you have made may 

have moved it away from what you originally intended. You can, of course. 

simply revert to an earlier version. Did you save versions of the test 

document? 

Summary 
In this ch;lpter: 

• We have l<XJked at ways of selecting text. 
• We have l<XJked at moving and copying text within a document, 

using either dmg and drop or Cut, Copy and Paste, together with 

the Clipoo.ard. 

• We have 1<XJked at deleting text. 

... 
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7 

and Replacing 

tit 

Search Jor characters or text stn·ngs. 

Replace characters or text stlings with other 
characters. 
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7.1. Introduction 
You will often W:l.nt to find 3 word or phrase in 3 document, either 
when you are writing 3nd you want to see wh3t you h3ve 3Jrcady pUi 
or when you are rC3ding or editing a document. When you are 
writing, or perh;lps editing or revising, a document, you m3Y :l.lso want 
to replace a string of chamcters, for example January by Febru:try. 
Word provides you with very cxtensive facilities for doing this. \'(/e 
sh:tll only describe the simpler aspects here. 

7.2. Finding Characters 

74 

There is:t special Find menu (Figure 7.la), which you C3n open from 
the Edit menu or by keying Ctrl+F. To find a string of chanlcters, you 
simply type them into the box and dick on Find Next (or key Al t+F). 
If the string exists in the document, then the next occurrence will be 
highlighted. If the string does not exist in the document or you have 
found all the occurrences, you will sec a message telling you so . 

• 

Figure 7.1a The Find window - basic. 

In Figure 7.1a you will see a button labelled More. If you dick on this, 
the window expands so that it looks like figure 7.lb. You will S(''C 
various boxes, representing options: 

r __ 
r ____ ~ 
r .. _ 
r _ .. 
r>fhl .. _fortIo 

Figure 7.1b The Find window - expanded. 

. ' . 
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• Search: this Gm S.1Y All, Down or Up, If you sckct Down, you will 

search from the present position of your text CtJrsor W the end of 
[he document. Correspondingly, with Up selected you will search 
h;l(k to the beginning, while with All , as you would expect, the 

search gocs through the whok document. going to the end and 
then starting ;tgain ;tt the beginning until it gets back to the original 
position of the text cursor. If you sclc<:t Up or Down, Word, unlike 
some other programs, tells you that it has reached the beginning or 
end of the document and gives you the option to se:m;h the rest of 

the document. 

• Match case, unles.s this box is sek--cted, a search will find all 
occurrences of a SIring, irrcspC<:tive of whether it contains capital or 
small letters. If you select this box, you will only find occurrences 
corresponding to the case you enter. Thus if this box is selectL-'d and 
you search fo r 'brown' you will not find occurrences of 'Brown'. 

Simi(;tfly. if you search for 'Brown', you will not find 'brown' 

• Find whole words only: if this is selected, searching for 'can', for 
ex;nnple, will not find 'scarl', or 'candidate', 

• Use wildcards: 111is allows you to ~rch for more complex 
strings, for eX3mpie 311 strings beginning in 'is' and continuing with 
a , e or i, so that one can change them to -isa, ise or -is;' depending 
on the style that you are using. However. this is outside the scope of 
ECOL Word has some very powerful Siring searching capabilities, 

which are described in the Help files. but you need to understand 
the principles before you try to use these. 

• Sounds like: this finds words that sound like the search teon th:tt 
you have entered. You h;tve to a llow for US pronunciation when 
you use this option, 

• Find all word forms: if Ihis is selected, when you se;trch for, say, 
'stay', you will also find ·stays', 'staying', 'stayed' etc. 

At the bottom of the screen, you will also SL-'C three bunons, No 
formatting, Format and Special. The first cancels the SL-'Cond, which 
allows you to add all kind.~ of conditions to your search. e.g. the 
characters have to he italic or bo ld o r in a particular typeface. This is 
outside the scope of ECOL. but is well explained in the Help files. 

The Special button is useful a~ it allows you to search for things other 
than ju~t letters; see Figure 7.2, which is self-explanatory. 
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.­-­~ -----~------------
Figure 7.2 Special characters you can specify in Find. 

Exercise 7.2 
Open your latest test file (or perhaps an earlier version that you want 10 clean 

up). Search for words or strings thai you know are there and, just to see what 

happens, wOfds or strings thai you know are nOI there. Try oullhe differenl 

search options 10 see their effect. 

7.3. Replacing Characters 

76 

In Figure 7.1, you will sec that there are two other labs, Replace and 
Go To. You C"J.n access these by clicking once you arc in Find or you 
can get to them di rectly from the Edit menu . Replace, strictly 
speaking Find and Replace. C'J.n abo be accessed from the keyboard 
shortcut Ctrl+H. 

Exercise 7.3a 
The Replace menu looks like Figure 7.38 and, like Find, it can be 

expanded by using the More button (Figure 7.3b). You will see that it is very 

like the FInd menu, except that it has a Replace with box and additional 

buttons. Replace and Replace All . The selectable oplions all work in the 

same way as for Find. although, if you use Special Characters when the 

text cursor is in the Replace box. you wil l see that the list is different and 

shorter (Figure 7.4). Comparison of Figures 7.2 and 7.4 will show you why. It 

does not make sense, for example. to replace with any number, although you 

may well wish to search for any number. 

. .. 
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.. R.eQoce I Ii> To I 
fol_' to" :=I I ..,-

""' 
ItoII«o ..... ' ..... ete>il :=I ..... . -. .... 

Figure 7.3a The Replace window - ba.lc. 

.. RoQIKe I liP Tal 
fol..twt: • :=II ""-

,~, 

~""": ..... etext :=I ...... . _. 
.... " I· ::J 

r __ ... . r __ -.k<rit 
r ... _ 
r ...... r _ .. -.:I foraIs -- I Ie ... -. _ . 

Figure 7.3b The Replace window - expanded. 

earlqactt Mark 
lab Ch!racter 

Coatet Ch!racter 

~dCcntert5 

CoUmBreak 

Em""" E,,,,,,, 
~ III'hat Text 

MaruaI ~ Break 

MaruaI Paoe Breal\ ..... .....,...,., 
Nonbreai<rog sp«:e 

"""""-
Figure 7 .4 Special character. in Re place. 

If you enter text in the Find what and Replace with boxes, say 'cats' in 

Find what and 'dogs' in Replace with, then, If you cliCK the Replace 

button, you will replace the first instance of 'cats' with 'dogs' and highlight the 
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next instance (or Word will tell you that the whole document has been 

searched), Clicking the Replaee button again will repeat the process. If you 

click Replace All. however, every instance of 'cats' in a document will be 

replaced by ·dogs'. 

You neH to be c.,.ful when using RtIpIac., bec8i .... 
... rehlng 'or 'un'. for .~ • .... ....,a.clng It with 
'could' wUI not on.,. change 'can' to ·could'. but .leo 'selin' 
to 'scoulcl', which WOU wi. not w ..... n.., ~ can .Ither 
select the 'Find whole words onlY opUon or .mer the 
string with apac .. , •••• ' c.n', but .... a.tter would .1 .. 
change ·un .... ·. while putt ..... !ipItCe at the end would 
..,.... tIlet ~ would not find ......... of 'c8n' followed 
~ punctual ....... Is ua.. ................. to think IIbouI 
what you a,. cIoIngI 

Exercise 7.3b 
Now replace words, characters and strings with other words, characters and 

strings in your test document. One very useful replacement is to replace ali 

double spaces with single spaces: you can repeat this until you get a zero 

result , when you will no longer have any double spaces in your document. Try 

using the Speeial Charaeters in the Find and Replace boxes. You can 

always use Undo if you wish. Alternatively, when you close the file. you can 

decide not to save the changes. 

Although tF8dlltonaitr. He"""'1 u .... Is to put • double 
space ...... a full stop, ~ wHI find that this ..... not 

normal'" hII ..... In typeset material. You neH to dec" 
which approach ~ ........ to 18k •• 

Remember that when ~ .... find or Replace. the Brow .. 
object , ... Section 2.3 .nell A..- 2.111 will c ....... to 

what you &ast looked for. 

. .. 
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74 Using Go To 
Allhough nOI within [hc ECDL sylbbus, the Go To command ~lppe~lrs 
logclhcr wilh Find and Ikpbcc. II appears as shown in Figufc 75 and 
is ~c1f-expbnalory. It i~ mos\ useful whcn editing :1 document, rJlhcr 
than when you arc writing ,I new one. "!lIC kcyboard shoncut is 
Ctrl+G. 

find ~nd Repl.>ee HE! 

Summary 
In this chaptcr: 

EItoo- + ..-.d - to _ reIatHe to 
&. o.nent Itubon. Eurrdo, ~ 
.. _f..-d""'t.n5. 

Figure 7.5 The Go To window. 

• We ha\'e looked at how to use Find. 
• We have looked at how to use Repbce. 
• We havc looked al how 10 use Go To. 

7. 
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8. 

Text 
Fonnatting 

Format text, including changing the typeface, type 
size, style (italic, bold and underlining), the colour 
and the alignment. 

Format paragraphs, including changing the 
alignment (left, fight centre and justified), using 
hyphenation if appropn'ate, indenting, changing the 
line spacing and other charactel1stics. 

Copy the Jormatting from a selected piece oJ text 10 
anothel: 

.. . 
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8.1. Introduction 
In many W'J.ys whal we shall look at in Ihis ch:lp(cr i.s al Ihe ht.-art of 
word processing, how you al1ually make your document look Ihe way 
you want ilIa. Chapters 9 10 11 cover other aspcCL~, hul here we de-oil 
wilh the basics in terms of gelling the chanlcters and p:lr:lgI""J.phs to 
look the way you w:mt them to. 

8.2. Formatting Fonts 
What is a fom? The term derive.~ from the days when mctal type was 
used and had to be cast. the French word being fonde. In fact, British 
usage was generally ·foum·, rather than font, but US usage has taken 
over with the spread of computers. There has also been some 
disagreement over eX:lctly what a font is. Docs it include the size or 
just the typeface? Are it:llic and bold of the same typeface thc same 
font or not? Howcver, these arguments are all mther sterile, so here we 
shall refer 10 typeface :lI1d type size, with italic, bold etc. referred to as 
font style where we need a generic term. 

The basic choice of typeface and type size is usually controlled from 
the toolOOr. Figure 8. 1 shows the drop-down menu for Iypefaces. 
Those at the lap, above Ihe double line, are the fonts you are currently 
using in your present editing session, while the remainder are listed in 
alphabetic-.Il order. 111e icon on the left of the font name describes 
how the font is encock>d, but for the purposes of F.CDL you do 110t 
need to know about that, except that fonts with the TrueTypc ':t 
icon will always appear o n your printer exactly as shown on the 
screen. The others (here the typefaces are C111ed PostScript, but the 
Icon represents Adol:x! Type Manager - or ATM - which is the 
software used 10 represem them on screen) mayor may nOl apJX>ar as 
shown on the screen, depending wh{.""I:her they are downloaded from 
your system or stored on your printer. Certainly, if the typeface 
apJX>ars in this list, you coin use it in your documenl. To use a typeface 
for a particular piece of text, you select that text and then go to the list 
of faces and dick on the one you want to usc. 
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~B j 
N,w 

t 

Figure 8.1 The typeface drop-down menu. 

Similarly, Figure 8.2 shows the type-si7.e drop-down lis!. Again you 
select the lext you want to change and click on the si7.e you w:m!. if 
the si7.e you want is not shown, simply type it in the box at the lOp 
and type Enter. Type sizes are given in poims, which is a long­
standing typographic uni!. Word allows you to specify type size 10 a 
pr(."'(;ision of half a point, but nO{ more precisely (unlike p:lge make-up 

programs). if you really want to, you can go up to a si7.e of 999 points 
;llld. in practice, 6 or 7 point type is about Ihe sm:lllest that is 
comfortable to read. 

11 
12 
I ' 

I' I' 20 
22 
24 
26 • 

Figure 8.2 The type-size drop-down menu. 

You em also set the font style from the toolbar (italic, bold or 
underline - see Figure 8.3), whilst the corresponding keyboard 
.~hortcuts are Ctrt+l, Ctrt+B and Ctrl+U. These are wh:u is described as 
toggle commands, so Ihal if your original selection is not it:llic, then 
keying Ctrl+l or selecting Ihe :Ippropriate icon wi!! make it italic. 
Simihlfly if your selected lext is already il;dic, keying Ctrl+[ or sek."Cling 
Ihe appropriale icon will remove the italic style. Note Ihal, if you select .' . 

• 1':('01. ' .. . 
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a sentence that begins in italic, but is not fully i tal ic throughout, thcn 

clicking the italic icon or keying Ctrl+ J will rcmove all the italics. In 

con t rJ~t, if the sentencc h:ld begun not in italic. hut included some 

it:l lics. then clicking the italic icon or keying Ctr1+1 will make the 

w hole sentence it:llic. The bold a nd underline comm:l!lds work in the 

samc way. :Ilthough all three arc independent and can be combined. 

B I II 

Figure 8.3 Font style icons on the toolbar. 

Exercise 8.2 
More detailed font forma\t ing is controlled by the Font Formal menu. Go to the 

Format menu and select Font. You will see a window tha\looks like Figure 

8.4. First. you can see that it is possible to set the typeface, type·size and font 

style. You can also set the colour from the Color drop-down menu and a 

variety o f whal Word calls Effects, which are fairly self-explanatory. You will 

also see a sample of the font and a brief explanation of the Iype of font (which 

corresponds 10 the icon in the font Iisling). Once you have made your choice. 

you click OK in the usual way. 

is' 
"" 

ii-
"" -r _ r _ 

r _ _ 
r __ 

r.- r o_ 
r _ r_ r_ 
r _ r~_ 

Figure 8.4 The Font Format window. 

You will see that the Font Format window has two other tabs, Animation, 

which you can ignore for the purposes of ECDL. particularly if you are solely 

involved in prodUCing printed documents. Character spacing is more 

important. The window (Figure 8 .5) contains four lines: 
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~ 0...:--... 1_1 

..... r---::J - 1,- :;] .,.,~ - 1,_ .. :;] tK;~ 
r_",,_ 

-
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Figure 8.5 Character spacing tab in the Font Format window. 

• Scale allows you to change the typesize within a line without changing the 

inter-line spacing (which is related to the main font size, but can be 

changed in the paragraph format window, as discussed below). 

• Spacing allows you to contract or expand the spacing between 

characters. It can be useful for fining text into a limited space for example. 

• Position allows you to move characters up and down relative to the 

base line (the line that is formed by the bases of the letters without 

descenders. Le. not letters such as p, q, y and g). Note that for subscripts 

and superscripts it often looks better if you use the subscript and 

superscript options (Effects) in the main font window because these also 

reduce the character size, rather than just moving the characters relative to 

the base tine. 

• K erning is changing the inter-character spacing between certain 

characters for aesthetic reasons. A good example is the space between A 

and W (AW), which if not kerned looks disproportionately large. You do not 

usually need to make any adjustments here as it happens automatically. 

Now open the latest version of your test file. You can start to make it look 

better. Try changing the typeface and the type size until you find a 

combination that you like. You may notice that some faces took targer, even 

though they are nominally the same size as others. You may also want to add 

botd or itatics (adding underlines is not generally regarded as good styte. but 

add them if you wiSh). Save the fite when you like what you have 

... 
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Typeface. come In two .... In types. cala.ci IMrif and 
........., Cor sometknes ........,.". In French una mMns 
'without', so "'" .ac ..... ., ........ and ........ tac .. do 
noL ........... the ..... 11 'hooks' .t the end of the strok •• 
that .... k •• lett ..... Thus, nm.. Is • ..,., 'ace, whereas 
Helvetica (UHd ..... for Exercl ... ) I. not. Can you ... 
tM dItfeNnc.? 

8.3 . Formatting Paragraphs 
Again, you can set some parJgrJph formalling from Ihe loolb;lT. For 
example, Figure 86 shows the icons you can lise to adjust the texi 

alignment: 

Figure 8.6 Par.graph alignment Icons on the toolbar. 

This parJgnLph has been left aligned. You wi!! notice that the right­
hand side is 'ragged', i.e, not justified, and the text is not hyphenated, 
so that if a word will not fil. it is taken over to the next line. This 

means that the intelWord spacing is always the same. 

This text has been right aligned. You will notice lh;u [he lefl-hand side 
is now ·raggt."d', i.e. not justified, and the text is not hyphen:l1ed, so 

that if a word will not fil, il is taken over to the next line. This means 
thai the interword spacing is still always [he same. 

This text has been centred. You will notice that the both sides arc now 
'rJgged', i.e. not justified. and [he lexl is not hyphenated. so that if a 

word will not fit, it is taken over to Ihe next line. l1lis means that the 
interword spacing is always the s'lme. 

nlis text has been justified. and indented on both sides, 
p;mly to distinguish il from the main [ex\. YOlL will notice 
th:u bOlh sides are now justified. but not hyphenated, so 
thaI if a word will not fit, it is taken over 10 the next line. 
nlis means Ihat the inlerword spacing va ries. However, if 
there are long words. such as 
antidisesTablishmentarianism, intergovernmental or 
pseudointellcctual. and/or if the line length is shan. some 
of the interword spaces ('J.n be quile large. 
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From the toolbar. YOLI ca n al.-.o adjll.~t the indent (sec Figure R7). 

Figure 8.7 'ndentation icons on the toolbar. 

We .~hal1 now sec how to deal with these I:l rge I>p:\Ces by .-,eiccting 

hyphenation in the p:lr:lgr.lph format menu. 

Exercise 8.3a 
Open the paragraph format wmdow by going to the Format menu and 

selecllng Paragraph. The Indents and Spacings tab (Figure 8.8) allows 

you to adjust the alignment and Indents as in the justified example above and 

also the general paragraph layout: 

tdort>.-d-.. I ..... ..-d~a-... I 
...--.' .iiiiiiii::J ~- 1-,,·,. ::1 -'" ~ -, '" ""', ~ 1( ...... ) ~ r--:lI 
-. 

(!IiI<v.' ~ ... - .' """, ~ 1, 50-.,. ~ r--:lI 

IP.·. 

Figure 8.8 Paragraph format window: Indents and Spacing tab. 

• Alignment allows the same options as the tool bar (Figure 8-6) 

• The Outline level relates to what you see in the Outline view of the 

document. but is not covered in the ECOL syllabus. 

• Left and right indentation are self·explanatory: note that you can only 

generally set left indents from the toolbar. 

• Special indentation has two options. Hanging Indents all lines except 

the first by the amount specified. while First line mdents only the first line 

by the amount specified. 

• r.(,0I . • 
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• Spacing before and after specifies the amount of spacing before and 

after the paragraph . 

• Line spacing allows you various options (see Figure 8.9). The At: box 

only comes Into effect if you choose Exactly. At least or Multiple. 

Figure 8.9 Line spacing options. 

Again you can see a preview and can click OK if you are happy. Note that 

making these changes only affects the current paragraph. You only have to 

have the te~t cursor placed somewhere within the paragraph for the changes 

to apply; you do not have to select the whole paragraph. Alternatively. you 

can select a number of paragraphs 10 which the changes are to apply. 

The other tab in this window is Line and Page Breaks (Figure 8.10). The 

Page break options are: 

-
lobi ... 

Figure 8.10 Line and Page Breaks tab. 
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• Widow and Orphan control. If selected, this stops odd lines being left 

at the top and bottom of pages. In Word you cannot control the minimum 

number of lines, as you can in some programs. 

• Keep with next. If selected, the paragraph will always be on the same 

page as the one following. Note that it only makes sense to use this 

occasionally, for example with headings, as otherwise you can have some 

very short pages or not even be able to paginate at all. 

• Keep lines together. If selected, all the paragraph will be included on 

one page. 

• Page break before. This is self-explanatory. 

The other two options in this window are: 

• Suppress line numbers. For this to have any effect, you have to 

indicate that you want line numbering as default. You do this in the File 

menu and choose Page Setup and then the Layout tab (Section 13.3). 

• Don't Hyphenate. Again, for this to have any effect, you have to have 

hyphenation set for the whole document. You do this in the Tools menu, 

selecting Languages and Hyphenation, where you can also set the 

parameters that control when hyphenation takes place. 

If you have hyphenation set, the paragraph given above (with the text 

changed appropriately) now looks like: 

This text has been justified, and indented on both sides, partly to dis­

tinguish it from the main text. You will notice that the both sides are now 

justified and now hyphenated, so that if a word will not fit, it is hyphen­

ated, rather than taken to the next line. This means that the interword 

spacing varies. However, if there are long words, such as antidisestab­

lishmentarianism, intergovernmental or pseudointellectual, and/or if the 

line length is short, some of the interword spaces are now not so large. 

If you do not like the hyphenation breaks, you can add optional 

hyphens (see Chapter 5). 

Exercise 8.3b 
Now continue the operation with your test file and add some formatting to your 

paragraphs. As your test file is a letter, the address and the date should 

probably be aligned right. You may also want to change the interline spacing in 

the paragraphs and perhaps the spacing before and after the paragraphs. Do 

you need spacing before and after? You may also want to add some indents . 
.. * .. 
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8.4. Copying Formats 
TIlere may be times w hen you want to copy the ehaF.lcter or 

paF.lgmph format of one piece of lex[ [0 an(){hcr piece. To do this you 

use the Format Painter icon on the toolbar. ·111is is o ne o f the few 

commands Ihat docs not exist in Ihe menus: 

Exercise 8.4 

1. You select the lext from which yoo want to copy the format. 

2. Yoo click the Format P ainter . Double click il you wanl to copy lhe 

formaltJng to more than one IocatlOfl. The cursor WIll change shape. 

3. Select the (lirst) text 10 wtllch yoo wan! to copy the formal. If you only clicked 

(rather than double clicked) on Format Painter, the reformatting will take 

place and Ihe cursor will change back to normal. 

4. If you double clicked on Format Painter, click on the next section that you 

want reformaUed. Do Ihls as many limes as is necessary 

5. Click on Format P ainter to cancel when you have finls/"le(t 

6. eoolinue the operatlOfl WIth the test file and copy the style from one 

paragraph to another. Save when you are happy. 

Summary 
[n [his chapter: 

• We have looked :11 how to format chaF.lClcTS. 

• We have looked at how 10 format paF.lgrJphs. 
• We have lookt.'<l :11 how 10 copy fomlalling u~ing the Format Painter 
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9.1. Introduction 
Some inform:nion is much more underst:mdable if it is laid OUI as :l 
\:Ible or list. Here we shall look al using tab markers and list 
cornrn:mds to align tex!. Fully formatted tables will be covered in 

Chapter IS. Adding a border or box to all or some of the information 
Gill also make it clearer. We shall coveT Ihat here too. 

9.2. Using and Setting Tab Markers 
"Illere are four different tab markers you can set so that the text aligns 
to the left, to the centre, to the right :lnd to :I decimal point. You c:ln 
usc these to sct simple tables, although more complex t:lllies :Ire better 
handled with table formatting (Chapter 15). Aligning to a tab marker is 
very similar to aligning the par-Jgr-Jph text as we S:lW in Chapler 8, 
except that you can define :llignment points (tab markers) at :lny point 
in a par-Jgr:lph. Figure 9.1 illus[r;lIes the four different tab settings . 

r " i , , . . . f . • ,. c_ - _'w '. c_ - -, .... - - - --- -- -- -~ 
••• 

~" .... _. 
-~ -... --'-~ 

Figure 9.' Tab settings. 

It is important to understand th:lt t:lbs :lpply line by line. The text :It the 
top of Figure 9.1 is keyed in the following order: <t:.tb>Left <tab>CclZtrc 
<tab>Rig})t <tab>/Jeocill/aI5.66 <CI><tab>left <tab>Celllre etc. «t:lh> 

means a tab charader produced by striking the Tab key and <cr> 
means a C'Jrriage return produced by striking Enter.) The text in the 
lower part of figure is typed in the order: <tab>71}iS [ext <tab>'I1Jis le>:1 
<tab> 'INs le:\1 <tab>This lexl <cr><tab>is set /0 <tah>is sella <tab>is sel 

10 <t:lb>is sella <cr><tab>lIlig" left. <tab>al(gll wllimlly. <tab>aligll 
right. <tab>alig1/ 10 a decimal poilll: <cr><tab> <tab> <tab> <tab> 7.88 
<cr><t:tb> <t<ll» <tab> <t:lb> 788. Note that with <I decimal t:lb :my line 
that does nO( include a decimal point or full stop will al ign :IS Ihough 
the d(.'Cimal point is at the end (just :IS though it were a number). 

This may look a little confusing, but it is important to understand thaI 
while lab Ch:lr-Jders are ideal for aligning short pieces of text or 
numbers, they are not a good way to <llign parJgnlphs that spread over 

91 



Module 3: Word Proce •• ing 

j) ...... 

• 2 

more than one line. ,11i:. is beGtusc you have to key the text line by 

line and if, for example, rou decide 10 change the typesize of your 

document (or even the typeface), you may find that your text no 

longer fits and has to be rckeyed, which is somcthing beSt avoided. 

Although we ... .....m. ....... to .... dec ...... point e •• 
fulllIIOp, .... ohItnIct., to be UHd ... dec ...... point 

, ..... with ......... NIIItecI Mttinpl can be ... dIfteI..,tty 
In .... c-troI ..... I .................. , ... -.ctIon 2,. 
11M F ....... for .............. ....,. ....... 0 __ " • ........ -

If you look :11 Figure 9, I , on the ruler above e~l ch alignment point you 

CJ.n see where the tab stop (or tab marker) has been scI. with the 

shape tell ing you what kind of tab stop it is. ( It is known as a t:lb stop 

~J.usc in thc d:lYs of the typewritcr this w as physicJ.lly a swp thai 

prevented Ihe c.uriage moving further. though there were only left tab 
stops in those cbys.) 'llIe L shape is a left stop, the inverted T:I centre 

stop, the revCfS(."CI L a right stop and the invened T followed by a 

decimal point a decimalta!>. 

Exercise 9.2 
You set these points (tab stops) in stages (note that seUing tabs Involves 

two types of operation, setting the position and insert ing the tab character 

in the text): 

1. Type a line (or lines) 01 text and insert tabs belore the texl you want 10 align. 

At this slage the lexl Will probably align to a series 01 default POSltlOTlS (which 

do not appear as tabs on the ruler) - see the telC! at the end oIlhis exercise. 

2. Click on the box 10 the left of lhe ruler until II shows lhe type of lab stop you 

want to sel. The sellings indicator rolates as you dick (Lett, Centre, Right, 

Decimal, elc.). 

3. Make sure that the text cursor is in the paragraph in which you want to set a 

tab. This may sound obVIOUS. but is very easy to overlook. You can, of course, 

select a number 01 paragraphs and Ihe settings Will apply to all of them. 

4. Click on the menu bar at the POSll lon(S) where you want the tab stop(s). If you 

need more than one type of tab stop, then you will have to repeal stage 1 

between each click. However. you can sel all the left labs first and lhen 

.. . 
• ECD!. · 
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all the decimal tabs. for example. You do not have to work from right to left. 

You will find that the tab stop may not go exactly to the position you want. 

locking on to an invisible grid. To place the stop exactly. you can hold down 

the Alt key as you adjust the position. As you set each tab stop. you will see 

the text align. If you are unhappy with any of the tab stops. you can either 

drag and drop them along the bar (holding down the Alt key if necessary) or 

drag and drop them off the bar altogether to remove them. Note that. if the 

text goes past a tab stop. then that tab stop will be ignored. 

If you are keying in a paragraph with the tab stops set and you key a carriage 

return, then the sett ings will also apply to the new paragraph you have created. 

As we have seen in Step 1. if you have no tab stops set. you will find that 

keying tabs still aligns the text to a series of default positions_ The spacing of 

these can be set, as discussed in the next sectiOll. 

You can c ........ ttt. units of ........ ment you .... using by 

going to the Tool ......... and .. tectlng Optktn •• nd theft 
0.-.1. A.t the bottom. wou will .... window ....... you 
ct.nve IMttween Inches, centl..-t .... pic ••• nd point • . 

9.3. Formatting Tabs 
Instead of using your mouse and sel1ing tabs by eye. you can go [0 
the Format menu and select Tabs . A window like that shown in 

Figure 9.2 will open. 

~~~ =tlbRaf><: k17<m ~ 
; r Loft r Q.ecma! 

(.'~ rlW 
c ... 
~~,,~""~c',".~~,- I 

!J rz... ('1_ 

TlbRaf><ttJbe~: 

<»: I (antlII 
• 

Figure 9 .2 The Tab Format window. 
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Perh:lp.~ the first IXlx to note is at the lOp right, De'.utt t.b .top • . 
Here you can adjust sp:lcing of the default tab stop positions, rcpc:lled 
across the page at the interval shown in the IXlx; these can be useful if 
you W:lnt the S:lnle a lignment throughout your document. You ca n 

adjust the spacing value by keying in a new figure or clicking on the 
\IP or down arrow at the side of the box. However, as soon :J!> you 5('[ 

jU1>t o ne t:lb SlOp in :J pamgl""Jph. the def:lult pOSitions no longer :Jpply. 

Ne:J r the bottom of the window you will .see three buttons, Set. Cle.r 
and Cle. r All. If there aTe no \:Ib SlOpS shown in the box on the left , 
then you Iype the position where you w:Jnt to set the tab into the IXlx 
:11 the top left. You C'Jn overwrite what is alre:ldy there, !Jeousc it is 

just a copy of wh:lt is in the I:Jrger box below. Select the type of t:Jb 
stop you wan! and click on Set. You can do this as many time as you 
wan!. When you have fin ished, click OK. If you just set one SlOp, you 
can skip clicking on Set :md just click OK . However, if you set more 
th:m one stop, you must click Set after keying each position except 
the I:Jst. NOIe that you can also select the alignment of e:lch stop. JUl>t 
as with selling SlOpS o n the ruler, the new tab positions will apply to 
Ihe current paragr.tph or all the paragraphs sek'CIed. 

You will notice that there is an additional type of alignment called b.r. 

If you sct this, you will find that you get a veniC'JI bar, the height of 
the p:lrJgmph, at Ihe tab stop position. However. thi.s is not a real tab 
SlOp 1X!C".tuse the lab key does nOl r(.'COgnise the position (even though 
a venic ... J bar also :1PPC:ITS on the ruler which makes the bar easy to 
move or remove). So if you W:lnt text aligning to the left of a bar, you 

need to sel the bar and a right t:lb stop JUSt before it. 

Before you dick SCt , you CJn also set a Le. d. r charJcter. This me:ms 
that. instead of space betwl..'Cn the text a ligned :11 the different tab 
SlOpS, you gel whatever leader character roo SIX:cify. Figure 9.3 
repeats Figure 9.1 with l.caders :Jnd bar SlOps included. 
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To remove stops, you open the Tab format w indow :md sele<:t the tab 

you want to remove by clicking on the setting in the large box. 111e 

setting will then be copied to the smaller box above. Click Clear and 

th:1\ tab stop will no longer apply to Ihe current pamgr.Iph (or :Iny 

paragr.lphs selected). If you W:lnt \0 get rid of :,11 the stOps. just click 

on Clear AU. 

Although you can mov. t.b .. ops on tIM ruI .... you cannot 

edit t.b atop pull .... In tIM Tab ......... window. You have 
to cle.r • stop ..... ent .... new .top In • new poeltlon. 

Exercise 9.3a 
In thiS exercise. you will repeat what you did in Exercise 9.2. but thiS time use 

the tab formalttng box. 

1. Type a line (or lines) of text (or take some text you have already keyed) and 

insert tabs before the text you want to align. At this stage, as before. the text 

will probably align to a series of default positions or to any tab positions you 

have previously set. 

2. Make sure that the text cursor is in the paragraph in which you want to set a 

tab. You can again, of course. select a number of pargraphs and the sewngs 

will apply to all 01 them. 

3. Go to Format I Tabs. If any tab positions are showing, then click on Clear 

All to get rid of them. 

4. By reference to the ruler at the top of the text area. decide the positions of the 

tab stops you want to add. 

5. Add tab stops (and their alignments) as described above. clicking Set 

between each one and OK when you have finished. You will then see that the 

tab stops have appeared on the ruler at the top of the type area. 

Exercise 9.3b 
Open the fatest version of your test document and add some informat ion With 

tab stops tncluded. Perhaps you could add information about when you 

started each ECDL module or how long each chapter took you (include a 

decimal tab). Try adding leaders and bar stops. Once you have set up the 

tabs. try adjusting them (with and without the Alt key held down), Save the 

version you are happy with. 
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A different way of ;Iligning text is to use a Ibt. figure 9.4 shows a 
huJleted list and a numbered li~t. 

The simplest w"y to create these is, again, to ensure th;lt the text 
cursor is in the correct P"r:lgf'Jph (or you have selected" number of 
par:lgraphs) and just dick on the appropriate toolbar icon (Figure 9.5). 

These are again toggles, so that if you have selected a bullet list and 
you dick on the bullet list icon again, you will remove the formatting 

However, if you have a bulleted list and you dick on the numbered 
list icon, you will convert the list to a number(.>(\ list (and vice versa). 
TIlen. if you dick on the numbered list icon again, you will remove 
the list formaui ng all together. Note that you do not have [0 increment 
the numbers in a numbered list (or, indeed, even type them); this is 
done for you. 

• ... This·is·a-buUd cd·list1l 

• ... This· is·a-buUetcd·list1l 

• ... This·is·a-buUctcd·list1l 

• ... This· is· a-buUcted·list1l 

i 
I .... This·is· a-nUlooercd-list1l 

2 ... This· is·a-nUlwcrcd- list1l 

3 .... This· is· a-nunilcrcH st1l 

4 .... This·is·a-nunilcn:d- list1l 

Figure 9.4 A bullated liat and a numbered liat. 

11- :-- .-
Figure 9.5 The tool bar lia' Icona. 

You can also do all sons of other things with list formats, for example 
changing the bullet char:lcter and the indent, by going to the Format 

menu and selecting Bullets and Numbering. Howcvcr, this b outside 
the scope of the ECDl syllabus. 

. .. 
• ,.cD!. ' .. . 
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Exercise 9.4 

Open the latest version of your test document and add a numbered and a 

bulleted list. It is a good idea only to use numbers when they actually mean 

something, e.g. a series of steps. Otherwise, it is simpler to use bullets. 

However, add an extra paragraph in the middle of your numbered list and see 

what happens to the numbers of the following paragraphs. Save the version 

you are happy with. 

9.5. Borders 
You can apply oorders to almos! anything within your document. The 
~jrnp[e~! is to apply a border (or oox) to ;1 p:lr.lgraph. You simply 
select the p:lmgraph (or paragrJph.s) you want included, go to the 
Outside border icon (sec top [eft of Figurc 9.6) on the toolb;lr and 
click. You can change the border you will select (and what is shown 
initially on the icon) by clicking the arrow to the right to opcn the oox 
a~ ~h(lwn (S(.'C Figure 9.6). If you click on a p:tnicu[ar .style, you will 

not only apply that style to the current pOlmgrJph or to a group of 
pamgr.lphs selected, hut :11$0 ch:mge the rule on the main icon. Note 

th:n if you select a bottom rule, for example, and you have a number 
of parJgraphs selected, the rule will only appear below the last 
paragr.lph. If you want a rule after each par.lgraph, you will have to 
treat each one separJlcly. 

Figure 9.6 Adding a border or box. 

Note that if you click :l rule style a second time, you will rever~e the 
style dl:lnge, but if you click another rule ~tyle, th:n will be added or 

removed, depending on what is currently shown. Thus. if YOli dick a 
box rule and then dick the left·hand ~ide rule, you wi!! end up with a 
box rule without its left-hand side. Note that you can remove all the 
rules by clicking the l:L!>t style .~hown (all broken line.;;), which doe.~ 

not toggle. You can vary the style of border :md :\dd borders more 
sek"'t:tiveJy by using the Borders ;md Sh:lciing format window. Go 10 
the Format mcnu and selcct Borders and Shading. 111e window 
(Figure 9.7) will appear. On the left , you will see that you can change 
the style of the oordcr, ilS width and the colour. Note that this can also 
Ix: done from the Tables and Borders toolhar (Figure 9.8). We Sh:l11 
comc b;lCk to Tables in Chapter 15. 
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Figure 9.7 The Borders and Shading window. 

Figure 9.8 The Tables and Borders toolbar. 

If be fore you open [he window. you scleo some [ext, then the drop 
down menu at [he IXlUO[l1 right allows you to apply [he border [0 
either the whole par:tgraph or to the seleocd text. [n this way, you eln 
;lpp[y underlines, overlines and boxes 10 individual words or phrases. 

Selecting the page IXlrder tab brings up a window like Figure 9.9. Here 
you C;lIl opt for a ]><Lge border similar to those abo ve. as well as 

determining ils position . 

....... ..... '......., gEl 

- - -
0 

~ 
O<l"' ..... _ .. _ -
_to __ 

lIT b ~ ............. 

ro- . -.-.-----.-- ~ 

.d ~. , 
/D ~ -- ., 

LJ --11 -fO- I"" J 
_. 

~, 1-- ., 
I ..... ) ::I - .. I 
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Figure 9.9 Page Border tab in the Border and Shading window . . ' . 
• .. rot. · .. . 
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Mo.t deaktop .... r print .... do not print to tM edge of the 
pa ...... 1'IMtt9 I •• IUIrrGW strip .round tM edge of tM print 
.,.. on which .. I. ImpoHlble to print .nythlng. Thu., H 
you want to Inc ...... page borden In your document., you 
need to .xperiment with your print ... to He .... t It will 
print and what It will not. 

The final wb in the Borders and Shading formal window is. of course, 
Shading, which allows you 10 add backgrounds. "I1tis is outside the 
ECDL ~ylbbus. 

F.cllltl •• such •• bordera .hould be uaed with ,..t,.lnt. 
Hav. a look .t __ printed book. to glv. you ...... bout 

when such .............. nc. the t.xt .nd when they.,. 
unnec .... ry. 

Exercise 9.5 
Open the latest version of your test document. Add a border to a paragraph 

by usmg the toolbar. Remove part of it (you can always use Undo), Select a 

word or a few words in the text and then go to the Borde,. and Shading 
menu and add a border to the selectiOfl. For example, you could enter a 

telephone number below your address; then select this and add a border to 

it. You can also add a border to the page and experiment with varying the 

thickness and type of the rule being used as a border. (Remember to change 

it back. however. unless you want to keep the new settings.) 

Summary 
In this chapteT' 

• We have looked at the use of tab~ and tab stops. 
• We have looked at using numbered :md blilieled lists. 
• \'(/e have seen how to add borders to parJgraphs, selected text and 

p<lges. 
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Styles 
and Templates 

t I I 

Use styles. 

Use templates. 

tOO 
. . . . . 
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Style. and Template • ......... ~ ....... . 
10.1. Introduction 

In the last few chapters, we have been talking about applying formats 
10 paragraphs :tnd explaining that the slyles applied , the alignment and 
tab SCllings used etc., only apply to the current paragraph or any 
scle<:tcd paragraphs. It is prob;tbly obvious that <l pplying these formalS 
over and over again to different paragraphs would nOI only take a 
great deal of time, but would also nO! ta ke advant<lge of the storJge 
and processing capabilities of the compUier. Thus, just as we ca n SfOre 
documents, we can also Slore and usc combinations of form3lting. 
which are called parJgr.lph styles (or usually just styles) and 
combinations of these slyles and other aspects of a document such a~ 
the page size etc. (which we will cover in Chapter 13). TIlesc 
combinations are Called documenl templates (or JUSt temrlate~) and we 
encountered them briefly in Chapler 4. 

The ECDl syllabu~ does not cover the questions of SCtting up and 
changing styles and templates, simply choosing and using them. In 
Chapler 4, we have already memion(.-'(/ saving documents as templates. 

10.2. Using Templates 
We shall consider templates first because we can then look at ~tyles 
within the context of a particular template. 

There are twO ways you can use a particular temphue for a document. 
One is when you create a new document (as we shall see below). 
while in the OI:her case you may not realise that thb is actually what 
you are doing. This is when you save a document under a new name 
and delete or change pans of iI, so as to use the styles and formats in 
that document. The document you have us(-'(/ as a pal1ern may well 
have a specific template associated with it. This will include a list of 
styles, as we shall see below, and will also determine the page size, 
margins etc. 

In hct, every document has a template associated with it. In Chapter 2 
when we creat.xi a new document, we said lhat you should sele<:1 a 
template. which in that casc was the blank page. This associates the 
default template, called norm;ILdot. with the document; alltcmplalcs 
have an extension .dot, as we saw in Chapter 4. In that chapter we 
also nOled thaI when we saved a file for usc on the Web, the page 
byout changed. This was because a new template, more ;Ippropriate 
for the Web, was then associated with the document. 
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Exercise 10.2a 

Let us go back to creating a new document. Go to the File menu and select 

New. In Figure 10. t you will see that there are a number of tabs along the 

top of the Window and we have selected Memo. We select Professional 

Memo.dot and open a new document that looks like Figure 10.2. We have 

chosen Memo because it is relatively simple and the professional one 

because It is important to be professional! 

-~I_ ... - -100,._1 __ 1"",,"_,_1 
.,~ -

-­r._r_ 
Figure 10. 1 Selecting a template for a new document. 

Mem~'U 
' .. ~ ~ .. ---.­
.-~~ .. ---­
.-~ ~ .. -........... 

_ ... __ ... _ ..... __ .... __ .. _" .. -, ...... _,_ ... ,--,.-_ ... _ ...... ... __ .. _ .. ' .. _" .. _ .. _-_ ...... , .... --,..--.--_ ..... _ .. __ .. -........ 
Figure 10.2 Basic document produced when the 

Professional Memo template is selected. 

You will notice that Microsoft has included some text for you to overwrite. This 

not only te lls you what goes where and what to do. but also gives you an Idea 

what the final document will look like. It is not necessary for a template to 

include text (and, of course. the blank page by definit ion does not), but it can 

be helpful. If we had choser. a different template. then the page WOUld, of 

course. have looked quite d ifferent, but we might not have found that out until 

we started applying the stytes. Indeed. even here, although the text refers to 

the heading styles. you cannot immediately see from the document what 

those styles will look like. We shall carry on with this in the next section . . . . 
• FoC'DJ. · .. . 
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We have already mentioned (in Chapter 4) saving documents as templates. 

Any document can be saved as a template (with or without text), but it is a 

good idea only to save as templates those files that are indeed different from 

existing templates or those that have a specific purpose. 

Exercise 10.2b 
So let's create a new document and choose a template. Since your previous 

test document was a letter, we suggest that you choose a letter template. You 

can either follow the instructions in the template or you can try opening the 

latest version of your test document and cutting and pasting paragraphs from 

that letter into your new letter (use the Window menu to switch between the 

two documents). You could select the whole of your test document (use 

Ctrl+A) and the copy and paste it at the end of the new document. You wi ll 

then need to move parts to the right place (with Cut and Paste). Whichever 

approach you use, you may find that the style does rIOt change to the new 

style (in fact it probably will not. because copying and pasting rIOrmally 

carries the style with it ~ the instances of when it does and when it does not 

are rather too complicated to detail here). Do not worry, because we shall sort 

that out in the next exercise. 

10.3. Using Styles 
It should by now be clear that styles are combinations of formatting 
instructions (we shall S('"'e exactly what very soon) th,lt can be applied 
to a paragl"Jph. So how can you see and apply these styles? If you go 

to the Format menu and select Style, you will open a window that 
looks like Figure 10.3. We are not going to do anything in this 
window, but you will see a list of styles on the left, together on the 
right with previews of the layout and the text style, as well as a 
descriplion of the style settings of the style seleded. The latter may 
star1 with Normal+ or something similar. This means that the style is 
based on the Normal style, except for the listed ch:lnges. Here we are 
still looking at the PJ'Ofe •• ional Memo. 

Figure 10.3 The Style Format window. 
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We said that we were not going to do anything in this window, but, 
clicking on a different style in the list will show the details for that 
sryle instead. The other buttons allow you to change the style and, in 

many cases, duplicate the operJtions that we have discuSS<.-d in 
previous chapters, but applying them to the sryle, rJther than to a 
specific paragraph. 

We have already looked at the boxes on the toolbar where you can SCt 
the typeface and Iypesize. To the left of these is anOlher box, in which 
the style name of the current paragraph is shown. It may. for example, 
say ·Normal' or 'Heading I '. If you click on the down alTOw on the 
right of the box, you will be able to see (or scroll down) the available 

styles, as shown in Figure 10.4. TIlis duplicates the list in Figure 10.3, 
but in the correct typeface, at the correct type size and with the size 
and the text a lignment indicated. 

J A'4'i#bJArieI ~ 
Heading 1 

Normat 

Company Name 

IDocument Label 

Enclosure 

Header Base 

He .. ding .iU. 

Message Header FIr$t 

Figure 10.4 The Style drolMlown box. 

To apply a s tyle to a paragrJph, you simply click in the drop-down list 
and you will see your current p:lragrJph, or any sekcled paragrJph, 
change to the new style. You can, of course, make direct changes to 
the formatting of individual paragraphs, but applying the style ... 

• ECDL ' .. . 
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elsewhere will not t:lke those cJl:lnges into ;Iccount. If you want to 

make over;11l changes 10 a style, you need either to le:lrn how to edit :I 

style or get someone who docs understand to provide you with :I new 

template. These :Ire outside the ECDL syllabus. 

On the Format menu, theN .. also an option labelled Style 
Gal....,.. Th .. allow. you to review the t ......... and atyJes 
on YOW' .ptem ..... also, to a c ......... dent, ... how your 
current document would look In • different tempi ... . 

Another option 01'1 the Format menu I. Autoformat, which 
effecttvety anaIysea yow document and ........ tyIes 
appropriately. Again. thla is ,..Hy beyond the scope of the 

ECDL .yllabua and need. to be used with .,..t care or ,.ou 
.....,. find that chIIngea that you did not Intend have been 
made to ,.our doc .......... 

Exercise 10.3 

1. Open the Style Format window for your new document (see previous 

exercise) and click various styles in the lisl in turn; you should see the details 

for each style as it is selected. Just click Cancel when you have linished 

looking at the window. 

2. Look again at your new document. If you have moved or copied paragraphs 

to where you want them. you can now apply the appropriate styles by using 

the drop-down box from the loolbar. Save your new file as. say. fljl/erO I.doc. 

Summary 
[n this ch:lpter: 

• We have looked at the use of templates. 

• We have SL"'Cn how to use :In existing tempbte for a new document. 

• We have St.."Cn thaI styles arc combinations of fornl;It.~ and we h:lve 

St..'en how to !Ipply them to paragraphs. 
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Page 
Numbering, 

and Footers 

Add page numbers. 
Set up and use page headers and footers. 

.' . · . 
• .. (' 1)[. . · . . . . D. Penfold, Word Processing
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11 .1. Introduction 

It is alm051 cCl1ainly unnecessary w explain why page numbering is 

useful. Equally. you are probably f:uniliar wilh page headefli and 

fOOlefli. which may conlain the page numlX'r, btH also include 

informal ion abotH a IX)()k title and chapter or section title and, in 

reports. perhaps the n:l nle of the org:lnisation. a refert:nce code and 

the date of the revision. 

Of course. you could enter these as pal1 of the text on each page. 

However that would not be a good idea, bccau~e if you change the 

formatting or the text, your page breaks may no longer IX' in the 

required place. In addition, if you add your own headers and footers. 

they form part of the text and upset the te.xt flow, stopping pamgmphs 

running on from one page to the next. 

Fortunately Word provides special routines 10 h:mdle the inclusion of 

[hi!; aspect of a book or reJX>11 (as indeed do all top-lcvel word­

processing and p,LgC make-up progr:tms). 

11 .2. Adding Page Numbers 
You can add p:lge numbers (or folios, as they arc known in 

publishing) to pages w ithout setting up headers and footers as such. 

Exercise 11.2 
Go to the In.ert menu and select Page Number • . which will open the 

window shown in Figure IlIa. You will see that you can choose where on the 

page the number is to go and how it should be aligned. The tOP box gives 

you the options of selecting the top or bottom of the page. wtlile the alignment 

box includes the opOons of Lett. Center and Right as wel l as Inside and 

Outside to caler for le/t- and right-hand pages. You can also choose 

whether or not to include Ihe page number on the first page. 

Page Numbc lI AD ' 

I .... 

E.lJmIat ... 

Figure 11_1 a The Page Number window. 
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If you cl ick Format, you will open the window shown in Figure t 1 .1 b . Most of 

the options are self-explanatory. except perhaps the reference to section 

numbers. AUhough outside the ECDL syllabus, you need to know that a 

document can be divided into sections (and, indeed. has to be if you mix, fm 

example, portrait and landscape pages). Here you have the option to restart 

the numbering of each section (which is another reason for dividing the 

document into sections) or running it on. 

p 

Figure 11 .1 b Page Number formatting window. 

Page numbers only show in Page Layout view and, when you insert them, you 

will find that Word automatically switches to this view. You can of course 

switch back. You will also see that the page number is ·greyed' out. If you 

want to edit it (and there is no real reason why you should , unless you are 

perhaps unhappy with the typesize), you have to treat it as a fooler. You 

double click on it, which will bring up a w indowftoolbar that we will d iscuss 

below. Note that the page number may appear as (PAGE). because it is what 

Word calls a field and il depends on how your system is set up whether field 

codes are shown or not. You can change this in Tools I Options I View. 
Incidentally, to be sure that you see the actual page number you can use 

Print Previe w , which we shall look at in Chapter 14. 

You may also notice that three new styles have been added to your drop­

down list, Header, Footer and Page Number. These are applied automatically 

and you would not normally use them in any other context. However. if you 

know how to do so. they can be changed iust like any other style. This is 

outside the scope of ECDL. 

Open your letter file . Add text to ensure that it at least runs on to two pages. 

Then insert page numbers. Try Ihe diHerent options (you can only insert page 

numbers in one place, so changing the options will move them, rather than 

add yet another fol io). Again, it may be worth looking at letters from large 

organisations to see which styles are clear and which are not. Save your file 

again as a new file Of a new version. . .. 
• E(;DL ' .. . 
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11.3. Headers and Footers 

Strictly ~pcaking. headers and fOClters (othcfv>'i~e referred to :is 
headlines and fOCltline~ or running he;ld~ ;Illd nUlning reet) are present 
all the time. although you are not aware of them. This is why. if you 
want to add them. rou have to go to the View menu, r;uher than the 
Insert or Format menu. 

Exercise 11.3a 
When you select Header and Footer in the View menu. you will see three 

(or perhaps four) things happen: 

• If you were not using the Page Layout view. Word automatically sWitches to 

this view. In fact. headers and footers are only visible in this view. 

• The main page text is greyed out 

• The header area appears. 

• A new window. effectively a toolbar. appears. 

These effects are all shown in Figure 11.2. II you mouse over each of the icons 

on the tool bar. you will see an explanation of what each means. On the left. you 

will see In.ert AutoText. which is shown with its drop·down menu displayed. 

The entries are in general self-explanatory: AutoText entries can be edited and 

added by going to the Tools menu. choosing AutoCorreet and then the 

AutoText tab. Use of it is outside the ECDL sy1labus. but some aspects are 

useful in the context we are discussing here. The insertion takes place at the 

position of the text cursOf. 

,-_ .......................... -, 

........ _ •• Dooo 

~P_'.Dooo -. -. 
Figure 11.2 Viewing headers and footers with 

AutoText displayed. 
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The remaining icons then fall into groups: 

• Two of the next three icons effectively duplicate the page number 

commands we looked at above, while the third allows you to insert the total 

number of pages. 

• The next two icons allow you to insert date and time. Note that these can 

also be used by going to the Insert menu and choosing field, where you 

will see many other fields: all of these can. of course, be inserted anywhere 

in a document. 

• The next icon allows you to access P_ge Setup, which we will discuss in 

Chapter 13. The other icon in this group allows you to hide or show the 

main text whi le you are editing the header and looter. This has no effect on 

the li le itself. 

• The next icon, in a group of its own. allows you to make the header the 

same as the previous one, that is, the same as the header in the previous 

section. If there is no previous section. it will be ·greyed' out. 

• The first icon 01 the last group, before Close, allows you to move between 

header and footer. while the other two icons in this group al low you to move 

between sections. 

The impliC".!.tion of some of these icons is that different seaions can 
have different headers and footers, although they do not have to be 
different, and this is indeed the C".!.se. Having different headers and 
footer.'; is often a good reason for splitting a document into a number 
of SC<:tion~. For example, Ihe 'Prelims· of a book (title page, table of 
contents. preface. e lc.) are often number<.--d with Roman numer.!.ls and 
the main book pagination is in Amble numer.!.ls. 

If you click Close , you return to the view you were in before you 
opened the headers and footers. 

Other than the above, you handle text in headers and footers just as 
you would other text. You can apply any style to text in a header or 
footer and can also u~e ;tll the usual formatting optiOns. 

You should note that headers and footers expand if the contents 
becomes greater than the original size (and headers and footers can 
contain piclUres as well as text). so you need to handle [hem with 
care. Note also th:lt the position of the header and footer is SCI in the 
P_ge Setup (Chapler 13). . .. 

• ECIlL· .. . 
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"Is.~ .................... to ......... ,... ............ or 
to .... h •• d,,. ..... Iooten If,... ........... o ...... x 
1Qout ...... you MIll .... both In ......... doo......t. " Ie 
not advIubIe, IMCI ..... "MIll tNd to 0 ....... 1"""" In ......... 
............. ,... ................... ua.t Ie .. rou need. U .. 

Mad.'a ..... toot.n ..................... Ie ..... complex . 
.......... r .... you ........... ......, In the NormlII view! 

Exercise 11.3b 

Open the verSIOn 01 your letter tile in which you included page numbers and 

add headers and looters to see what happens. If you include a page number 

field in the header or footer as well as inserting a page number, you will end 

up with two folios, which is generally not a good idea, Do not save this file. 

Exercise 11.3c 
Open the version 01 your leiter file without page numbers and add an 
appropriate header and/or footer. Save this as a different version/lile from the 

versioo in which you Simply added page numbers. 

Summary 
In this chapter: 

• We have looked at inscrting page numbers (folios). 

• We have looked as adding headers and foolers to :1 document. 
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Checking 
and Changing 
Spelling 
and Grammar 

Use a spell-check program and make any necessalY 
changes. 
Use a grammar-checking program and make any 
necessary changes. 

.' . · . 
• ,.cD!.' · .. . D. Penfold, Word Processing
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Cheeking and Changing Sp.lllng .nd Gr.mm., ........... ~ ..... . 
12.1. Introduction 

Word provides facilities that check your spelling and your gl"'Jmma r_ The 
first thing you n<."(.-d to be sure of is whether Word is talking the same 
language as you ;Ire. To do th is go to the Tools menu and select 
L.ng .... g. ;lIld then Set I.IInv ... ge, 111e language that is already sct 
for your documem will be highlighted. You can change this if you wish. 

N(){e that there are various versions o f Engli.~h ; UK English assumes that 
you want to spell words with -ise, -ising, ised and -is lt ion at the end, 
r-Jther than using -ize etc. 111is means that you have to be C'Jreful if you 
want to usc British spelling for words such as colour. but the 
-ize oplion as well (which some publishers such as Oxford University 
Press n.'commend). While you can SCI up cusfOmiSt.."-'d dictionaries, Ihis is 
oUiside the scope of ECDL. It is nO( documented whether the gmmmar 
checking also has variations between the differem v ersions of English. 

12.2. Checking and Correcting Spelling 
[n earlier versions o f Word, you had to run the s pell checker to see if 
Word thought you had made any errors. You still C'J.n, ei ther by 
pressing function key F7 or by going to the Tools menu and .sclcaing 
Spellinv .nd Gr.m""'r. NO!:e that by going to Tools I Options I 
Spelling .nd Gr.m""'r you can specify w hether nO!: you check the 
gr-.Jmmar at the same time (and you can also change this in the 
window Ihat is display<.'(! when a potenti:t! error is found, Figure 12.1). 
If you have some text selected, the check will o nly take place on the 
selcacd tcxt. 

r. __ ........ -' .... (ltw_w .. ""'~.. _ 

...,.,-,> --
-" -,... _. 
-" -
1-

• 

Figure 12.1 A po.sible spelling error Is found. 

If the spell check hilS a word that il thinks is wrongly spell<."<i, then 
you will SI..'C a window like Ihat in Figure 12.1. You C'Jn choose from 
the following options: 

• Ignore or R.sume : Go on to the next word: make no ch;mge. 
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• Ignore All: Go on 10 Ihe nexI word; do not m;lke ;my chango.: and 
do not query this word ag;lin if it occurs in the document. 

• Add; Add to your custom diction;lry. You can also edit this 
diclion:HY by going to Tools I Options I Spelling and Grammar 

and pressing the Dictionaries huuon. 

• Change: Ch:mge 10 lhe suggeslion highlighted in lhe Suggestions 

box. You can sciecI Ihe righl word if il is there. If it is nOl and you 

still n(.-'Cd to make a change. Ihen you can overtype in the box al lhe 
lOp. If your new word is also nOl in the di<.1ionary, Ihen you will SL-'C 
anOlher message and have 10 decide whether (0 ignore the word or 
add it (0 your custom dictionary. You c:m also choose Ignore All , 

which will ,lllow you 10 usc Ihe highligh!Cd word in lhe pre~m 
documem , hut nOl :ldd il (0 the didionary. 

• Change All : Change all occurrences of the word in the same W:ly. 
• AutoCorrect; This will make the correction :mel add it to the liSl of 

words th:tt are automatically corr('""i21t:d as you type. Be C".l.rcful about 
u.~ing this oplion in the spelling check, 1JCC'.l.usc you m;IY find lhat 
you ;ldd changes lh:11 arc wrong! Fortunately, you Can access and 
edil the AutoCorrect list, via Tools I AutoCorrect. 

Note that the Options button takes you directly to Tools I Options I 

Spelling and Grammar. while there is also a tick box lhal allows you 
10 decide whelher 10 check grJ.mmar or not, as we noted alXJVe. 

Word 97 makes life easier for you, however. in that, if you have 
indicated so in the Options menu, all word~ that Word thinks :tre 
wrongly .';pclled will have a wavy red underline. To view aitern;llive 
.';pellings, righl dick on Ihe word (see Figure 12.2). To leave the word 
unchanged, just click away from the pop-up menu (although il will 
relain Ihe underline). Allernatively, you Ca n click on Ignore All , when 
Ihe underline will disappear. Thus, to SL'<." which word.'; may be 
'wrongly' spelled, you jusl need 10 scan the documem by eye. 

op·do .... n -- .d· 

,uy'greer .... 
•• os; 

Klls/Opt, '"'- Q ,-.... 
,ge'Selll(! .. p, _. 
,ge'~4.uP ~ ~ ... ·M 

Figure 12.2 Drop-down window displayed after 

word with wavy red undertine is right-clicked. .' . 
• F,C'"D1. ' .. . 
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It I. worth ...... mb.ring .... t all a apell check.r I. do6nV I. 
cOfnlNlring the word. you u .. with a dk:tionary ... mIIY Mt 
be correct from your point of vl.w and will milk. aome 
odd, and somet ...... emusIng ...... tlon. '01' proper 
__ •. F~, It will not find word. mlsuaed, •. 11. 

prlnclpl. Instead of principal, .ffect instead 0' affect, so 
apell checking need. to be UHd 1nt .. 1 ...... .,. and with 
c .... lon .... v ............ spell checkers.re .Jrtremely .... ful 

utHItI •• " UHd property. 

Exercise 12.2 
Open your letter file . If you have made any potential spelling errors. they will. 

by default, already be underlined with a waVlj red line. Right click. on these 

and decide what to do. You can also go to the Tools menu and select 

Spelling and Grammar (or just k.ey F7). At present. uncheck. the Check 

grammar box and work. through the document If you wish. you can 

introduce deliberate spelling errors or proper names to see what happens. 

Save your corrected document 

12.3. Checking and Correcting Grammar 
The gmmmar checker works in exactly the same way as the spelling 
checker 3S far 3S the interface is concerned. Indeed, you C3nnot run 
the gmmm3T checker independently of the spelling checker, except in 
so far 3S that gr:lmmatica! errors arc underlined with a W;IVY green 
line, rather than 3 red one, so right clicking on an example will bring 

lip the I)().~sible gr:Jnlmar error (see Figure 12.3). 

U ' UIC' IOU' Io:IICIo:K' "Iroll" UII 

:. (f~·12.4):~ 

ve' ( figures 

Figure 12.3 Drop-down menu displayed after phrase or 

sentence with wavy green underline is right-clicked. 

If you use Tools I Spelling and Grammar the options that you have 
are similar to those with Ihe spell checker, but fewer (.K"C Figure 12.4): 
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• Ignore or Resume: Make no change :md move on. 
• Ignore aU: j\bke no ch:mge to any instance of this error in the 

document and move on. Do not highlight this error again. It is nO( 
entirely clear what is ll1eant by the S3.ll1e error. 

• Next sentence: Move on within the paS&lge shown. 

• Change: Change as suggeslCd or as you rekey. 

s~ 4hd GOd."' .. " I r>gt"h IUnoled "ong"""'l I1El 
ca.....Usei 

You 'I1n ... Iull", bypr ... .ngfun'l1onkty F7 O! by :j I -- I 
g""'l!; \.0 !he Toolt menu ",d ul,,1uIi Spelbng ond 

_ .. 
I 

o ....... u .oj ... - I -. 
r 

~I .,..,. I 

oj 

ElJ po o.ct" ....... QptiDno ..• I ... I ~ I 
Figure 12.4 Possible grammar error is found. 

Note Ihat in Ihe Tools I Options I Spelling and Grammar menu 
(Figure 12.5) Word allows you to select various writing styles and to 

even generate your own style, but only by sekcting from the list of 
Scttings provid ... -d. 

T'd~ I ~~I ~ 1 ... .....-..1 _ I .......... I ~ I I'rW: I _ ~6Gr_ -P o.o.9In\I .. "",t.,oe 

r """ ~ ...... "1Ns IIocuwI PAI-ts __ 

r 5upst _ ...,d<tIontty<riy 

p avae __ " If"ERCA5[ 

P""'_oCI1~. 
Pavae_..:I!"_ 
Cuotoro~: 1=.0I1.0[C . -
P O'O'q_ ...... t>I>o 
r ... ,,-.ol....,. ........ _ 
PQJd"--~ 
r_~y_ 

~ ... 

Figure 12.5 The option to choose writing style. in the 

Tool. I Option. I Spelling and Grammar window. 

• E('OI. · ... 
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"caN Is .... d.d In ...... a ........ oheoll..,. then even 
..... caN Is .... d.d lin ....... a ........... oheoker. "can 
certaInIr be UMfulI lin tIwowIng .. oIwIDue ."..., such .. 

....... • pao ... m_.plao'" ~ etc., ItuI " oft ... 
• u ••• eta unneoeu.ary chan ••• (tor ........ , the Word 

........ oII.oker", ....... paMIve ........ ' ..... 1 • ................. ..,......, ............ " ................ . 
• 101"'" NOD ................... or,..... ...... So, ... the 
..... a. cheoIler, but ... " Int •••• nttrt 

In Sect .... z.~ we noted ........................... ..... 
icon. " rou ....... oIiak ... Icon. rou wi. ~ to the 

next ........ ' or ......... error. 

Exercise 12.3 
Open your lener Ille. II you have made any potential grarrmar errors. they will 

already be unoerlmed With a wavy green line. Right click on these and decide 

what to do; you may well disagree With the advice g iven! You can also go to 

the Tools menu and select Spelling and Grammar (or just key F7). This 

time, check the Check grammar box and 'NQfI( through the document. You 

will almost certainly lind something that the grammar checker does not like. 

You will also see any spellings that you left uncorrected in the lasl exerCise. 

Save your corrected document. 

Summary 
In Ihis chapter: 

• \'(Ie have looked al using a spelling checker . 
• We have looked at using a grammar checker. 
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Document 
Set .... p 

c te u will learn how to 

Use page set-up. 
Change page st:ze, page orientation and margins . 
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Document Set-up 

•••••••••••• ® ••••• 
13. 1. Introduction 

We h;we looked at form;llling par.Jgraphs and imposing styles. hut so 
far we h:lve not mentioned how to define the over.ill byout of the 
dcx:ument. p:lge size, p:lpcr size and so on. These are all defined and 
mod ified hy using Page Setup, which is on the File menu 

13.2. Paper Size and Paper Source 
When you open Page Setup, the first tab you see is usually margins. 
However. we will look first :11 Paper Size and Paper Source (Figures 
13. 1a and 13. 1h). 

Exercise 13.2a 
In Paper Size, you sellhe size of Ihe paper Ihat you (or more correctly your 

printer) will be USing. NOle that versions of Word when installed may have the 

default paper size set to the US standard letter (8.5 by 11 inches). You can 

set the paper size to A4, which is what most people in the UK use. but you 

should also click on the Default button 10 change Ihe defaull paper size. You 

will be asked whether you want to do th is. You should click Yes. bUI II is a 

good idea only to make this change of paper size allhis time, so that all other 

sellings will be retained. 

-, 
tiW't: 129.7 em 

-. 
fA! r.' PortrI4 
~ ("~ape 

, '" 

Figure 13.1a Paper Size tab of Page Setup window. 
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1"_ Setup fiE! 

t\,o!gjr>s 1 p_:;;.e JbPOis-:-11 ~ 1 
1701_, r--r.2i,4'$# Oil 

.01 ~ 

Qjt._: rill ;Pi 
Oil !i, 
.01 ~ 

~I:o' I....,.,.. docunent ::J 

Q,oofd .•. I I ~ I """ I 

Figure 13.1b Paper Source tab of Page Setup window. 

In this menu you also set whether your document is to be portratt (long side 

vertical) or landscape (long side horizontal). Note that you can apply these 

seltings to the whole document or just from this point on. If you have sections 

in the document, you can apply the change just to one section (useful if you 

want one section to be landscape and the rest portrait). Note that you see 

a preview. 

WillI is shown in Paper Source will depend on Ihe printer you have 

sel up on your system. NOll' thai you have the oplion 10 take p~lper fOI 

the first page from one lray and the paper for the remaining p~lge.~ 

from another tr.ly. 111is is to cater for letters where the first p:lge ~lnd 

Ihe continuation pages often usc different notep3per. [t depends on 

what you 3re doing (and whether your printer allows this) as to 

whether this facility is useful to you_ And. of course, if you have a 

printer that will take more than one size of paper, you can sel up 

sections 10 go on different paper sizes. 

Exercise 13.2b 
Open your lener file , which will almost certainly be portrait. although the 

paper size may be US standard letter. Open the Page Setup window from 

the File menu. Change the size to A4, which is almost certatnly the size of 

paper you will be uStng if you are in the UK or any other part of Europe It IS 

probably a good Idea to change the default as wel l. See what happens if you 

change the page onentatlon to landscape, although you will probably not 

want to leave your letter like thls_ Save the document If you have changed 

the page size. You can look at the Paper Source tab, but you are unlikely 

10 want 10 change anything hefe, unless you are on a network. tn which case 

talk to your network manager. .' . 
. .. ("m. > 
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13.3. Margins 
The first four entries (see Figure 13.2a) are self.explanatory and 
indicilte the dist:mce from the edge of the paper to the edge of the 
text area. They are shown in the preview. 

"" 1 ~.5i em !l -- IZ.5i em !l -
"", 1'·1?00 !l ~ ... 13. 17 00 !l -

--. 1000 !l -... ----. ILlSOO !l - II .lSoo i:l -~ 1_ do<unoo"I. ::J 
r~ ... ~ 

.", ...... I I ~ I ""'" I 
Figure 13.2a Margins tab 01 Page Setup window. 

lnc next oox, Gutter, need .. some explan:uion. It refers to what is 
also called a binding margin. It will be added to the left-h:md m:Lrgin. 
However, if you have the Mirror margins box ticked it will be added 
to the right-hand side of left-hand (verso) pages and 10 the left-hand 
side of right-hand (recto) pages, as the preview shows. (Note that you 
may have 10 dick on the Apply to box to change the preview.) Figure 
13.2b shows the effect on the page preview. Mirroring the margins of 
course also reverses the margin settings on the Jcft-hand page. 

~ Ip_:eJ~ScuaoI ~ 1 
IPP' 12.5i00 irl Pr_ 

~ 12 .Si <m ~ 
I0.*I0, 11· )7<111 ~ 

~, 13.17em 13 

.",&t ... """'I 
Figure 13.2b Margins tab with Mirror margins sat 

and a guttar added. 
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The other twO boxes (klCrmine the positions of the top of the he:lder 
and the bottom of the footer in ICrlllS of the distance from the tOp :md 
bottom of the p:lge respectivcly. 

You Gm :llso change the left :md right margins of:l p:lgc by drJgging 
the page markers on the ruler. Note that you usually net.>d 10 select the 

whole document or YOll will only ch:mgc the margins for tlw 
p:lragmphs .,clt.'ClCd. If YOll do [he S:lme thing in Print Preview 
(Ch:lp!Cr 14), you can move ,Ill the m'lrgins. both horizontal and 
venical. This is cquinlem to changing thcm in Page Setup. 

R.member UNIt most prlnten do not print right up to the 

edge of the Pllpet', 80 you need to IIYlk. __ that you do 

not atl. yow ..... r and toot ... too neIIr to the edge 01 the 
PIIP. n.. ...... of course, applies to e.tt and right 
IIYlrglna, but _athetle and tiling conaldenltlona u .... lly 
IIYlk. thla .... lk.1y anyway. 

The I:lst [:lb in Ihe Page Setup window is Layout (Figure 13.3). 
Again this is quitc scif-expbnatory :mel mainly 10 do with sections and 
headers and footers. H also :lllows you to specify line numbering if 
you wish. This was also referred to in the Paragraph Format windo\\ 

in Chapler 8. 

Page Setup 6£1 

INewI)a9O 

I1Nders and Footers 

r Dffetert lPland evet'I 

r OI'fetert t;-st I)a9O 

"-
::J 

_---' .. ""',....""''''', '------ll 8Wf tn: Iwtde d,,« .... ent 

r 

'" Co,"" 
Figur. 13.3 The Layout tab of the Page Setup window • 

. ' . 
. .. COl. , 

' .. 
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Exercise 13.3 

1. Open the latest version of your leuer. Try changing the margins and. if you 

included a header and tooter, the distance trom the edge ot the page. Set 

whal you Ihink may be reasonable. Add a binding margin if you wish. Are you 

planning to print the second page on the back of the first? (f so, then set 

Mirror margins. You can also experiment with having different odd and 

even headers in this case by using the Layout tab. Again. once you are 

happy, save the latest version. 

2. Ideally, the format that you flOW have should be one you would like to use for 

a realleUer. You can therefore. if you wish save this as a template. calling it 

perhaps M),fcIfCI".(/OI. It is probably a good idea to delete all the text except 

your address (and telephone number). Nole that you can always edit this later 

if you wish. 

Summary 
[n this chapter: 

• We have looked al how 10 use Page Setup. 

• We have seen how to changc the page size and oricnt:ltion. 

• We h;lve S<.-cn how to set Ihe dcf;luh page sizc. 
• We have seen how (0 change the paper source if necessary. 

• We have seen how to modify and mirror the p:lge m:lrgins :md the 
positions of the header and footer. 

• We have secn how to add ;I guller or binding margin . 

• We have seen how to ;ldd line numbers. 
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Printing 
Documents 

I 

Preview a document" 

Use the basic print options" 

rn 

Pn"nt a document from an installed pn"nter" 
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Printing Documents ............. ~ .... 
14.1. Introduction 

Even in this age of eJedronic communication, it is more than likely 
that you will need a primed version of a file you have oc-en working 
on. Windows is able to store dctails of many printers ,md you can 
switch between them if they are attached to your system. However, 
there is always a def:lUh printer, which is the onc to which documents 
are scm unless you indicate otherwise. 

Although the primers are installed from Windows itself, all control of 
the printing of documents is done from within Word. And not only can 
you print from within the program, but you can also preview what you 
are going to print. As we saw in Chapter II, the Page Layout view 
may nOt give you a tme WYSIwYG (What You See [s What You Get) 

view, whereas the Prim Preview does. 

14.2. Print Preview 
To see a print preview of your document, as mentioned in Chapter 13. 
go to the File menu and select Print Preview . l11ere are various tools 
shown on the specialtoolbar (s(""e Figure 14.1): 

Figure 14.1 The Print Preview window. 

• You can print diredly from this preview. 
• You GIO select the m;lgnifying glass and zoom in ;Ind out by simply 

clicking on the page. 
• You can show a single page or up to six pages at the s;lme time. 
• You can choose the exad magnific'JIion that you want to use. 
• You can display both horizontal and venical mlers if you wish. 

These allow you to modify the margins, as discussed in Chaptcr 13. 
• You can shrink the view to fit. 
• You Gill use a full~screen view. so that the menu bar disappears. 
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When you exit from Prin! Preview, you return to the documcn! vk:w 
you had previously_ You do not close the file. If you prin! di rct1ly from 
Print Preview, you open the Print dialogue box, as we shall see below. 

Exercise 14.2 
Open the latest version of your letter file and then open the Print Preview 

from the File menu. Zoom in and out and vary the magnificatioo. Change 

the number of pages you can view. Show the rulers and experiment with the 

margins (i f you do this. either use Undo Of. better, make sure that you do not 

save the new version of your file). Try some of the other options. Do not at this 

stage print. You can ctose the Print Preview and even the file, if you wish. 

when you have finished. 

14,3 , Using Basic Printing Options, 

126 

Including Choosing the Printer 
To print a file, you can print from the Print Preview, you can select the 
toolbar icon ~, you can select Print from the File menu or you can 
use the keyboard shortcut (Ctrl+P). Whichever option you choose, 
when you decide to print, you will see the menu shown in Figure 
14 .2. 

"-- ..-SIoa& ~ __ ..... 

T,.,.. L...J.os..-....Il" - ~, 
~ .... ~ 
'. _.-
-....£:J 

I I :' " 

Figure 14.2 The Print window. 

You can therefore choose which printer to use (the one that is shown 
initially is the default primer and you will only sec the printers that arc 
insulled), which pages to print , how m:my copies \0 print (and how to 
collate them). You can also determine whether you prim the document 
itself or certain related information, but this is not within the ECD!. 
syllabus. You can also prim JUSt odd or just even pages, as well as all 
pages in the [",Jnge you have SCI. .. , 

• ECDL ' . , . 



Printing Documents ............. ~ .... 
If you click on Properties. you see another window (Figure 14 .3), 
which varies depending on the printer; since each printer h;IS its own 
driver software that determines what you see here. \l:lh:u always 

appe:lfS, however, is lhe o ption to change the paper size since. as h:ls 
:tlready been mentioned. you may find th:ll m~tny :lpplic:uions use the 
US Iener size :IS def:lult. You will probably need to change this to A4 : 
Ihis is a sep:lTate setting from that in Page Setup. which sets the p:lge 
size for the documem r.:lther than the printer and the oricnt:llion of the 
page on the printer, portT'.ait o r landscape. Once you h;lve made your 
selection. click OK and then again OK in the main printer window . 

D •• 
"" 

P __ I AWoSoIocth..,. ::d 

~~ ~""' I 
.to<U- A_Jl.ot .... I 

O~ c..:..I I - &q. 

Figure 14.3 The Print Properties window. 

Exercise 14.3 
Open your final letter document and. by whatever method you prefer. print it 

onto your default pnnter (or another one if you prefer), Are you happy with 

what you get? If not. then you may need to go back and change some of the 

things you set in prevIous exercises. 

14.4. Viewing the Progress of Printing 
If you h:lve sent :1 number of documents to be printL>(I, you may wish 

to review their progress. This : lctually forms pan of Module 2. but is 
repeated here IX-'Cause it is infonnation that you may find very uscftJl 
in the word processing context. You can do this from the desktop print 
manager. 111cre arc two W:lyS to do this. 
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Exercise 14.4a 

1. Open the Printers window from the Start menu (Start I Settings I 

Printers) and then select the printer you are currently using and open it. You 

wil l see a window like that in Figure 14.4. which shows you the progress of the 

various prinl jobs you have sent to this printer. 

(f1",onll,!0600 .. r-JD 

Figure 14.4 Progress of print jobs. 

2. When you start 10 print. you will see a printer icon open in the Taskbar at the 

bottom right of your screen (next to the time in most cases). If you click on 

this. you will see the same window as In Figure 14.4. The icon will remain as 

long as there are fites being printed. When printing is complete. it will 

d isappear. 

From the print ............ K ....... you can al.o p8u .. Of' 

purge print ..... TIll. can 1M useful H, for example, you Mve 
• long print queue .nd suddenly he. ~ .. gent to 

print Of' " the print., t-M .nd ~ou ...... 10 dop printing. 

Exercise 14.4b 
Try printing several documents and then open the Print Manager window. 

Relate what is happening there to what is coming out of the printer. Note that 

sometimes. because a printer may take some time to process the page 

internally. it may be even a few minutes after a print job has disappeared from 

the Print Manager window before it is actually printed. 

Summary 
In Ihis ch:ipter: 

• We h:ive looked at how to use Print Preview. 

• We h:i\'(: looked al how to set the print p:il"amctcrs and the printer 

properties. 

• We h3ve looked a1 how to monitor the progress of printing. . .. 
• F.('nt. · .. . 
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Creating, 
Editing and 
Fonnattjng 
Tables 

Set up a fable in various ways. 

Edit and format a fable. 

I: 
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15.1. Introduction 
In Chapkr 9 we looked at the usc of t;Jb ~tops ;md noted tlJ;J( thcir 
use W;IS good for short items, blll for blocks of text, for ex:tmple, thi~ 

was not a good approach, bcc;lUsc tabs only handlc lexl on :t line by 
line b;l~is. T;lblcs in Word. however. ~Irc b;ISL'"(1 on a cellular appro:1Ch, 
so th:l( ;1 t:Lblc h cs.~emi;llIy ;1 block of cdls, to each of which separJtc 
form;nting em be ~Ipplicd. You c;ln also apply formatting to the wholc 
table or on either a column or a row b;t.'>is. 

15.2. Creating a Table 

13. 

'I11ere arc two ways you can crcate ;1 table by using commands 
(Section 15.6 explains how to dmw a table), 

Exercise 15.2 
• Use the Icon [lm on the Standard toolbar. which opens a grid (Figure 

15.1) on which you can choose up to five columns by lour rows by default. 

However if you drag and drop with the Tight mouse bunon. starting in the 

top left cell, you make the table any size you like. Figure 15.2 shows a table 

of four columns and three rows produced in this way. (Note that if you 

select text before you click the icon. you will convert that text into a lable 

with the number columns corresponding 10 the number of tabs you have 

set in the paragraph. although the result is nol always easy to predict,) 

4 x 4To!IbIe 

Figure 15.1 Table options shown when using toolbar option • 

~. D· 0 , .. 
1 : I: 1 : ~ 

Figure 15.2 Example of table created with toolbar option . . . . 
• I':CDl. · .. . 
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• Go to the Table menu (tables ha'Je their own menu) and select Insert 

Table. You then see the window shown in Figure 15.3. You can choose the 

number of columns and rows. as well as the column widths if you wish, 

although Auto IS a good first choice (and IS what the icon approach 

generates automatically), pro'Jiding equal widths with the total table width 

equal to the page width. If you make your cojumns wider. some of the table 

may be off the edge of the page! 

Inier! Table DEI 

Number fi ,-ok..rnns: I! :i:J OK 

f\Unber fi tows: 12 :i:J C~d 

Colurm~h: IAuto :B Autoformat ... 

Tabk fOfmat: ''''''''') 

Figure 15.3 The Insert Table window. 

Note that with the second approach. you can at the same time select 

AutoFormat, which we shall look at below. The other point to note is that, 

unless you use AutoFormat. which you can also select from the Table 

menu. each cell of the table will initially take on the format of the paragraph in 

which you create the table. Thus if we choose another table of four columns 

and three rows, it will appear below the first table. as shown in Figure 15.4. 

You will note that the two tables are identical. 

, '" . - ' .. . " p 

!: !: ! : !: ~ 
• 

!: !: !: ! : ] 
Figure 15.4 Table s created via m enu a nd toolbar options. 

Now create a new file (with a b lank page template). Try creating a table by 

ei ther of the abo'Je approaches. See which you find easier. For use in a future 

section. create se'Jen columns and head the cotumns as follows: Title, 

Firslllumc, SlIrl/ame, Addn'SS I , "/"01/"1/, COli III)' {Illd POSlcode. Enter 
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some text in those cotumns correspondmg to the column headings. Create al 

least five rows in addition to Ihe headmg rCffl. II does nOl malter whether you 

use real names and addresses or not. Save the file as la ble_tc:stO/.tloc. 

15.3. Changing Cell Attributes 

132 

The first thing to note is th ~1\ there arc various selections you can make 
in a taNe: 

Exercise 1S.3a 

1. You can select a row. again using Select Row from the Table menu or 

using the mouse. When you do the latter, make sure that you include the 

column marker for the end of the row. which looks as though it is outside the 

table (Figure 15.5(a)). jf you do not do this (see Figure 15.5(b)). you will have 

selected the cells making up the row and not the row itself. 

Figure 15.5a A row selected. 

Figure 15.5b Cells in a row selected. 

2. You can select a column, again using Select Column from the Table 

menu, by using the mouse or by moving your mouse cursor down to the top 

of the column. In the latter case it will change into a broad arrow and the 

column will be selected if you then click (Figure 15.6). 

Figure 15.6 Selecting a column. 

3. You can select the whole table, using Select Table in the Table menu or 

using the mouse in the usual way. Again, it is important to make sure that you 

include the last column marker. 

. ' . 
· F-rot. · .. . 



Creating, Editing and Formatting Tabl.s 

•••••••••••••• ® ••• 

4. You can select a cell or cells with the mouse. 

Once you have made this selection, you are able to do different things: 

• If you have selected a row, then you can format or delete (all the cells in) 

that row, To delete, you use Delete Row trom the Table menu: it you just 

use the delete key, you will end up with an empty row, Le. you delete the 

contents but not the row. You can also insert a row. but you do not have to 

select the r(yoN to do that, just place the cursor in the row below where you 

want to insert the new row and click on Insert Row from the Table 

menu. However, if you select a number of rows, when you select Insert 

Row trom the Table menu you will insert the same number of rows as you 

have selected. Thus if you want to insert three rows, you select three rows 

below where you want to insert the new rows and then select Insert Row. 

• If you have setected a column, then you can again format (alilhe cells in) 

thai column. To delete, you use Delete Column from the Table menu: 

again do not use the Delete key. As with rows, if you select two columns 

and then choose Insert Column from the Table menu, you will insert 

two rows to the left of the rows you had selected. Even to insert one 

column, you need to select a column; if you do not the Insert Column 

command will not appear in the Table menu (to replace Inse rt Row)­

the same is true of Dele'e Column. Note that to add columns to the right 

of the table, you select the column formed by the markers on the right of 

the table and then choose In.ert Column. 

• If you select the whole table, you can, of course, delete the whole table (use 

Dele'e Row again) or you can format the whole table. You can also convert 

the table to texl (with or without tab stops) or sort entries in it. These two 

aspects are really outside the ECOL syl labus. but are useful techniques. Note 

thai by selecting text and going to the Table menu, you can also convert the 

text to a table. which can be very convenient. This is a more controllable 

approach than selecting the text and using the In.ert Table icon . 

• If you select a cell, you can format this, as well as deleting the cell, 

inserting additional cells and moving the cell boundaries (as we shall see 

shortly). However. once you do any of the last three operations. you will find 

that the table is much more difficult to handle. This is because the columns, 

and perhaps also the rows, wil l cease to align and making changes In 

terms of the rows and columns, which is great advantage 01 handling 

information as tables, is much more unpredictable. What you can do, 

however, is merge cells, so that you are able to produce cel ls that straddle 

either vertically or horizontally or alternatively split a cell into a number of 

other cells (Figure 15.7). 
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~olWlUr2Q 

o Spill Cell . IH EJ 

o /Unberd~: 

-"----- IUnbef d (.OWS: 

II 

r ' 

OK Co/ItICei 

Figrolr8 15.7 Splitting a cell. 

In WCN'd ••• he PNdtK:eMOr of WCN'd 87. when ~ou MIec.ed 
.wo col ......... In • lIIb1e .nd then choN ..... c.n ...... 

'wo col ......... w .... _led cell by cd ... tIuIt two 
col ....... bee ......... Untortun.tety. In WCN'd 87. merging 

'wo eoa.-. vtv ...... enonnous cell. which I. not v..., 
.... pfuI. There lIN w.,. ........ this, but they Involv. 
varlou. h1cks. So If ~ou Mve • .-cllk: NquiNrnent '0 
mertte e ...................... to ........... col ....... 
containing honottfIc (Mr, ......... "c.) .............. end 

...,.....lnto ........ cot.- e ............. full ....... 
with honorfftc. then ... If you un obtain • e~ of Word • 
'0 ..... on rour .p ...... ktng ..... Word 871 

If you •• nt '0 .... row ••• he end of a bbl ............ . 
w.~ I. '0 cHell. In ........ call of ........ 1plM:lng .... '.d 
cursor In ...... cell). Then prw ...... lIIb key end .... t.d 
cursor wiD IItove 10 .... ned eel •• thus creating e new row 
In .... proc .... Thl. I. en IDuatNtlon of lhe ...... lhel .... 
tab key .... ,. In ...... It doe. not InHrt a lIIb cluarllCler 

•• such. It movea the cursor '""" cell to cell .. utlng .. 
the top left end going ektng .... row. wttilit reeche ..... 
bottom right. Holding down .... ShIft key while preuing 

lhe lIIb key move ..... eunor .., .... oppo.lt. direction. If 

~ou wanl to key • to ehuacter within • lIIble cal., fOI' 
........ to ellgn • column on the dec ..... 1 point, then ,OU 
he" to k., Ctrl. Tab. 

, . , 
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You can change column widths wi th the mouse. If you move the 
cursor !O one of the grid lines indicating a column boundary. it will 
change into ;1 double veniGl! line with an arrow on each side (St..'C 

Figure 15.8). If you now dmg and drop the cursor, the column 
houndary will move to a new position. 

Note that , as pointed out above, if no cells arc selected, then the 
whole column boundary moves, while if one (or both) of the cells 
;ldj;lcent to the bound:lry is selected, only the boundary of Ihat cdl or 
those cells will move. In either case, it is simply the boundary that 
movcs, so if one column becomes wider, the adjacent column becomes 
narrower. GCl1ing column widths correct C"J n therefore be an itcmtive 
o pe mtion. 

, 
Column'2C -I' Column'3a Colu!1 

0 0 0 

0 0 0 

Figure 15.8 Moving a column boundary. 

You can also change the column width, as well as the row height, by 
using Cell Height and Width from the Table menu. 111is is the only 
way to adjust cell height and, if you know the width of the 
information that you want to pUi into the cells, perhaps a bel1er way of 

adjusting the width as well. 

Exercise 15.3b 
First you select the cells to be modified. Whether you select a complete 

column or a complete row is unimportant as the formaning will apply anyway 

to the complete row or column. Then choose Cell Height and Width. 

Unless you select a column, you will first see the Row tab (Figure 15.9). This 

has vanous boxes you can complete: 
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Indent Erom left: 

r;; AIow rowtotrNkacrosspaQIIS 

-=----;=~ r. ~ r Ceo;ter r Rdt 

Figure 15.9 Row tab in Cell Height and Width window. 

• Height of rows: II is a good idea to set this at Auto or at At le.st 

(with the value in the box on the right). While you can set il exactly. you 

may find entrl&S disappeanng because ei1her the typesize is 100 large for 

lhe height Of the text goes onto two rows. lOf example 

• Indent from 'eft Remember thiS applies to the whOle raw and not the 

text. 

• Allow row to bre.k across pages: This is a quesllon 01 style and 

personal prelerence. 

• Alignment (left, Center, Rightl: Again remember that Ihls applies 10 

the whOle row 

You can then go on to SOft out the next raw or group 01 rows A group can, 01 

course, be the whole table Note that there is also a command on the Table 

menu, Distribute Rows Evenly However, the actual row spacillg is not 

completely under your control If you use this. The rows are averaged rNer the 

table depth. 

II. In the Cell and Height menu. we move 10 the Column lab (Figure 

15.10). we see that we have two options to complete. plus AutoFit: 

... 
• f:C'IlI • • 
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Cen He,gh! and \rrI,dth (J EI 

."" 

I- ±l 
IO.36cm if 

... '''''''" 

Figure 15.10 Column t.b in Cell Height .nd Width window. 

• Width of columns: This can obviously be set at any value, but again be 

carelul thaI Ihe aggregate width does not exceed the page width. 

• Space between columns: This can be varied at will. If you have ru les 

between the columns, this value can often be set narrower than the default, 

which seems to be quite wide. 

• AutoFit: Here the columns adjust to the width of the contents in so far as 

they can within the page width. 

Again there is a command on the Table menu, Distribute Columns 

Evenly. This distributes the columns within the width of the lable. 

So now open your table file. Try inserting columns, rows and even cells. 10 

see whatlhe effect is. Delete columns, rows and cells. Once you are happy 

with carrying oul the operations, c lose Ihe document and do not save it. 

Open your table file again. Change column widths and row heights and even 

the type size in columns and rows until you fee l that the table is as readable 

as you can get it. Then save it as a new file Of a new verSion. 

15.4. Formatting and AutoFormat 
As nowd alxlVc, you can format table cells as YOli wish, using all the 
formatting bcilities used in norrml text. It is also quite po.~sihle to 
h;lve spcdal tahle cell .~ t yles in :, template. However. to make life 
easier for you Microsoft has developed ;, series of st:md:lfd formats. 
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Exercise 15.4 

These are accessed by selecting AutoFormat, ei ther when creating !he 

tabte or from the Table menu. The Autoformat window (Figure 15.11) now 

appears The box at the top left lists the formats; if you select them in turn, 

you can see what each one looks like in the Preview Lower down the 

window, you can select the aspects (borders etc.) you wish to use, as well as 

decidmg what to do about the first and last row and/or column, which may be 

a heading or a total, for example. If you click OK, your table will take on the 

formatting thai you have selected 

"" f"" _ Toto! 

,~ , 
~ .. , " 

" 

r lasI , .... 
rl$, ........ 

Figure 15.11 The Table AutoFormat window. 

There is one final aspect of cell formaning and this can only be done from the 

Tables and Borders toolbar (Figure 15.12), which you can open from 

View' Toolbars, from the icon rn on the main toolbar. This is aligning 

the text at the top, in the centre and at the bottom of a cell. To do this you 

select the relevant cell(s) and click on the preferred icon from one of the 

following, I~ El g 

T Qble and BOIdel3 E:'J 

;Y' a l. • 'h ·.! l o , ~ , 
• Iii! EI E! t:;I I 3f rn I ill! 1Ir. I tI U >: 

Figure 15.12 The Tables and Border. toolbar. 

So, open your first table file agam. Use AutoFormat to see if you can 

achieve a bener effect than you did in the last exerCise. Save the f ile again as 

a new file or a new version. . .. 
• f:rDl. · .. . 
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15.5. Splitting a table 

If you dick in :my row of 3 t3blc :tnd then select Split Table from the 
Tabla menu , the tablc will split 3bove the row in which you dicked. 

cre3ting J bbnk line, i.e. a C'Jrriage retu rn, betw(;.'(;n what arc now two 
tables. 

Exercise 15.5 
Open your first table file again. See whal happens when you split the file . Do 
nol save il. 

15.6. Drawing a Table 
Word 3lso allows you to dr;Lw 3 t3blc. To cre3te a 13blc, you do the 
fo llowing: 

Exercise 15.6 

1. Either cl ick on the perlCi l al the lell of the Tabl.s and Bordars tcolbar or 

choose Draw Table from Ihe Tabl. menu. Your (mouse) cursor will turn into 

a pencil and the loolbar will open if it is not already showing. The view will 

change to Page Layout. 

2. Click where the top lell corner of the table is to go. 

3. Drag and drop until the overall size of the table is about right (Figure 15.13). 

, ........ .. 

.......................... ······+-1 

Figure 15.13 Drawing the outsida of a table. 

4. Click at the top of the box you have created. roughly where you think the 

boundary between the first two columns should be, and draw a line to the 

bottom of the box (Figure 15.14). 

13. 
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Figure t 5. t 4 Indieating the first eolumn boundary of the table. 

5. Repeat this for as many columns as you want. 

6. Click on the side of the box or on a column boundary for the position of the 

lirst row and draw a line across the box, straddling as many columns as 

necessary. 

7. Again, repeat for as many rows as you want (Figure tS. tS). 

...... , 

Figure t 5. t 5 Indieating the laat row boundary 

when drawing a table. 

8. Click again on the Peneil icon or strike the Esc key on the keyboard to eXit 

from drawing mode. 

You can then tidy up your table and add formaning in the ways we have 

discussed above. 

Now open a new file. Create the same table as you did In the first exerCise, 

but this time by drawing. See which approach you prefer. You can save this 

file if you wish, but do not overwrite your last previous table file . 

15.7. Adding Borders and Shading 

140 

Word offers a number of differem ways to achieve oorders and 
shading for your table, as we shall now sec. 

• £(,01, · ... 
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Exercise 15.7 

To add borders, you can either use the Table. and Border. tool bar (Figure 

15.12) or the normal boxing 1001 bar that we have used previously in Chapter 

9 (which is in fact lhe same as the one on the Table. and Border. toolbar 

since icons can be on more than one toolbar). You simply select the 

appropriate cell(s), row(s) or column(s) (or even the whole table) and then 

choose the rules you want to add. It is a good idea to use Print Preview to 

check that the rules are where you want them, The grid lines in a table are 

very useful but they can be confusing. You can hide them if you wish (see the 

Table menu), 

To change the weight and type of rule you are using for the border, you can 

either use the icons on the Table. and Borde ... loolbar again or you can 

use the Border. and Shading option from the Format menu, which we 

covered in Chapter 9. Similarly, you can change the colours of the rules and 

the fill (or shading) of a table cel l. It you use the toolbar, you just c lick on the 

pencil icon .&. for the rules or the paint can icon & for the fill and 

choose what you want from the selection now displayed (Figure 15.16). 

Remember, however, that you may also need to change the colour of your 

font (see Chapter 8) if your text is to be visible. 

Figure 15.16 The fill .election on the 
Table. and Border. toolbar. 

So finally, open your latest formatted table file again (not the one where you 

used AutoFormat). Add some rules and perhaps some shading. How does 

it look in comparison with the AutoFormatted table? Save if you wish. 

Summary 
In this ch,tpter we have lCK>ked at: 

• Three different ways of adding t;Lbks 10 ;1 document, 
• How to select cells. columns. rows ;U1d complete tables. 
• Reformatting and deleting f:dls, columns and rows, 
• Splil1ing cells and splilting a wblc. 
• Adding border.~ and sh;iding to wblc ceils, 
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Drawing 
Objects and 
Handling Images 

Add an image or graphics file to a document. 

Use AutoShapes and niles. 

Change the c% urs of drawn objects. 

Move images and drawn objects. 

Resize and crop a graphic. 

.' . . . 
• EC'OL' .. . D. Penfold, Word Processing

© The British Computer Society 2000
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16.1. Introduction 

Many documenL'> cont:.in iliustf"Jtions. From :I t<..-chnic.lI point of view 
there arc two kinds, those known as bitmaps and thOM! known ;IS 
vo.."Ctor graphics. Bitmaps are images. often digital photogf"J.phs, made 
up of m:my small dots. known as pixels, either black :md white or 
coloun.'d (FigUfC 16.1). Vector gf"J.phics, in comrast, :Ire based on a 
combination of lines and shapes [hat can be dcscrilx.>(1 Illalhem:llically 
(Figure 16. 12) and redrawn each time they arc shown on scr(."Cn or 
sent for printing . 

.. _--

Figure 16.1 A bitmap Image • 

.... _---' ... _---O "' II .. . ll" . ,,~. " !lOI!I •• ~' - .~ __ • 
· . " • ••• " .. . " u· .. · .. ·. 

_.~ .OO • • . l·· .,t · .. · • .. I"l·.· 
_ . ... " ....... ,... III 

Figure 16.2 A drawing or vector graphic::. 

In some ways Ihe two types of artwork aTC handk'<l s imilarly. while in 
others they are Irc:ltoo q uite differently, so it hdps if you understand 
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Ihe difference. One importam factor. for example. is Ihal Ihe file ~ize of 
a piece of v{.'"dor artwork is almosl independcm of Ihe size al which il 
is outpul :md in facl, Ihe same illustration C'Jn be reproduced :11 any 
size beC' .. use it is $Clbble. In contrast, a bitm:lp is cre:ltc..>(l al a fixed 
resolution, i.e. with a fix{."'<1 numocr of dots (pixels) per unit length in 
each direction. I'ut simply, each dot contains the information about the 
colour at that poim and over i[s own small area . If you enlarge a 
bitmap, you may be able [0 crea[e more dots, but you C"".mnot increase 
the information contenl; Ihus [he quality of the piClure grJdually gets 
worse and Ihe impression of cominuous tone cannot be sustained. To 
oblain a larger bitmap at the same resolution, you need more dOis 
with each dol containing its own information. Another effect of Ihis is 
Ihal the larger a bilmap is. the larger its file size is. 

$tric!ly speaking, these differences are nOi part of the ECDl syllabus. 
but they will help you understand why the tWO types of artwork are 
handled differently. Ind{.-cd, you will find that there arc differem types 
of program for handling the two types, although there is some overl:lp. 
Morc impomm. understanding the difference will help you to use 
artwork more sensibly. For eX:lmple, a letter comaining a photogrJph 
will ha\'e a large file size, so that il will take a long time to prim and 
willl:lke longer, and therefore cost marc. to IrJ nsmit electroniC' .. lly. 
quile apart from taking up marc space on your system. 

There are w:lys to compress files so that their file size is smaller, but 
these methods do not :iffect the time taken to print. These 
compression techniques arc also not as appropri:lte for files used for 
priming as [hey arc for files viewed on .screen. YOll will see more 
about images for viewing on screen in Module 7, but herc we will 
restrict oursch'cs to looking al how to add them to documents, how to 
generate sOllle kinds of drawings and how to lIlove and resize Ihe 
illustrations. 

16.2. Adding an Illustration 

, .. 

There are essentially two W:lys in which YOll c:m include :1 picture in 
you r document; you can dr:lw it yourself or yOlL c:m hring it in (import 
it) from somewhere el.<;c. in just the same W:ly as you would have 
done had you bc..>en gcncr:lting a paper based document in the old­
fashiont.-d way. And again. just as in the old way, even if yml drJw Ihe 
picture, you may ch<x>sc nO( do it directly willlin Ihe document, but 
complete [he drawing somewhere else and inser! the finbhed drJwing 
into your document. 

. .. 
• ECO!.· ... 
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If you add either a hitmap image or:1 dl"'Jwing [0 a \Xbrd document, 
the techniques you usc are the same, bec:lUse you arc simply including 
an(){her file within your document file. While it is useful to undcr.st::.md 
the differences between the two types for pr:lctiC'JI reasons. importing 
a file is importing :I file. [n f:lct , we shall sec morc ahout importing 
othcr types of file in Chapter 17. 

You Gln either add :10 illustl"'Jtion directly in the tcxt of your document 
Of. togelher wilh somc additional text, you ("".In put in a text box, 
which is a box that is separate from the m:lin flow of the document 
text and can be moved independently. TIle usc of text boxes is outside 
the ECDL syllabus. but il is a gOCld idea to undersl:lOd the principle. 
Here we shall just discuss inserting i1JusII":ltions directly in the text. 

Exercise 16.2a 
If you wanlto include an illustration, you decide where it shOuld go, placing 

your texl cursor at thai position. Then you go to the In.a rt menu and choose 

Picture. Here we will be concerned with the top two entries in the menu you 

now see (Figure t63) Clip Art and From File. In fact. they only distinguish 

the source of the Image and the method of inclusion. 

~ f\g,,-..... ~, .... ~.~ ..... 
.-.. . • r u •• 
IW;!o/VD"J • 
Det .. ndDne.. to 4 
","'d 

,," .. 
~ ... 

"'---
t'ooIQIIIt .. 

0-"" 
O""(lIf ........ . 

IrOo>cnT ...... . 

"IIIiI ___ ae': III"" M. ... 

11110#.... 'g{ralll'h. 

"... 'iY~ 
QI>Ioct... .. 
1IooI!JIwrt.. . ~ ... 0 _ 

.. ~ .. ctrIt( 

Figure 16.3 The In.ert Picture m e nu, 

If you select Clip Art, you open up t.4Icrosoft"s Clip Art Library (Figure 

16.4). You will also see Ih8tlhe View changes to Page la yout In order to 

take advantage of the whOle library. you will probably need 10 have the 

Microsoft Office CD In your CD drive. but thiS depends on how your system is 

sel up. You Will almost certainly have a seleclion of pictures on your hard disk 
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(and you may see a series of Information screens before you see ehe wmdow 

like Figure 16 <I If you do nol have the CD In I[S drive) 

You will see that the Images are In categories. but to begin with you see All 

Categories. If you choose. say. Transportation. you will see a window like 

Figure 16.5. In the fu illibmry there are a large number (severallhousand) 

piClures. so using the search faclilly prOVided may help hnd what you want 

Figure 166 shows the search screen. NOle that. allhOugh you want a picture. 

you have to search f()( II by the keyword or name thai has been given II. so II 

may be worlh remembering Ihatthe names were gNen In ehe USA 

1'!!lI ~KIMII 
1"-,,"*,-1 

... 1 
r.., ! 
~ I 

a. ....... -,. -_ .. -
.:J _do" 

Figure 16.4 The Microsoft Clip Art library • 

·,M ...... ', ..... _ .. 'v • 

i.~ I a.,.... I 
""' .. ,,:.- _fod, ..... c.-

Figure 16.5 Transportation section o f the Clip Art library • 

. . . 
• frOl. · .. . 
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f"nI .. cb .... QpG....,,... -.-
lM'*,,1 

[ .... '100. 

Figure 16.6 Search window of the Microsoft Clip Art library. 

Once you have found the Image you want, you select It and click on the 

Insart button and the picture will be Inserted Into your original document 

One of tM problama willi Word la that tM •• act position of 

the pict_ la not .tw.,. ~, .lthough .a we shall 
__ below, you c ... .,.cttr tIM rut.a tor plechtg plct .... Do 

not be ... rprtHd initially, " the pic ...... doea not appear 

where 'OU •• pect It to. n.. position dependa partly on tM 

slz. of the pic ...... nd partly on ,our page alz. and where 
.he c.llout w.s on 'IM page. How.v ... , one. It Is part ot 

your docurneont, you can move It around. 

Once you have Inse(led Ihe picture, lhe Clip An Gallery closes and II you 

wanl to Insert another picture, you have to (eopen It This can be a 1,"le 

tediOUS If you want more than one picture, but there seems to be no way to 

keep the window open_ NOle that, if you click on Clip ProJHtrtia. , you see a 

window like Figure 16.7, which tells you Ihe palh name of the lile, as well as 

ItS size and file fOrmat Although we shall not consider them here, there are a 

large number of dlHerent graphics and image file fOrmats 
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Figure 16.7 The Clip Art Propertl •• window. 

If you decide lhat Microsoft's offerings are not what you want or, alternatively, 

you have a scanned photograph or ooe taken on a digital camera lhat you 

want to include in the document. then when you choose Picture from the 

In.ert menu, you choose From File instead of Clip Art. You will now see 

a window like Figure 16.8. In fact, you can access the Clip Art library this way 

as well if you know the folder it is in (which you can take from the screen in 

Figure t 6.7). You will notice that in the box at the bottom left you can specify 

the file type and conveniently all picture types are grouped together . 

• 

Figure 16.8 The In_rt Picture window. 

• F.C'D1. ' .. . 
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You can again search (either by file name IX by text IX property) and you can 

also browse and, as you do so, you will see previews on the right of the 

WIndow. Once you have the picture you want, you select ln.ert. Note that 

there are one IX two other buttons and options on this screen: 

• Advanced: This allows you to carry out more complex searches. 

• Link to file: It this box is ticked, then, rather than the picture being 

inserted in the file, a lil'lk to the picture is added. This has advantages and 

d isadvantages, Of course, it keeps the file size down, but, if the documenl 

is passed to someone else, you have to remember to include a copy of the 

artwork file and update the link (aJlhough the next box S.ve with 

document helps you with this). In addition, when you look at the file on 

the screen, the picture has to be called in each time you scrOll, which can 

slow down the scroWng, 

• Flo,at over text: If this box is ticked, then the situation is the same as 

with the Clip Art Ubrary and the position is unpredictable, being placed in 

a picture box between paragraphs at the position that 'looks best". 

However, this may not be the most appropriate place WIth reference to your 

text. Thus removing the tick from this box means that the pICture goes 

exac!1y in the text allha poinl where you called it from. This may, of course, 

mean lhat il disappears off the edge 01 the page, but you can always move 

it (by Cut and Pa.te), The problem comes if you edit the document and 

then have to reposition the picture. However, although the floating option 

copes with this in principle, you may lind that the solution is not always 

what you want. You will need 10 find the best solution to your needs. This is 

not one of Word's better aspects. 

NO{c Ih:1I Word also provides a Pictu,. loolb:u (Figure 16.9), bUI mOSl 
of the adjustments il allows you 10 make are nO{ covered in Ihe ECDL 
syllabus. In addilion, whilst Ihe loolbar provides some b:lsic 
functionality, there :Ire much betler tools than ~brd for handling 
pictures. 

Figu,. 16.9 The Picture toolbar. 

You can, of course, always, copy an illustration from anOlher 
documem and p:I.'>te il into your document. \X1hile Ihis is nOl the place 
to discuss it al length, remember that the copyright of almost all 

, .. 
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illustrations belongs to someone and so their use in any commercial 0 

widely distributed documcm without pcrmbsion or paymem is 

infringing the copyright owner's rights. 

Exercise 16.2b 

1. Open a new lile: you will need some text, although it does not matter what it i 

about: you could copy the lexl from anywhere - a Help file perhaps. II you 

prefer. you can open your leIter file. Insertlhe Windows 98 CD in your drive. 

Go 10 the In.ert menu and selecl Insert Picture and then Clip Art. If yo 

have opened the lener, see If you can find an appropnate picture 10 include; 

otherwise just select any picture you fancy. You could try USing Search. 

Once you have found a picture, see whal happens wtlen you add It. 

2. Go to the In •• rt plctu ... again. This time select From FII • . Do you have 

any photographs on your system? II so. you could try inserting one. If nol. go 

to the Mlcro.oft Clip Art Gallery again. download a photograph off the 

web or perhaps find another CO that has photographs 00 it. Use browse (or 

find) to locale l iles With an extension such as .jpg .. bmp .. gll, .\If or .pcx. and 

try the different optionS in fhe Insert Pictu ... window. 

16.3. Adding and Handling AutoShapes 

150 

If you want to dr:IW a diagram in a Word document, then there is a 

facility calk-d AutoShap •• , which makes things much easier than 

starting from scratch. 

Exercise 16.3 
If you look again al Figure 16.3. you will see that Auto.hap •• is an option 

in the In •• rt I Pictu ... menu. If you select Auto.hape., your view will 

switch to Page Layout and you will see the AutoShap •• trobar (Figure 

16.103); alternallvely, you can open the Drawing tOObar (Figure 16. lOb) anc 

open AutoShape. from there. MouSing over the Images shown lells you 

what they are and if you click 00, for example. aa.lc Shape., you will see 

Ihe selection shown In Figure 16.IO(c). II you then select a shape. your 

(mouse) cursor will change Into a cross and you can drag the image unlillt is 

the size and shape you want. Note thaI. if you keep the Shift key held down 

while you do this. you relain the aspect ratio; that is, a square remains a 

square rather than becoming a rectangle. You will see that the Callout. are 

set up to allow you to enter text directly into them (Figure 16.11). You can 

format the text in the usual way. as described in Chapter 8 

... 
• r.CDL · .. . 
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Figure 16.10a The AutoShapes toolba,. 

Figure 16.1 Ob The Ikawing toolbar • 

.t: 1EI ~&,~11; 
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OOt.L 
0000 
BBlCD 
©@@'" 
<:>'<:><1 
,(JOO 
( ) { } 

Figure 16.1 De AutoShapes toolnr displaying Basic Shapes. 

Figure 16.11 A callout. 

It is worth noting that simple shapes, such as ru les, arrows, 

squares/rectangles and circles/ellipses can be drawn directly from the 

Drawing toolbar (Figure 16. lOb), 

AutoShapes provides you with the basic shapes, but you will probabty want to 

change the line Widths and you may also want to change the colour of the 

lines and the fill. In Figure t6.12, we will look at a simple square. Figure 

16.12a shows it as created (and selected). Now, you may have noticed that 

when you opened the AutoShapes toolbar, you also opened the Drawing 
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tool bar, which allows you to carry out most drawing operations, many of which 

we shall not consider here. However. if we ensure that our square remains 

selected (Figure 16.12b shows it when it is not selected and clicking on it 

selects or deselects it), then we do the fo llowing: 

o 
Figure 16.12a Square Is created and selected. 

D 
Figure 16.12b The square unselected. 

1. Select the Line style icon _ . Clicking 00 it opens the menu shown in 

Figure 16.12c. You just choose the line thickness you want: we have chosen 3 

pt (3 points). Note that you can also change the dash style 5 and (for 

certain objects, but not the square) add arrow heads ;; . 

•• . ~ 
J'" pi: •• ••• ,.. 
' . ••• '. ' . ••• ••• ,. 

• tp'e Liles ... 

• " _"'.·e • ., 
Figure 16.12c 

2. Next you may want to change the colour. Click on the Line colour icon 

~ and select what you want (Figure 16.12d). Here we have chosen grey, 

as this guide is not in colour (Figure 16.12e) 

... 
• [rDi. · ... 
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Figure t8.t2d The Line colour menu. 

D 
Figure t 6. t 2e The square with a grey outline. 

3. Finally, you may want to change the fill colour. Click on the Fill colour icon 

~ and you will see a menu that is very similar to Figure 16.12d. Again 

choose your colour. In this instance we have chosen black (Figure 16.121). 

Figure t6.t2f The square with a grey outline and black fill. 

You can also vary these parameters using the Format AutoShape menu, 

which we shalilook at in the next section, 

Now open a new fi le or the one in which you added the picture. Experiment 

with using AutoShapes to add shapes to your file. Save the file if you wish. 

16.4. Moving and Placing Images and 
Drawn Objects in a Document 

Images C'.tn be sited in three ways. They Cln 'nOOt' between 
paragraphs, they can be fiXL><i, as we saw above, and they can overlap 
the text. as do AutoShapc ohJects unless you make space for them or 
adjust the wrapping. 
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Exercise 16.4 

For AutoShape objects adjusting these parameters is carried on the Format 

AutoShape menu. You access this by right clicking on the edge of the 

object. A drop-down menu will then appear. Setect Format AutoShape at 

the end 

The menu initial ly looks like Figure t6.t3 and you can see that here you can 

also make the changes we made using the Drawing tool bar. 

I l.MI!Lrd~J I 5I:e 1 -.1 ...... ~ 1 
~ 

"." II 1::1 r SoIri!r ____ 

~ 

"'", .:J ... ' -, ::J 'fbiIII.: lo.1'Spl .,-
::J 
3 

::J 
:=i 

::J 
::J 

Figure 16_13 The Format AutoShape window. 

The other tabs are: 

• Size , including rotation. (This is not shown here. but is very clear.) 

• Position (Figure 16.14). You can specify the poSition both horizontally and 

vertically relative to the page, the column. the paragraph and the margin. 

You can also fix the position and allow the image to move with the texl. 

Locking the anchor (and you will see an anchor J,. alongside a 

paragraph when the object is selected) means that the object will always 

appear on the same page as ItS 'parent' paragraph. Allowing the image to 

move with the text means that the image moves with the paragraph as you 

edil. Note that Floating IS not an option here. 

• 1';1"1lI.· 
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Figure 16.14 The Position tab . 

• Wrapping (Figure 16.15). This shows how the text can flow around the 

object and the pictures on the menu illustrate the principles well. The dark 

square shows what is currently selected. Initial ly there is no wrapping so 

the object may overlap the text. 

CoIor<...:I1JIe< I SIN I -. ~I 
~-..,. 

rororo EJ ro 

Figure 16.15 The Wrapping tab. 

II you want to move a picture, you have some of the same options. Again you 

right click on the picture and then choose Format Picture from the end of 

the pop-up menu that appears. The Format Picture menu is similar to the 
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Format AutoShape menu. but has some differences. The Position tab 

now allows the picture to float in addition to the other options. You can now 

also access the Picture tab (Figure 16.16). which allows you to crop the 

image (see below) and make some adjustments to colour, as well as allowing 

you to treat the image as a watermark, which shows on every page. We shall 

not deal with that here. 

-. ... _1 ... l_t .. _l§O;l --~ .-----" ~ .-----" - .-----" - .--. --- " - .-" "'" -- " "'" 

Figure 16.16 The Picture tab of the Format AutoShape window. 

The Picture toolbar, which we have already seen in Figure 16.9, allows you 

to make many of the same adjustments, 

Use your file with the pictures in. Then experiment with the Format 

AutoShape and Format Picture menus or with the Picture loolhar to 

see the ways in which you can place your picture(s) and shapes relative to 

the text. Save the file if you wish. 

16.5. Sizing and Cropping Images 

156 

To size an image, you simply select the object (picture or AutoShapc) 

and then drJg one of the 'handles' (the small boxes on the sides and 

corners) to the size you want (Figu re 16,1 7). Using one of the handles 

on the sides will diston the aspect rJlio (height to widlh). If you use a 

corner handle and hold down Shift. you will rewin the aspcL1 F.ltio . 

. ~~ . 

• ~.~ 
I ' ._- - -. 

Figure 16.17 Resl,r.ing a picture: Ileft) during; Iright) afte, • . . . 
• r.CDI.· .. . 
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Cropping a picture means removing part of the picture (as if you were 
cutting it ofO, To do this, you either specify the crop in the Picture 

lab or you sek"<:\ the crop tool Ht from the Picture toollYJr. 11le 
cursor sh;lpe will change to this shape. '11Ien, in the same way as 
sizing, you drag one of the handles (Figure 16. 18). This time, the size 
will not change. When you have finished, just click in a bhtnk part of 

the screen to cancel the cropping tool. 

Figure 16.18 Cropping a picture: la) before; Ibl during; Ie) arter. 

Exercise 16.5 

1. Resize one or more of your pictures. (You can always use Undo or close the 

fife without saving.) 

2. Crop one or more of your pIctures. (You can atways use Undo or ctose the 

fite without saving.) 

Summary 
In this chapter: 

• We have looked at the difference between vector grJphics and 
pictures (bitmaps). 

• We have seen different ways of adding an illustration. 
• We have noted that the copyright of almost every illustr:uion is 

owned by someone. 
• We have seen how 10 use AutoShapes. 
• We have seen how to move and pl:lce images rel:ltivc to tex\. 
• We have seen how to resize and crop image:~. 
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Importing 
Objects 

Import spreadsheet Jiles. 

1 

learn how to 

Impol1 image/des, chm1s and graphs. 

• 58 
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Importing Objects ................ ~ 
17.1. Introduction 

j 

We have seen in the last ch:tpter how images can he inserted into a 
document. However, these are not the only objects that can be inserted 
and the approach used in Chapter 16 is not the only approach 
po~ible. One of the advantages of Windows is that you can insert an 
objcct, such as a spreadshcl.-1, into a Word file in such a way that when 
you want to edit it , selecting it also opens the application that is 
associated with it (often the application that it waS created with). How 
applications are associated with file types is discussed in Module 2. For 
example, files that have an extension .doc are almost always associated 
with Word and filcs with an .xls extension with Excel. 

111ere are a number of ways in which you can transfer lext and 
pictures inlO Word. The simp l e.~t is copying and pasting and Ihis works 
from many applications. The second approach is to use Insert and 
then sek>ct File. This only works for file types for which Word has an 
input filter and these include Excel. The third approach is the one we 
have mentioned above, using what is called OLE (Object Linking and 
Embedding) and here you go to the Insert menu and select Object. 

We shall now deal with the three approaches in turn. 

17.2. Copying and Pasting 
We have looked at copying and pasting in detail in Chapter 6. 111e 
appro;lch is just the same here, except that we have 10 open the O{her 
application first. Figure 17. 1 shows a small spreadsheet in Excel (see 
Module 4 for more information on spreadsheets). If we select the cells 
containing the data and then copy (probably just keying Clrl+C), the 
material has been added to the ClipBoard. 

Figure 17.1 A small spreadsheet in Excel. 
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Next we have 10 trJnsfer to word (or open il if il is nOI already open) 
and ensure that we have the right target document open. 
Moving/switching betwL'en appliGltions is described in Module 2, but a 
brief summary is given in Chapter 2 of Ihis book. Once you are in the 
Word document :11 the position where you want the table to be 
insened, you simply Paste (key Ctr1+V). The Excel data will appear as 
a table (Figure 17.2) Ih:11 can be edited in the ways discussed in 
Chapter 15 . Note thai copying in this way breaks the link with the 
origin:t! application. 

l '80.Ic-C_OIOI'·"'WOfftIOIIOnT~ ". 

HIoinV ..... ·C"'"l"'lOf· ... -MonagIng·Fln. 5<' 
l, __ ""'9" ". 

"Spno"'-" ". 
5<011__ ~. 

Figure 17.2 The Excel spreadsheet pasted as a table into Word. 

However, there is a way of copying that does not break the link and 
we will come to that below. 

Exercise 17.2 
Once you know how to use Excel, create a small file , then create a Word file 

and try copying the Excel file yourself. You could also try with other 

applications. such as graphics and drawing programs. 

17.3. Inserting a File 

... 

The second way to include a file from another application (usually just 
the Microsoft applications and one or twO others such as WordPerfed 
and Lotus 1-2-3) is to go to Ihe Insert menu and select File. Assume 
\vt' have saved our spreadsheet as ECDLl.xIs, so if we find this 10 
insert. we will sec the filter menu (Figure 17.3). (Incidentally, this 
shows us JUSt which application files we can impon.) TIle imponed file 
(below the one we copied and pasted) can be seen in Figure 17.4 and 
is almost identical. 

.' . 
• ECOL ' .. . 
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Figure 17.3 Importing a flle using the Convert File window. 
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Figure 17.4 The Excel s preadsh.et imported Into Word. 

This approach also breaks the link with the original application. There 
are advantages in both this method and copy and paste. For the whole 
file , particularly if it is large, the insert approach is probably better. but 
you do have to h:lve the whole file. If YOll only want pari. then usc 
copy :lfid paste. 

17.4, Inserting Objects 
The third approach allows the link we discussed abo ve to be retained. 

Exercise 17.4 
II you go to the Ins.rt menu and select Object. you see a w indow like 
Figure 17.5a with the tab Create New. The list shown includes essentially 
the software that you have available and il you select, for example, 

,., 



Module 3: Word Processing 

,.2 

Micro.oft Excel , you open an Excel spreadsheet within your Word 

document. Although it forms part of the Word document, it is edited with 

Excel. which provides you with increased functiona lity. And, 01 course. you 

can choose any of the programs that are compatible. 

Figure 17.5. Create New tab of In.ert Object window. 

Here we are concerned with importing an existing application tile, which will, 

at least in principle, continue to be updated in Excel. So we go to the sccood 

tab (Figure 17.Sb), Create from File. This assumes that we know what we 

want to insert and where it is. so we browse until we find our Excel file. The 

lext at the bottom left tells you what is going to happen. Note that there are 

three further options: 

OltjOC' I1IJ 

tl!ato _ [er..t~ from ffo .' I 
FIo~: 

I" It_ .. · 

Figure 17.5b Create from File tab of In.ert Object window. 
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• Link to tile If chis IS nocclcked, then the effect is the same as It was With 

the first two methods Figure 17.6a shows the change in the text when It IS 

ticked. 

1111,.,' 1113 

01( (.oral I 

Figure 17.611 The te.t with Link to tile .elected. 

• Float over text. thiS is the equivalent of the command we met on the 

PIcture menu in Chapter 16. The text does not change when thiS IS licked. 

• Di.play a. Icon (Figure 17.6b): In this case. only an icon IS shown in the 

document. This is mainly of use il the document IS not to be pnnted. 

Clicking on the Icon will open the linked document. 

~_ Ct"''''''''rJiol 
"-f" a-... 

rkt~"" 
rfloot_1pt 
F1~ ...... 

01( (.oral I 

Figure 17.6b The te.t with Di.play a. icon .elected. 

You can have all or none of these options ticked. 
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As noled above, you can achIeve the same resull WIth Ole link by USIng Copy 

in Excel, but Ihen, instead of using Paste, you use Paste Special from the 
Edit menu; nole Ihat there IS no keyboard shortcut lor Paste Special. There 

are varIOUS ophoos Ihal you can choose (see Figure 17.7). but Ihese are all 

explained. While the principle IS wllhin the ECDL syllabus, the detail IS no1. 

1:m!lIlM 

tI'1 <* I 
~I 

Figure 17.7 The Paste Special window. 

Now repeat the lirst exercise In thiS chapter. but this time use Ins.rt 
Object. Once you have Inserted Ihe object click on II to edit it and watch 

what happens. 

Repeat the l irst exerCise in thiS chapter, but thiS time use Paste Special 
inSlead 01 jusl Paste. Once you have done th is, click on it to edi t it and 

walch what happens, It should be the same as when using the Insert 
Object option. 

17.5. Pasting Charts 

'64 

Within Excel, it is pos.~lblc to generate Ch:U1S h:l~"<I on the dna (see 
Mcxiule 4 for further det:lils) and one h:lS ix-cn genel"'JK-'d from the 
ECDL spreads)K"C1 d;ll:1 (Figure 17.8). We can copy :lnd then either 
Paste or Paste Special in the saine way as we did :Ihove. If we do 
Ihe latter. then the d:lta in the chart is linked hack to the original 
spre:L(bheet :lnd will he updaK,() as and when the sprcad~hcct is 

updated. 

. .. 
• r£nl. · ... 
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Figure 17.8 P •• tlng .n Excel ch.rt Into Word. 

Exercise 17.5 
Repeat the previous exercise in this chapter. but this time. befOfe you do that. 

create a chart In Excel. Then copy the chart. Once you have Insened the 

chart in Word. agaIn clICk on ilto edit it and watch what happens 

Summary 
In this ch:l.pter: 

• We h:!vc looked :!t copying and pasting:! sprcadslu..'Ct :!nd a chart 
from Excel into Word. 

• We have look(."(i at import ing a spreadsheet into Word. 

• We have looked :l.t importing objects into Word from mher 
applic.uions and retaining the link with the origin:!l :!pplic.uion. 

• We have looked al P:lste Special for copying and p:lsting into Word 
from OIher applications :!nd retaining {he link with {he original 

applic:uion. 
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Mail 

Create a data file, such as a mailing list, fo r lise i n a 
mail merge. 

Create a leller/or m ail merging. 

Creale a label document/or mail merging. 

Canyoul the merge. 

. .. 
• F£DL · .. . D. Penfold, Word Processing
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18.1. Introduction 

1 

One greal advantage (or d isadvantage, depending on your viewpoint) 
of computers is that they can do things over and over again, very fast. 
Thus, if you have a list of names and addresses, producing an 
individualised letter to each person on the list is very straightforward. 
This is known as mail merging beC'.!.Use the production of such letters 
and labels was its prime purpose. However, it c .. n be used to for 
various other purposes as well; these are outside the scope of ECDL. 

18.2. Creating the List 
11le first thing to note is that you do not necessarily have 10 create the 
list. You can, of course, and we shall see how, but in most cases the 
list will come from a spreadsheet, a d3!aoose or a Word file in which 
the fields (that is the different parts of the name and address) are 
separ.lted in a standard way. This might be as a table {like the one you 
created in Chapter 15), blll it can even be what is called a delimited 
text file that , for example, looks like: 

TitlelFirstnamelSurnamelAddress IITownlCountylPostcode 
MriJohniSmithl1 Church SlreetlBradfordlWest YorkslBD22 3XL 
MsiGIorial8rownl22 High StreetiBathIWiltslBA34 9U 

You will notice that there are the same number of fie lds in each entry 
and the fields are described in the top line. With many addresses that 
match this format (and of course many addresses do nO{, so the fonnat 
has to be more complex in reality). we can carry out a mail merge. 

Exercise 18.2 
You can creale the list using whatever approach you prefer. However, Word 
has some special routines to help you. Go to the Tools menu and select 
Mall Ma'1lle. The Mall Merge Helper in Figure 18.la appears. The first 
thing you have to do is create the Main Document, I.e. the master letter. If 
you click on this you get several alternatives, Form Letters, Mailing 

Labels, Envelopes and Catalog (Figure 18.1b). Let us click on Form 

Letters. You can then either use your current document or create a new 
one. We wi ll create a new one, which at the moment we will leave blank. We 
will come back to this in a moment 
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...... _ ............ _·_br_ .. ""'" -1 ~ __ _ . 

3Ci11_ ..... _ ... _ 
I 

Figure 18. 1 a The Mall Merge Helper window. 

~--I ...... ----er-.-. 

'"'" 
Figure 18.1b The Main document options in the 

Mail Merge Helper window. 

Let us go back to the main Mail Merge window and move on to creating the 

data source. Figure 18.2 shows us that we can create a new data source or 

use an existing data source. There are also two other options. which use other 

sources, but which we will ignore. If you choose to use an exist ing data 

source like the example above, then you browse through the system in the 

usual way until you lind the file you want and open it. 

"" ... _ ............ __ br_ ... ""'" -l e __ _ . 

Y?\ .. ..-... --..---... -----... 
~----

• 

• 

--""...J 
Figure 18.2 Choice of creating a data source 

or using an ellistlng data source. . .. 
• £(,IlI. ' .. . 
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If you decide to create a data source. you then see a window like Figure 18.3. 

which allows you to choose the fields from a standard set that Microsoft 

provides Once you are happy with that. you have to save the file Then you 

see a screen into which you can enter data (Figure t8.4). You are then able to 

go ahead and enter data 

A __ qodtw...,.,eiocorrwoeddfOMd <IoQ. Tho first ,owioc_1I>o 
"-10< row. t«h d tho coUmo ,,11>0 I>Mdeo- row ... wtI>. fWd"""". 

Wo<dll"o.rdos~ usedfWd ............. lI>oistboiow. Vcuc .. .:Idor ,...,... 
fWd_toCUllorri><r 11>0_ row . 

.... ""'-
Figure 18.3 Choosing fields lor the data source. 

Dol. rOlm DEI 

TtIo: 
. ~ I 

~, I .. - I 
~, 

I JobTtio: I -"'-', 
_. 

I 
AcIdr ... I: I ftId· .. I AcIdr .. .z: 
a~: I !/IOWScuco I 
state: .oj .... ~~ 

Figure 18.4 The data e ntry screen open in Mail Merge. 

18.3. Creating the Main Document 
You now need \0 ~Kld the ficld~ th~lt you have crc~lIcd into the 
lTIliin document. 

Exercise 18.3 
When you go back to your master document, you will see that there is a box 

on the toolbar that allows you to enter a Merge field. ThiS is in fact part of the 

Mail Merge toolbar. whiCh IS shown complete In Figure 18.5. Figure 18.6a 

shows the top of a letter with some fie lds entered and the drop-down menu 

showing how you choose the next field. Figure t8.6b shows the complete 

16. 
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fields of the address. Once your letter is complete. you can save it. You may 

also see messages asking if you want to save the associated mailing list. 

Insert Merge Fiek:I .. Insert Word Field .. «» . , " 
Figure 18.5 The Mail Merge toolbar. 

"""'_''-'1 ,.-,., 

~ . 
...... ,.. .. ,.._ .. ICDL .. . _._..--............ __ .. _ .. _,.._._ ...... _ , 

• 

Figure 18.68 Selecting the next field for the master 

document from the drop..down menu. 

--.--. • • • 

,T"'''' __ I 

'-" 1 - . 
,T_I 

n. __ _ 

-

n.o,.. .. __ .0011 .. _ ......... _.--_ ....... __ .. _._,.._._ . ..,.-_. 
Figure 18.6b The completed fields for the address. 

Note that if you use an existing document. you enter the fields in the 

same way. 

If, instead of producing a letter. you want to produce a set of address labels, 

then you choose Mailing Labels in Figure t8. tb and you will need to setect 

... 
• -PoCm. · .. . 
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(or create) a f ile, juSt as for a mailing leuer. We shall use the same file as we 

used for the letter. 

You will then be told that you need to set up your main documen1. If you click 

appropnately, you wi ll see a window (Figure 18.7a) where you can choose the 

type of label you want to use (to correspond to your stationery). Unfortunately. 

there is no preview and the file does not tell you how many labels per shee1. 

However, the dimensions are given and, from these, you can work out which 

label you need. Once you have selected an appropriate label size - and 

remember to select the A4 and AS size. rather than the (US) standard - you 

wil l see a window (Figure 18.7b) that allows you to enter the merge fields 

(Figure 18.7c), in a similar way to that which you used for the leiter. Once 

you have completed that. you wil l see the completed master document 

(Figure 18.7d). 

When you first ... your IIIIIn docwnent " wlH ..... r •• In 
Figure 18.7d. How ...... " you .wltch back to It aft ... 
merging, you wiN lind that tINt IMCOftd .nd ........... 
reconls have acquired an .xt,. field <Nen Record> IFigure 

18.7.). The .... son for this should be obvious. 

Do not u .. the Envelopes and LMIII. optkM'l on the Tools 
menu. ThI ...... somewhat ............... which I. out ... 

the Hope of ICDL 

Loki II" .. " ,,, IlCl _w_ 
I I o~_ 

~ 

~L-andi't.'"' lror: " 

::J _, 
'-' I 

LMIoI~: IA_Y A4 ...0 AS __ EI ..... I 
,...L-. .. I - , 

1"""- I ,1.6.·_"", . 
'-. --l7163' __ ..,., ,~ 

l716i'_'" -, >< <1165 · p,.."" 
(7L66· p,.."" 

.,j 
p.-. M (2 I %29.1 "'>1 

l1l61.~ 

Figure 18 .7a Choos ing the labe l type. 



Module 3: Word Processing 

172 

Cr .. ,,'" lilb" l. fiEl 

d'looooe the _ -01> Field b.tton to _ "'"'01> foelrls no tho 

sande label. Voo can edt .ord foomat the MerQe fields and text ... the <.1 
~lobelbQx. _. 

I 
_ Postal e:. Code.,. I ,.. ,., 

I 
""-

:J "'-"','" ....... 
-"" ,- .oJ ,..., 

I I -, ... '" , ..... 
Figure 18.7b Choosing your merge fields. 

d_«f~.tn ..... «s"",_. 
«Addr< .. , .. 
oAdd. ... b .,-
~"""'y.«Po",odu 

Figure 18.7c Viewing a sample label • 

." ... ,_._., . .-", 
~. ,1_1 
""-',-,' • 

..... ",-. .-., 
'''-''1 -" .1_1 
""-' ." ...... , • 
• 1 ... ,_,,_., 

..-,,' 
~. ,' .... ' ",,-,._., 
• 

Figure 18.7d The completed main document. 
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rr-" __ '_"I 
'_"1 ,-, 
,r_1 -,_., , . 
..... _T .... ' _ . _ ., ....-, .. 

.... __ .. ,_ .. _., 

....- t·1 
• ..-hl 
. r_ l _.-., , . 
." .. ........ r .... ' .. _."--., ._t .. 

Figure 18.7e Additional <Ne.t Record> field. 

18.4, Merging 
TIlC third part of the Mail Merge Helper is the 3C1ual merge. IVhich is 

c;mit.'"(1 out in the .'i;UllC way for both leiters and labels. 

Exercise 18.4a 
When you click on Merge. you then see another dialogue box. which allows 

you 10 choose whether 10 merge to a new file or direct to the printer and 

whether 10 leave blanks if a field is empty (in an address, you usually do not). 

You can also choose which of the records you want to merge (Figure 18.8). 

There are also options on the toolbar for launching the merge d irectly and 

checking thaI the merge is doing what you want. Once you are happy. then 

you can launch the merge and get ready to put everything inlo (window) 

envelopes and slick on the stamps! Of course, il you have also crealed 

labels. you can use these instead of window envelopes! 

Me,ge 0/£1 

MII(ge to: I ..... I -- .:J I V "'" I 
Records to be meroed 

I ".\lll 'E,r<:Im: I ,,, I Ched<trro« .. 

~ ()p/jonI; ... I 
~i-n'KOTds 

r. Q!ln\ prW bIri; lnes ...t.en dM fIeId5 ¥e ""1ItY, 
(' B'W bIri; bs ........ dat .. fIekk are ""1ItY. 

No ~ optIoos MYe ~ sot. 

Figure 18.8 Deciding which records to merge. 

Exercise 18.4b 

1. Open your letter file. Select Mail Merge Irom the Tools menu and select 

Create for the main document and then Form LeUer • . 

2. Then you will be given the option to choose between the Active Window 

(your leller) and a new file. While you can choose 10 create a new file , we 

suggest that you click on Active Window to use your letter. 
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3. You then need to create a data source. Again you can choose to Create a 

data source, but again, we suggest that you use the table file that you 

created earl ier. You will need to browse and then open it. 

4. You will now see a message that te lls you that there are no fields in your main 

document and then gives you the chance to edit that document. Clic~ on 

Edit Main Document. 

S. You will now see on your Mail Merge toolbar Insert Merge Field. Place 

the text cursor where you want a field and select one (you use the down 

arrow as usual 10 see them). 

6. When you have inserted the fields you can save (belter to save as a new file) 

and then run your merge by clic~ing the merge icon 

window li~e Figure t8.8. 

. You wililhen see a 

7. Try the different options and then clic~ Merge (to a New document). You can 

always delete that file and merge again. 

Exercise 18.4c 

1. Select Mail Merge from the Tools menu and select Create for the main 

document and then Mailing Labels . 

2. As in the previous exercise, you will be given the option to choose between 

the Active Window (the new tile) and a new file. In th is case, choose a new 

file . 

3. You then need to create or open your data source. Again use the table file 

that you created earlier. As in the previous exercise, you will need to browse 

and then open it. 

4. You wil l now see a message that tells you that you need to set up your main 

document. If you clic~ appropnately, you can then select the label size (and 

layout) that you want to use. Note that the label size for 21 to a sheet is 63.5 

by 38.1 mm and for 14 to a sheet the size is 99.1 by 38.1 mm. 

S. Once you have selected the size of label, you enter the data fields and cl ic~ 
OK when you have finished . You will see your label document. 

6. Run merge from the tool bar Merge icon. You will then see a window, as in 

Figure 18.8. 

.' . 
• f;('I)L ' .. . 
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7. Try the different options and then click Merge (in the first instance to a new 

document but you can tater merge directly to the printer). If you do merge 

d irectly to the print£!(. it is a good Idea to ensure that you have put in the label 

statooery! 

Note that you can also access the Mail Merge Helper Irom icon ~. 

You can access the data entry (in which you can check, modify your data file) 

from icoo . You can, as always, identify the icons by mousing over them. 

Summary 
In this chapter; 

• \'(Ie have looked al Ihe idea of mail merging . 

• \'(Ie have secn how to SCI up a mail merge. 
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............. .............................. .. .............. ...... .................. . 
• • • • • 
• • • • • 

Springer's study guides have been designed to complemenl 
Ihe ECDL syllabus, and be consislent with the content 
contained W'ithin it. Each study guide enables yov 10 
successfuly complete the European Driving Ucence IECDLI. 
The boob cover a range of specific knowledge oreas and 
skill sets. with clearly defined learning objectives. broken 
down into seven modules. 

Each module has been .....nllen in clear. jargon-free language. with sell­
paced exercises and regulor review questions. to help prepare you for 
ECDl Tests . 

• • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • • 
Titles In the series Include: • • • • • Module 1: Basic Concepts oflnlormoHon Technology • 

ISBN: 1-85233-442-8 Softcover £9,95 • • • 
• Module 2: UsIng the Computer & Managing Flies • • 

ISBN; 1-85233·443·6 Soflcover £9,95 • 

• Module 3; Word Processing • 
ISBN; 1-85233·444· 4 Soflcover £9.95 

• 
• Module 4: Spreadsheets • 

ISBN: 1-85233-445-2 Soflcover £9.95 • 
Module 5: Database • • • 
ISBN: 1-85233-446-0 Soflcover £9.95 • • • • Module 6: Presentation • • ISBN: 1-85233·447·9 Soflcover £9.95 • • 

• Module 7: Informatlon & Communlcatron • • 
ISBN: 1-85233-448·7 Soflcover £9.95 • • • 

• •••••••••••••••••••••••••••••••••••••••••••• 

All books are available. 01 course. from all good booksellers Iwho can 
order them even if they are nol in stockl. but if you have difficulties you 
can conlocllhe publisher direct by telephoning +4410) 1483 418822 
or by emoi~ng ordea@sv1 co uk 

For details of other Springer books and journals, please vis it 

www.springer.de 



IlIk •• ilk Ik. 11.1 ilhrillill al. leasl l'Ia.ill 111.1 /II illll". il ... "lill flsl 

..................................................................................... 

The Essential Series 
Editor: John Cowell 

· ................................. ......... . 
• • • 
• • • • • 
• 
• 
• 
• 
• • • • 
• • • 
• • 

If you are looking lor an accessible and quick 
introduction to 0 new longuage or area then these are 
the books for you. 

Covering a wide range of topics including virtual reality, 
computer animation, Java, and Visual Basic to nome but a few, 
the books provide a quick and accessible introduction to the 
subject. Essential books let you start developing your own 
applications with the minimum of fuss - and (as'. 

All books ore available, of course. from all good booksellers 
(who can order them even if they are not in stock) . but if you 
have difficulties you con con tac t the publisher direct by 
telephoning +44 (0) 1483 418822 or by emoiling orders@svl.co.uk 

• •••••••••••••••••••••••••••••••••••••••••••••••• 

• • 

• • 

• • 
• 

· ............................................... . 
For details of all books in this series, please visit: 

www.essential-series.com 
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Accessible Access 
Mark Wh itehorn and Bill Marklyn 

· ......................................... . 
• • • • • 

• • • • • • • • • • • • • • • • • • • • • • 
• 

Accessible Access 2000 assumes that you start with no 
knowledge of Access or databases and tokes you to the point 
where you can crea te and use 0 multi-toble da tabase. 

"These two authors make a perfect team. 
Bill Marldyn knows the product inside out and 
Marl: Whitelwrn maw the infomuttion tUcessible.n 

Neil Faw.:ett, Group Technical Editor, 
VNV BVSlNESS PuauCATloNS 

· .................... . 

"PCW and Amazon.co. uk contributor 
Mark Whitehorn is that rare 
combiruttion-an expert in his field, 
databases, and a fine writer too, with a 
talent for honing a complex subject 
down to its essentials." 

i- ~ 

• • • • • • • 
• • • • • 
• • • • • • • • • • • ••••••••••••••••••••• 

Tamsin Todd - Compulers & In lernet Editor. 
AI.W.oN.co..UK 

All books are available. of course. from 
all good booksellers (who can order 

them even if they are not in stock). 
but if you have difficulties you can 

contact the publisher direct by 
telephoning +44 {OJ 1483418822 
or by emailing orders@svl,co,uk 

}!me 2000 _ Sofuover _ 318 pages . ISBN: 1-85233-3 13-8 • £24.50 
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How Computer 
Programming Works 
Dan Appleman 

· ......................................... . 
• 
• 

• 

• 
• • • • 
• • 
• • 
• 
• • 
• • • 
• 

Key feotures Include: 

• A useful book for future programmers or anyone 
interested in explaining important computer 
programming concepts 

• Full colour illustrations help to visually explain important 
lopics 

• New expanded sec tion on computer programming for 
the Internet 

The book covers how programmers turn ideas into code, the use 
of algorithms 10 accomplish common tasks, the basic function 
of compilers and interpreters, and even how to program a 
video cassette recorder! 

· .................... . 

"." , .... '" 
".'''~~I.' 
~o • • • --

• 
• • • • • • • • • • 
• • • • • • • • • • 

All books are available, of course. from 
all good booksellers (who can order 

them even if they are not in stock) , 
but if you have difficulties you can 

contact the publisher direct by 
telephoning +44 (0) 1 483 418822 
or by emailingorders@.svl.co.uk 

] Iwe 2000 • So/teover • 226 pages 
• ISBN: 1-893 11 5-23-2 • £17.00 · .................... . 

For details of all Apress books, please visit 

www.apress.com or www.springer.de 


